
LD-60/90 Platform 

User's Manual

I611-E-07



Copyright Notice

The information contained herein is the property of Omron Robotics and Safety Technologies,
and shall not be reproduced in whole or in part without prior written approval of Omron
Robotics and Safety Technologies The information herein is subject to change without notice
and should not be construed as a commitment by Omron Robotics and Safety Technologies
The documentation is periodically reviewed and revised.

Omron Robotics and Safety Technologies, assumes no responsibility for any errors or omis-
sions in the documentation.

Copyright  2013 - 2021 by Omron Robotics and Safety Technologies All rights reserved.

Any trademarks from other companies used in this publication are the property of those
respective companies.

MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson.

Copyright 2012 CEPSTRAL LLC http://www.cepstral.com This product may contain copyright
material licensed from CEPSTRAL LLC, all right reserved.

Created in the United States of America

11970-000 Rev N LD-60/90 Platform User's Manual 2

http://www.cepstral.com/


Table of Contents

Table of Contents

Chapter 1: Introduction 11
1.1 Product Description 11
Body and Drive 12
What's Included - Basic Components 14
Optional Components (Partial List) 16

1.2 Software Overview 17
FLOW Core 18
SetNetGo 19

1.3 How Can I Get Help? 20
Support 20
Related Manuals 20
Including a Debuginfo File 20

Chapter 2: Safety 23
2.1 What to Do in an Emergency /Abnormal Situation 23
Releasing the Brakes 23
General Hazards 23
Releasing an E-Stop 24

2.2 Dangers, Warnings, and Cautions 24
Alert Levels 24
Alert Icons 24
Special Information 26

2.3 User's Responsibilities 27
Electrical Hazards 27
Pinch Hazard 27
Magnetic Field Hazards 27
Qualification of Personnel 28
PayloadMovement and Transfer 28
Multi-AMR Avoidance 28

2.4 Environment 29
General Environmental Conditions 29
Public Access 29
Clearance 29
Obstacles 30
Safety Scanning Laser Emergency Stop 30
Safety System Overspeed Faults 30

2.5 Intended and Non-intended Use 31
Intended Use 31
Non-Intended Use 32

3 LD-60/90 Platform User's Manual 11970-000 Rev N



Table of Contents

Platform Modifications 32

2.6 Battery Safety 33
2.7 Additional Safety Information 33
Mobile Robot LD Safety Guide (Cat. No. I616) 33

2.8 Disposal 33

Chapter 3: Setup 35
3.1 Overview 35
Tasks 35

3.2 Transport and Storage 35
Platform 35
Battery 36

3.3 Before Unpacking 36
3.4 Unpacking 36
Battery 37
Platform 37

3.5 Battery 44
3.6 Installing the Battery 44
Removing the Battery Door Skin 44

3.7 Attaching the Payload Structure and Options 48
3.8 Installing the Docking Station 49

Chapter 4: Configuration 57
4.1 Settings and Configuration 57
Maintenance Ethernet Connection 57
Setting UpWireless Ethernet 58

4.2 Mapping 60
Mapping Overview 60
Mapping Tasks 61

4.3 Acceleration, Deceleration, and Rotation Limits 61
Configuring for an Overhanging Payload 62

4.4 Supplemental Information 62
Laser Setup 62

Chapter 5: Payload Structures 65
5.1 Safety 65
Warning Label 65
Warning Lights 66
Warning Buzzer 66

5.2 Considerations 66

11970-000 Rev N LD-60/90 Platform User's Manual 4



Table of Contents

Performance 66
Weight 66
Power Consumption 67
Payload Bay Access 67
Dimensions and Design 67
Center of Gravity (CG) 69

5.3 Connections Between Platform and Payload Structure 74
Operator Panel 74
Option Connections 75

Chapter 6: Connectivity 77
6.1 Required Connections 77
6.2 Payload Bay Connections - Core 77
LD Platform Core Front, Upper 79
Core Right, Upper 79
LD Platform Core Rear, Upper 87
Internal LD Platform Core Connections 95
Internal Data Pinouts 97
Internal Power Pinouts 98

Chapter 7: Operation 101
7.1 Operating Environment 101
Intended Use 101
Clearance 101
Obstacles 102
Environment and Floor 102

103
User's Responsibilities 103
Getting Stuck 104

7.2 Typical Operation 104
7.3 Power and Charging 105
Battery Indicators and Controls 105
Docking Station 106
Manually Charging the Battery 108
Balancing the Battery 110

7.4 Operator Panel 111
Screen 111
E-Stop 113
ON Button 113
OFF Button 114
Brake-Release Button 114

7.5 Other Controls and Indicators 114
Light Discs and Beacon 114
LD Platform Core Status Indicators 120

5 LD-60/90 Platform User's Manual 11970-000 Rev N



Table of Contents

7.6 Sensors 121
Lasers 121
Sonar 122
Other Sensors 123

7.7 Start up 124
Procedure 124
Pendant 124

Chapter 8: Maintenance 127
8.1 Safety Aspects While Performing Maintenance 128
Electrical Hazards 128
Burn Hazard 128
Pinch Hazard 128
Magnetic Field Hazards 128

8.2 Safety Measures Prior and After Maintenance 129
8.3 Lifting the Platform Safely 129
Front Lifting Points 129
Rear Lifting Area 130

8.4 Safety Inspection 131
Warning Devices 131
Warning Labels 131

8.5 Cleaning 133
Work Area Maintenance 133
Platform Cleaning 133
Cleaning Casters on ESD Platforms 134

8.6 Maintaining and Replacing Batteries 135
Maintaining Batteries 135
Replacing the Battery 135

8.7 Replacing Non-Periodic Parts 138
Docking Station Roller and Bearing 138
Docking Station AC Power Fuse 139
Docking Station Internal Fuse 140
Rear Sonar Units 141
Sonar Controller 142
Light Discs 143
Operator Panel 143
Wheels and Tires 144
Drive Assemblies 144
Front or Rear Casters 148
Safety Scanning Laser 149
LD Platform Core 150
E-Stop and Safety Laser Commissioning 151
Accessing the Payload Bay 152
Removing and Installing Skins 152

11970-000 Rev N LD-60/90 Platform User's Manual 6



Table of Contents

Chapter 9: Options 159
9.1 Fleet Manager, for Multi-AMR Coordination 159
9.2 Pendant 159
9.3 Spare Battery 159
9.4 Payload Structure Bumpers 159
9.5 Call Buttons/Door Boxes 159
9.6 Electrostatic Discharge (ESD) Skins 159
9.7 High Accuracy Positioning System 160
Overview 160
Components 160
Sensor Installation on the LD-60 and LD-90 161
Tape andMarker Application 167
Define Goals 168
HAPS Software Configuration 169
Goals/Tasks 170
Specifications 171
Dimensions 172

9.8 Acuity Localization 172
When Acuity Won’t Work 172
Installation Scenarios 172
Payload Structure Design 173
Tasks 174
Components 175
Installation 176
Enabling Acuity 183
Importing the Camera Calibration 185
Compensating for Camera Position and Tilt 187
Making a Map of Your Environment 190
Scanning the Environment 190
Creating a Map 192
Localizing Manually 197
Interpreting Light Objects on the Map 198
Camera Specifications 198

9.9 Side Lasers 198
Positive Obstacles 198
Negative Obstacles 198
Installation 199
Components 199
Mounting 199
Connections 201
Configuration 202

9.10 Touchscreen 205
Installation 205
Software Installation 205
Mounting 205

7 LD-60/90 Platform User's Manual 11970-000 Rev N



Table of Contents

Connections 209
Setup 210
Configuration 210
Operating Modes 210
Choose Dropoff Mode 211
Patrol Route Mode 212
Localization Goals 212
Screen Logo 213
Contact Information 215
Setting Screensaver 215
Setting Display Language 216
Operation 216
Relocalization 223
Dropoffs (Choose Dropoff Mode only) 223
Patrol Route Mode 226
Specifications 226
Power Supply 227

Chapter 10: Technical Specifications 229
10.1 Dimension Drawings 229
10.2 Platform Specifications 230
Physical 230
Performance 232
Sensors 233
Battery Outputs 235

10.3 Docking Station Specifications 235

Chapter 11: Glossary 237

Appendix 244
A.1 Parts List 244

11970-000 Rev N LD-60/90 Platform User's Manual 8



Revision History

Revision
Code Date Revised Content

01 April, 2017 Original release

02 August, 2017 Corrections and improvements.

03 February,
2018

Corrections and improvements.

04 October, 2018 Corrections and improvements.

05 February,
2019

Corrections and improvements.

06 April, 2021 Corrections and improvements.

07 December,
2021

Corrections and improvements.

11970-000 Rev N LD-60/90 Platform User's Manual 9





Chapter 1: Introduction

This manual covers the setup, operation, and user maintenance of an LD Platform OEM.

Other than the basics, this manual does not cover configuration performed using the software
that comes with the platform. That is covered in the FLOW Core User's Guide (Cat. No. I637).

1.1 Product Description
The LD Platform OEM is a general-purpose, mobile robot platform, designed to work indoors
and around people. It is self-guided and self-charging, with an automated docking station. The
LD Platform OEM is available in two versions, designed to carry loads up to 60 kg (132 lb) for
the LD-60 and 90 kg (198 lb) for the LD-90 platform. Where appropriate, differences between
the models are called out. Otherwise, this manual applies to both platforms.

NOTE: The LD-90x is a variant of the LD-90, with the drive train of the Cart
Transporter CT130. In general, it is not covered in this manual, although it is
mentioned in a few places where its higher gear ratio is a factor.

Figure 1-1. LD Platform OEM Layout

Callout Description Callout Description

A LD Platform Core F Safety Scanning Laser

B Platform Sonar Controller G Low Front Laser

11970-000 Rev N LD-60/90 Platform User's Manual 11



12 LD-60/90 Platform User's Manual 11970-000 Rev N

1.1  Product Description

Callout Description Callout Description

C Rear Sonar X4 (2 pairs transducers) H Light Disc x2

D Battery Door Skin J Front Bumper

E Pendant/Ethernet Access Panel K Front Caster x2, Drive Wheel x2,
Rear Caster x2

The platform combines hardware and mobile-robotics software to provide an intelligent,
mobile platform to transport your payload. Once it scans its environment, the platform knows
where it is within a workspace, and can navigate safely and autonomously to any accessible
destination within that workspace, continuously and without human intervention.

The LD Platform OEM uses a Safety Scanning Laser as its primary guidance to navigate, com-
paring the laser readings to a digital map stored in the platform's Core. The laser is backed up
by a low front laser, two rear-facing sonar pairs, a front bumper, a gyroscope mounted on the
LD Platform core, and encoders and Hall sensors on each drive wheel.

For situations that are so dynamic that laser localization becomes difficult, we offer the Acuity
Localization option, which localizes the platform using an upward-facing camera to recognize
overhead lighting patterns. This is covered in detail in the LD Platform Peripherals User's Guide
(Cat. No. I613). This would apply to areas where objects, such as pallets or carts, are moved so
frequently that they can’t be mapped, or where they block the laser’s view of the mapped fea-
tures.

For most applications, you will want to customize the platform with a payload structure,
attached to the top of the platform, for some combination of picking up, transporting, and drop-
ping off your parts, samples, or documents. Refer to Payload Structures on page 65 for
guidelines on designing a payload structure.

The platform provides a variety of interfaces and power connections to support your applic-
ation-specific sensors and accessories, mounted on your payload structure. Refer to Con-
nectivity on page 77, for information on the available connectors on the platform.

Body and Drive

The LD Platform OEMs are relatively small, lightweight, and highly maneuverable. Their
strong aluminum chassis and solid construction make them very durable, and they have an
IP rating of IP20.

Each platform uses a two-wheel, differential-drive, with spring-loaded passive casters front
and rear for balance. The drive-wheels have independent spring-suspension, with solid, foam-
filled tires. The wheels are at the platform's mid-line, so the platform can turn in place.
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Figure 1-2. Drives in LD Platform (in red)
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1.1  Product Description

Figure 1-3. LD Drives

What's Included - Basic Components

l One fully-assembled LD Platform OEM

The platform includes a navigation laser, front bumper with low front laser, and two
rear-facing sonar pairs. Each pair is a transmitter and a receiver.

l LD Platform Core, includes an integrated computer, running Advanced Robotics Auto-
mation Management (ARAM) and a microcontroller with Mobile Autonomous Robot
Controller (MARC) firmware. It also runs the SetNetGo OS. The core is housed inside
the platform.

Figure 1-4. LD Platform OEM Core location

The core comes pre-loaded with ARAM and MARC firmware, and the SetNetGo OS.
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The core has an internally mounted gyroscope, and each drive wheel has an encoder
and a Hall sensor to complement the safety scanning laser.

l One battery

Shipped separately from the platform to comply with dangerous goods shipping reg-
ulations.

l Operator Panel

The operator panel includes a screen, an E-Stop button, ON and OFF buttons, a brake-
release button, and a keyswitch (which you can lock, in either position, and remove the
key).

Figure 1-5. Operator Panel

This will usually be mounted on the user-designed and -built payload structure.

An optional touchscreen is available. See Touchscreen on page 205.

l Automated docking station

This allows the platform to charge itself, without user intervention. It includes a wall-
mount bracket and a floor plate, for a choice of installation methods. See Installing the
Docking Station on page 49.

Also included is a manual charging cord, so you can charge the battery or a spare bat-
tery outside of the platform.

l Pendant (option)
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1.1  Product Description

This is used for manually controlling the platform, mostly when making a scan to be
used for generating a map.

Figure 1-6. Pendant Connection Point

You need at least one Pendant for each fleet of AMRs. Once a map is generated, the
map can be shared with multiple AMRs working in the same space.

l User documentation

Optional Components (Partial List)

Refer also to Options on page 159.

l Fleet Manager system

This system manages a fleet of AMRs, for multi-AMR coordination and job man-
agement. It includes the Fleet Manager appliance running the FLOW Core.

l Acuity Navigation

For dynamic environments in which a map can’t be kept current, or where the area is
too large for the navigation laser to see, the robot can use Acuity to navigate using over-
head light patterns seen with an upward-facing camera.

l Electrostatic Discharge (ESD) Skins

ESD skins are black. They are made of a conductive thermoplastic sheet, grounded to
the chassis in a way that prevents electrostatic buildup.
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Figure 1-7. LD Platform OEM with ESD Skins

They do this by providing a path to ground through the skin, to the robot’s chassis and
wheels, and provide resistance of 1X109 Ω (measured from skin to ground). These skins
are available for robot applications in electrostatic discharge protected areas.

l Spare battery

A spare battery can help keep the AMR on the job without stopping to re-charge.

l Call/Door Box

This allows an AMR to be requested from a remote location, or allows the system to con-
trol an automated door, so the AMR can pass through it.

l High-Accuracy Positioning System (HAPS)

Allows an AMR to achieve accurate alignment at a specific location, such as a fixed con-
veyor, using a sensor to detect magnetic tape on the floor at that location.

For Payload Structure Development

l Side-mount obstacle-detection lasers

Two lasers that scan the vertical plane on each side of the AMR. These detect obstacles
that are at heights the navigation laser can’t see.

l Touchscreen

Allows an Operator to interact with an AMR at the AMR‘s location, select the AMR’s
next goals, check status, etc.

Refer to the LD Platform Peripherals User's Guide (Cat. No. I613) for details on the touch-
screen.

1.2 Software Overview
A fair amount of software is involved in setting up and running an LD Platform OEM.

The platform comes with the following software:
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1.2  Software Overview

FLOW Core

The FLOW Core includes all of the software used by the LD Platform OEMs and the Fleet Man-
ager appliance. The SetNetGo OS is not part of the suite, but is included. For more detailed
information, including licensing, please refer to the FLOW Core User's Guide (Cat. No. I637).

User-Supplied Components / System Requirements

PC with Microsoft Windows®

l Ethernet (wireless preferred)

Wireless is required for an installation with multiple AMRs.

l 100 megabytes of available hard-disk storage

ARAM

The Advanced Robotics Automation Management software (ARAM) runs on the LD Platform
core. It operates ranging sensors like the safety scanning laser and sonar, and performs high-
level, autonomous robotics functions like obstacle avoidance, path planning, localization, nav-
igation, and so on, culminating in motion commands to the MARC firmware. ARAM also con-
trols the battery and light discs, and manages digital and analog I/O, which, along with
platform power, provide for integration of application-specific sensors and effectors that the
user adds.

ARAM manages wired and wireless Ethernet communications with off-board software for
external monitoring, development, and systems coordination, including coordination of a fleet
of AMRs through the optional Fleet Manager. It also manages integration with other systems,
as well as external monitoring, setup, and control with the MobilePlanner application.

ARAMCentral

ARAMCentral is the software that runs on the Fleet Manager appliance. This software and the
appliance combined are referred to as the EM2100.

For a fleet, the ARAMCentral software manages:

l the map that all of its AMRs use

l the configuration that all of its AMRs use

l traffic control of the AMRs

This includes multi-AMR avoidance, destination, standby, and dock control.

l queuing of jobs for the AMRs

l remote I/O, if you are using it

MobilePlanner

Before your AMR can perform autonomous mobile activities, you need to make a map of its
operating space, and configure its operating parameters. MobilePlanner software has the tools
to make this map and perform this configuration.
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Refer to the separate FLOW Core User's Guide (Cat. No. I637) for details on how to map a work-
ing space and prepare the virtual elements, goals, routes, and tasks for your application. In par-
ticular, refer to:

Working With Map Files > Editing a Map File > Using the Drawing Tools >
Adding Goals and Docks

T After generating the map, the Fleet Manager appliance shares the map between multiple
AMRs in one fleet.

MobilePlanner, Operator Mode

MobilePlanner’s Operator Mode allows you to monitor one or more AMR's activities and have
them perform mobile tasks in the mapped space. Refer to the separate FLOW Core User's Guide
(Cat. No. I637) for details.

Mobile Autonomous Robot Controller (MARC)

At the lowest level, a microcontroller running MARC firmware handles the details of platform
mobility, including maintaining the platform’s drive speed and heading, as well as acquiring
sensor readings, such as from the encoders and gyroscope, and managing the platform’s emer-
gency stop systems, bumper, and Pendant. The MARC firmware computes and reports the plat-
form’s odometry (X, Y, and heading) and a variety of other low-level operating conditions to
ARAM.

Touchscreen Support

Fleet Operations Workspace Core includes support software for the optional touchscreen.

Call/Door Box Support

Call/Door boxes have one software component on the boxes and another on either the Fleet
Manager or on the single AMR, when there is no Fleet Manager.

ARCL Protocol

The Advanced Robotics Command Language (ARCL) is a function of ARAM and ARAMCen-
tral, which is included as part of this suite.

ARCL is a simple text-based command and response server for integrating an AMR (or fleet of
AMRs) with an external automation system.

ARCL allows you to operate and monitor the AMR, its accessories, and its payload devices
over the network, with or without MobilePlanner.

SetNetGo

The SetNetGo OS runs on the LD Platform core and Fleet Manager appliance. It is the host OS
in which ARAM and ARAMCentral run.

The SetNetGo interface in the MobilePlanner software is for configuring the platform’s Ethernet
settings, upgrading software, and performing systems diagnostics, such as retrieving log files.
It is accessible when connected via the maintenance and management Ethernet ports, or via
wireless Ethernet if enabled.
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1.3  How Can I Get Help?

NOTE: You can use a web browser to connect directly to the SetNetGo OS on a
platform. This allows your IT support to set up the network for you, without
using MobilePlanner, which requires a license.

1.3 How Can I Get Help?
Refer to the corporate website:

http://www.ia.omron.com

Support

If, after reading this manual, you are having problems with your platform, contact your local
Omron Support.

Related Manuals

This manual covers the installation, setup, operation, and maintenance of an LD Platform
OEM. There are additional manuals that cover configuring the platform. See the following
table. These manuals are available on the software media delivered with your system.

Table 1-1. Related Manuals

Manual Title Description

Mobile Robot LD Safety
Guide (Cat. No. I616)

Contains general safety information for all Omron Robotics and
Safety TechnologiesLD Platform OEM-based AMRs.

FLOW Core User's Guide
(Cat. No. I637)

Covers MobilePlanner software, the SetNetGo OS, andmost of
the configuration of an LD Platform OEM.

EM 2100 Installation
Guide (Cat. No. I634)

Covers the Fleet Manager 2100 system, which is hardware and
software used for managing a fleet of AMRs.

LD Platform Peripherals
User's Guide (Cat. No.
I613)

Covers peripherals, such as the Touchscreen, Call/Door box, and
Acuity Localization options.

Integrated Toolkit User's
Manual (Cat. No. I637)

Contains information that is necessary to use the Integration
Toolkit facilitating integration between the Fleet Manager and
the end user's client application.

Including a Debuginfo File

If the platform has been set up on a wireless network, skip to SetNetGo Access.

Network Setup

If the platform has not been set up on a wireless network, you will have to set up a local area
network on a separate PC, configured to talk to the platform over a TCP/IP port. Set the IP
address to: 1.2.3.5. The Subnet Mask should be 255.255.255.0.

http://www.ia.omron.com/


Chapter 1: Introduction

(Windows 7) Start > Control Panel > (Network and Internet >) Network and Sharing Center
> Change adapter settings

(Windows 10) Start > Settings > Network and Internet > Change adapter options

Right-click on the LAN Connection, and click on Properties.

In the Properties dialog, scroll to and double-click the Internet Protocol (TCP/IP or TCP/IPv4)
option. In Internet Protocol Properties, click both “Use the following…” radio buttons to enable
them, and then type in the IP and Subnet mask values. See the following figure:

Figure 1-8. Internet Protocol Properties Pop-up Dialog

SetNetGo Access

If MobilePlanner is available, use MobilePlanner’s SetNetGo interface to access SetNetGo.
Otherwise, open a web browser, enter the URL: https://1.2.3.4, then confirm security certificates.

Regardless of how you accessed SetNetGo, you should now have a window similar to the fol-
lowing:
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1.3  How Can I Get Help?

Figure 1-9. SetNetGo Pop-up Window

1. From the SetNetGo screen, select:

System > Debug Info

This will activate the “Download debug info” button.

2. Click Download debug info.

3. Save the downloaded file, and attach it to your support request.

NOTE: Before preparing a support request, the AMR's internal clock
needs to be correctly set to ensure accurate timestamps in the debug file.
For more information, please refer to the FLOW Core User's Manual.



Chapter 2: Safety

2.1 What to Do in an Emergency /Abnormal Situation
Press the E-Stop button (a red push-button on a yellow background) and then follow the
internal procedures of your company or organization for a robot emergency situation. If a fire
occurs, use a type ABC or type BC extinguisher: foam, dry chemical, or CO2.

Releasing the Brakes

In case of an emergency or abnormal situation, the AMR can be manually moved. However,
only qualified personnel who have read and understood this manual and theMobile Robot LD
Safety Guide (Cat. No. I616) should manually move the platform. The brakes on the drive
wheels can be released with the brake release button. This requires battery power, and an E-
Stop must be pressed on the AMR.

NOTE: The LD-90x has a high gear ratio, and is very difficult to move, even
with the brakes released. This NOTE does not apply to the standard LD-90.

General Hazards

IMPORTANT: The following situations could result in injury or damage to the
equipment.

l Do not ride on the platform.

l Do not exceed the maximum weight limit.

Payload decreases as slope increases.

l Do not exceed the maximum recommended speed, acceleration, deceleration, or rotation
limits. See Center of Gravity (CG) on page 69 and Acceleration, Deceleration, and Rota-
tion Limits on page 61.

Rotational speed becomes more significant when the payload’s center of gravity is
farther away (vertically and/or horizontally) from the platform’s center of gravity.

l Do not drop the AMR, run it off a ledge, or otherwise operate it irresponsibly.

l Do not allow the AMR to drive through an opening that has an automatic gate/door
unless the door and AMR are configured correctly with the Call/Door Box option. Refer
to the LD Platform Peripherals User's Guide (Cat. No. I613) for details on the Call/Door
Box.

l Do not get the AMR wet. Do not expose the AMR to rain or moisture.

l Do not continue to run the AMR after hair, yarn, string, or any other items have become
wound around the platform’s axles, casters, or wheels.

l Do not use unauthorized parts.
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2.2  Dangers, Warnings, and Cautions

l Do not turn on the platform without the antennas in place.

l Although the lasers used are Class 1 (eye-safe), we recommend you not look into them.

Releasing an E-Stop

!
CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
If the AMR’s E-Stop is triggered, ensure that the cause of the E-Stop is resolved,
and all surrounding areas are clear before releasing the E-Stop.

After the E-Stop button has been manually released, the AMR will wait until the motors are
manually enabled.

There are two ways to enable the motors:

l Use MobilePlanner

l Press the green ON button on the Operator Panel or the GO button on the Touchscreen.

Once the motors are enabled, the AMR will wait two seconds and then resume commanded
motion, if there is adequate space to maneuver.

2.2 Dangers, Warnings, and Cautions

Alert Levels

There are three levels of alert notation used in our manuals. In descending order of import-
ance, they are:

!
DANGER: Identifies an imminently hazardous situation which, if not
avoided, is likely to result in serious injury, and might result in fatality or
severe property damage.

!
WARNING: Identifies a potentially hazardous situation which, if not avoided,
will result in minor or moderate injury, and might result in serious injury, fatal-
ity, or significant property damage.

!
CAUTION: Identifies a potentially hazardous situation which, if not avoided,
might result in minor injury, moderate injury, or property damage.

Alert Icons

The icon that starts each alert can be used to indicate the type of hazard. These will be used
with the appropriate signal word - Danger, Warning, or Caution - to indicate the severity of the
hazard. The text following the signal word will specify what the risk is, and how to avoid it.
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Icon Meaning Icon Meaning

!
This is a generic alert icon. Any
specifics on the risk will be in
the text following the signal
word.

This identifies a hazardous entan-
glement situation.

This identifies a hazardous elec-
trical situation.

This identifies a fire risk.

This identifies a hazardous
burn-related situation.

This identifies a laser emitter eye
damage situation.

This identifies a hazardous ESD
situation.

Falling Hazards

!
DANGER: PERSONAL INJURY OR PROPERTY DAMAGE RISK
The AMR can cause serious injury to personnel or damage to itself or other
equipment if it drives off of a ledge, such as a loading dock, or down stairs.

Physical Barriers

The edge of a loading dock, the entrance to downward stairs, or any other substantial drop
that is within the AMR’s expected operating area should be physically marked so that the
AMR’s navigation laser will see the barrier, and stop before reaching it. The AMR is designed
to detect objects up to 200 mm in height, so the barrier must be at least that tall. However,
because of variations in floor flatness, we recommend a barrier that is 250 mm tall.

The barrier needs to be continuous at the site, so that the AMR can’t drive around or through
it to the dropoff.

Logical Barriers

You should also use forbidden areas, sectors, or lines with several feet of safety zone (padding)
before the actual dropoff, to ensure the the AMR will not try to drive there.

These need to be continuous at the site, so that the AMR can’t plan a path to drive around or
between them to the dropoff.
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2.2  Dangers, Warnings, and Cautions

Special Information

There are several types of notation used to call out special information.

IMPORTANT: Information to ensure safe use of the product.

NOTE: Information for more effective use of the product.

Additional Information: Offers helpful tips, recommendations, and best prac-
tices.

Version Information: Information on differences in specifications for different
versions of hardware or software.
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2.3 User's Responsibilities
Safe use of the AMR is your responsibility. Safe use includes:

l Reading the installation and operation instructions, as well as theMobile Robot LD
Safety Guide (Cat. No. I616), before using the equipment.

l Ensuring that the environment is suitable for safe operation of the AMR.

If a fleet of AMRs (two or more) is installed, the Fleet Manager must be used, unless no
two AMRs will ever operate in the same area.

l Ensuring that anyone working with or near an AMR has been adequately trained, and
is following this guide and theMobile Robot LD Safety Guide (Cat. No. I616) for safe AMR
operation.

l Maintaining the AMRs so that their control and safety functions are working properly.

Electrical Hazards

WARNING: ELECTROCUTION RISK
The docking station has AC power inside. Its covers are not interlocked.

l Do not use power extension cords with the docking station unless properly rated.

l Never access the interior of the platform with the charger attached.

l Immediately disconnect the battery after opening the battery compartment door.

Avoid shorting the terminals of the battery.

l Do not use any charger not supplied by Omron Robotics and Safety Technologies, inc.

l If any liquid is spilled on the AMR, power off the AMR, clean up all possible liquid,
and allow the AMR to air dry thoroughly before restoring power.

Pinch Hazard

Platform Skins

!
CAUTION: PINCH RISK
Strong magnets hold the skins in place, and can pinch you if you are not care-
ful. Follow the instructions in the Maintenance chapter for handling skins.

Magnetic Field Hazards

Platform Skins

!
WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers stay back 30 cm from the platform skins, which are held in
place with strong magnets.
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2.3  User's Responsibilities

Docking Funnel

!
WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers stay back 30 cm from the underside of the platform, which is
exposed during certain maintenance procedures when the platform is tipped
on its side.

Qualification of Personnel

It is the end-user’s responsibility to ensure that all personnel who will work with or around
AMRs have attended an appropriate Omron training course and have a working knowledge of
the system. The user must provide the necessary additional training for all personnel who will
be working with the system.

As noted in this and theMobile Robot LD Safety Guide (Cat. No. I616), certain procedures should
be performed only by skilled or instructed persons. For a description of the level of qual-
ification, we use the standard terms:

l Skilled persons have technical knowledge or sufficient experience to enable them to
avoid the dangers, electrical and/or mechanical

l Instructed persons are adequately advised or supervised by skilled persons to enable
them to avoid the dangers, electrical and/or mechanical

All personnel must observe industry-prescribed safety practices during the installation, oper-
ation, and testing of all electrically-powered equipment.

IMPORTANT: Before working with the AMR, every entrusted person must con-
firm that they:

l Have the necessary qualifications

l Have received the guides (both this user’s guide, and theMobile Robot LD Safety Guide
(Cat. No. I616))

l Have read the guides

l Understand the guides

l Will work in the manner specified by the guides

Payload Movement and Transfer

You should actively monitor and confirm the status of AMR payload movement, and transfer
to or from facility equipment.

Payload transfer problems must trigger an AMR E-Stop that prevents the AMR from moving
until an Operator resolves the problem and confirms the system is safe to use.

Your facility should provide an interlock between the AMR and facility equipment.

Multi-AMR Avoidance

When multiple AMRs are operating in the same workspace, they must be connected to an Fleet
Manager via WiFi. The Fleet Manager helps prevent collisions by sharing AMRs’ dynamic X,
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Y, Theta, size, and path-planning information with each other. AMRs then factor this data into
their obstacle avoidance. This is not a physical method of preventing collisions, such as inter-
locked gateways or barriers. Ultimately, it is the end-user/integrator's responsibility to provide
an interlocked method of preventing collisions.

IMPORTANT:When two AMRs approach each other directly, neither can prop-
erly determine the other's physical size. Their lasers scan several centimeters into
the other's laser slot, returning an incorrect distance estimate. Because of this,
any installation that has two or more AMRs working in the same operating
space must be managed by the same Fleet Manager.

NOTE: Software-based means of collision avoidance are not safety rated. Care
should be taken to control traffic flow using map features, and apply proper soft-
ware-based clearances. It is the user/integrators responsibility to evaluate if hard-
ware methods of collision avoidance are necessary for the application or
operating space. These could include physical barriers or interlocks in the oper-
ating space that are specific to your application.

2.4 Environment

General Environmental Conditions

You must always ensure that the platform‘s operating environment remains safe for the plat-
form. If there are unsafe areas for the platform, physically block those areas off so the plat-
form’s scanning laser will detect the barriers, and the platform will not attempt to drive there.
You can also block off these area using forbidden zones in the MobilePlanner software, but
that should be in addition to physical barriers.

Public Access

The platform is designed for operating in indoor industrial or professional environments. It
must be deployed in a manner that takes into account potential risks to personnel and equip-
ment. The product is not intended for use in uncontrolled areas without risk analysis, for
example, areas open to general public access. Use in such areas may require deployment of
additional safety measures.

Clearance

The platform is designed to operate in an environment that is generally level and has no doors
or other restricted areas too narrow for the AMR. It is the user’s responsibility to ensure that
adequate clearance is maintained on each side of the AMR, so that a person cannot get
trapped between the AMR and a wall or other fixed object. You should consult the applicable
standards for your area. An exception to side clearance can exist at pickup and dropoff loc-
ations where the AMR must get close to conveyors or other fixed objects.

The primary direction of travel of the platform is forward. When the platform is turning in
place, with no forward movement, the detection of an obstacle in its path of rotation will not
trigger an obstacle-detection condition.

!
CAUTION: PERSONAL INJURY RISK
Personnel who work with or around the AMR should not stand close to the
AMR when it is turning in place (with no forward motion).
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2.4  Environment

Obstacles

If the AMR will be entering high-traffic areas, the user must take appropriate precautions to
alert people in those areas that a AMR will enter. If the traffic consists of other machines, the
user must adjust the AMR‘s and/or the other machine’s parameters to reduce the risk of a col-
lision.

Safety Scanning Laser Emergency Stop

If an obstacle enters the AMR’s immediate path, the safety scanning laser will trigger an emer-
gency stop. After the AMR has come to a complete stop, it will wait a minimum of two
seconds before resuming commanded motion, with no human intervention necessary.

l If the obstacle is still in the AMR’s path, and there is adequate room, it will first attempt
to safely path plan and maneuver around the obstacle.

l If the AMR can’t simply maneuver around the obstacle, it will search for another path
to reach its goal.

l If it cannot find another path, it will react based on the configuration settings. Refer to
the FLOW Core User's Manual (Cat. No. I635) for more information.

Safety System Overspeed Faults

A CPLD Channel 1 or 2 fault, is a system fault, reported by independent safety system to the
firmware controlling the robot.

Safety standards EN1525 and ANSI B56.5 state that sensing in the reverse direction of motion
is not relied on as part of the AMR's safety system. This is because it is used only by software-
based obstacle detection, the LD's reverse travel is limited to <300 mm/s

If an AMR exceeds the reverse speed limit, the safety system will report a fault. During normal
operation, the AMR will perform a controlled stop. This fault may also occur when moving
the AMR manually using its brake-release function. In this the case the safety system cannot
stop the LD Platform because motor power is disabled. Normal operation can continue when
the fault is cleared.

If this error is occurring, you may decrease the max speed parameter in question. In the Robot
Physical section and Absolute Movement Maximums sub-section of Robot Configuration, the
parameters AbsoluteMaxTransVel and AbsoluteMaxTransNegVel can be set to control the
maximum velocity of the robot. These parameters cannot be set higher than the forward and
reverse limit of the hardware platform currently being used. Lowering these parameters will
prevent the robot from moving at a speed that would cause an overspeed fault.

Following table displays overspeed fault conditions.

NOTE: The motion settings such as AbsoluteTransVelMax, that limit maximum
allowable velocities in the robot software (ARAM), have no effect on the safety
system.



Chapter 2: Safety

Table 2-1. Overspeed Limits for Different LD Models

Model
Forward recom-
mended Speed

(mm/s)

Reverse recom-
mended Speed

(mm/s)

Forward
Limit
(mm/s)i

Reverse
Limit
(mm/s)

LD-60 2050 250 2100 300

LD-90 1525 175 1575 225

LD-
90x

1000 100 1050 150

LD-
105CT

1525 175 1575 225

LD-
130CT

1000 100 1050 150

LD-
250

2050 175 2100 225

i The forward limits indicate where the safety system will report a fault. These speeds may not
be achievable by the robot under its own power. The max forward speed, should always be set
to the defined maximum (or lower) speed, found in the default configuration shipped with the
robot.

2.5 Intended and Non-intended Use

Intended Use

The LD Platform OEM is designed to operate in indoor industrial or professional envir-
onments. In general, if a wheelchair can safely and easily navigate the environment (open,
with gentle slopes), then it is safe for the robot.

Guidelines for safe use:

l Clean, dry floors — floors that are regularly swept, and routinely kept free of debris and
liquids.

IMPORTANT: Since the robot is not water proof, floors must be kept rel-
atively dry, as any dampness can cause the wheels to slip. This can cause
problems for braking as well as navigation. Refer to ISO Standard 13849-2
for instructions on how to test the robot in non-standard environments.

l Gentle slopes — wheelchair ramps are a good example of the amount of slope the robot
can safely climb.

l Temperature — 5 to 40°C, with a recommended humidity range of 5% to 95%, non-con-
densing.
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2.5  Intended and Non-intended Use

Non-Intended Use

You must deploy the robot in a manner that takes into account potential risks to personnel
and equipment. The product is not intended for use in uncontrolled areas without risk ana-
lysis, for example, areas open to general public access. Use in such areas may require deploy-
ment of additional safety measures.

The LD Platform OEMs are not intended for use in any of the following situations:

l In hazardous (explosive) atmospheres

l In the presence of ionizing or non-ionizing radiation

l In life-support systems

l In residential installations

l Where the equipment will be subject to extremes of heat or humidity

l In mobile, portable, marine, or aircraft systems

NOTE: The gyroscope used to assist in platform navigation requires a sta-
tionary environment for optimum accuracy. Therefore, we do not recom-
mend them for use on a ship, train, aircraft, or other moving environment.

IMPORTANT: The instructions for operation, installation, and main-
tenance given in this guide and the AMR user’s guide must be strictly
observed.

Non-intended use of LD Platform OEMs can:

l Cause injury to personnel

l Damage itself or other equipment

l Reduce system reliability and performance

IMPORTANT: Since the robot is not water proof (IP20), floors must be
kept relatively dry, as any dampness can cause the wheels to slip. This
can cause problems for braking as well as navigation. Refer to 13849-2 for
instructions on how to test the robot in non-standard environments.

If there is any doubt concerning the application, ask your local Omron Support to determine if
it is an intended use or not.

Platform Modifications

If the user or integrator makes any changes to the platform, it is their responsibility to ensure
that there are no sharp edges, corners, or protrusions.

Note that any change to the platform can lead to loss in safety or functionality. The user or
integrator must ensure that all safety features are operational after modifications.
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2.6 Battery Safety

!
CAUTION: BATTERY DAMAGE RISK
After receiving the battery, immediately charge to a full charge to avoid dis-
charging the battery below a usable state, which would require battery replace-
ment.

Effective April 1, 2016, IATA regulations (UN 3480, PI 965) require that air-shipped lithium ion
batteries must be transported at a state of charge not exceeding 30%. To avoid total discharge,
fully charge the battery immediately upon receipt.

NOTE: If the battery was not sent by air, it may be fully-charged.

Safety Precautions

l Store batteries upright at:

nn One month: +5 to 45°C
nn One year: 20 to 25°C

l Never expose the battery to water. If the battery is leaking, submerge in mineral oil and
contact your local Omron Support.

l In case of fire, use a type ABC or type BC extinguisher: foam, dry chemical, or CO2.

Maintenance

Every six months:

l Inspect battery for damage or leaks

l Place battery on a charger and allow to fully balance (battery shows all solid LEDs
when fully balanced). For more information please refer to Balancing the Battery on
page 110

2.7 Additional Safety Information
Contact your local Omron Support for other sources of safety information:

Mobile Robot LD Safety Guide (Cat. No. I616)
TheMobile Robot LD Safety Guide (Cat. No. I616) provides detailed information on safety for
LD Platform OEMs. It also gives resources for information on relevant standards. It ships with
each platform.

2.8 Disposal

Dispose of in accordance with applicable regulations.

Customers can contribute to resource conservation and protecting the environment by the
proper disposal of WEEE (Waste Electronics and Electrical Equipment). All electrical and
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2.8  Disposal

electronic products should be disposed of separately from the municipal waste system via des-
ignation collection facilities. For information about disposal of your old equipment, contact
your local Omron Support.
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3.1 Overview
In general, setup is physically and logically preparing the platform, configuring the wireless
network, and installing the docking station. Physically preparing the platform includes attach-
ing your payload structure to the platform.

Setup also includes generating the map the platform will use for navigation. This manual
provides an overview of that process, which is covered in detail in the FLOW Core User's Guide
(Cat. No. I637).

Tasks

Most of the steps in setting up a platform are straightforward. You need to tailor the design
and construction of the payload structure to your application.

l Install the docking station. See Installing the Docking Station on page 49.

l Fully charge the battery, either outside of or inside the platform.

l Install the battery in the platform. See Installing the Battery on page 44.

l Set up the wireless Ethernet for the platform. See Settings and Configuration on page 57.

l Design, build, and install a payload structure to suit your application. See Payload Struc-
tures on page 65.

This is the most involved task in getting your AMR working the way you want.

l Configure the AMR for your environment, so it can perform useful tasks.

This includes generating the map that the AMR will use for its navigation. Mapping is
covered briefly in Mapping on page 60 and in detail in the FLOW Core User's Guide (Cat.
No. I637).

3.2 Transport and Storage

Platform

Ship and store the platform in a temperature-controlled environment, from -20 to 60°C . The
recommended humidity range is 5% to 95%, non-condensing. It should be shipped and stored
in the supplied shipping crate, which is designed to prevent damage from normal shock and
vibration. You should protect the crate from excessive shock and vibration.

Use a forklift, pallet jack, or similar device to move the shipping crate.

Always ship and store the platform in an upright position in a clean, dry area that is free from
condensation. Do not lay the crate on its side or any other non-upright position. This could
damage the platform.

The crate with pallet for the platform measures 1441 x 787 x 762 mm , and weighs 70 kg .
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3.3  Before Unpacking

Battery

NOTE: If you purchased a spare battery, this section applies to it also.

Storage Requirements

If the battery needs to be stored, the manufacturer recommends:

ll One month: +5 to 45°C
ll One year: 20 to 25°C

The battery should start storage fully-charged. If storing the battery for an extended period,
recharge the battery periodically to avoid total discharge, which would damage the battery.
Fully recharging a battery every six months is sufficient to keep it charged enough to avoid
damage.

Always store batteries upright.

Maintenance

Every six months:

l Inspect the battery for damage or leaks

l Place the battery on a charger and allow to fully balance (battery shows all solid LEDs
when fully balanced). Fully recharging a battery every six months is sufficient to keep it
charged enough to avoid damage.

3.3 Before Unpacking
Carefully inspect all shipping boxes and containers for evidence of damage during transit. If
any damage is indicated, request that the carrier’s agent be present at the time the container is
unpacked.

3.4 Unpacking
Before signing the carrier’s delivery sheet, compare the actual items received (not just the pack-
ing slip) with your equipment purchase order. Verify that all items are present and that the
shipment is correct and free of visible damage.

l If the items received do not match the packing slip, or are damaged, do not sign the
receipt.

l If the items received do not match your order, contact your local Omron Support imme-
diately.

Retain the containers and packaging materials. These items may be necessary to settle claims
or, at a later date, to relocate the equipment.
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Battery

The battery ships in a separate container, not inside the platform. The battery box measures
311 x 540 x 457 mm . Locate the cardboard carton that contains the battery before continuing.
Refer to the following figure.

Figure 3-1. Battery Shipping Carton

Remove the battery from the carton. The battery has recessed hand grips at the ends of the bat-
tery, for lifting.

Platform

The platform comes packed in a box, wrapped with cling wrap, and secured by plastic bands
on a pallet. Refer to the following figure.

The Docking station and Starter kit, if present, are packed in a separate box sitting on top of
the platform box.

The Docking station carton's dimensions in cm are 50.165 x 50.169 x 41.103.
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3.4  Unpacking

1. Remove plastic bands and unwrap the cling film.

Figure 3-2. Boxes Ship Wrapped with Cling Wrap

2. Unload the top box, if present. This contains the Docking station and Starter kit.

Figure 3-3. Unloading Top Box
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3. Open lower box containing the Platform.

Figure 3-4. Padding at the Corners

4. Remove the rectangular box cap, placed on top of the Platform for protection.

Figure 3-5. Rectangular Box Cap
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3.4  Unpacking

5. Remove all corner padding.

Figure 3-6. Corner and Top Padding

6. Lift the outer box up.

Figure 3-7. Outer Box Slides up

7. Lift the robot using two people holding the grips at each side of the cardboard carrier.

WARNING: Heavy object.
To avoid muscle strain or back injury, lifting with two people and
proper lifting techniques is required.
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Figure 3-8. Robot Being Lifted by its Cardboard Carrier

8. Remove the plastic protective sheet.

Figure 3-9. Protective Plastic Sheet Being Removed
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3.4  Unpacking

9. Roll the robot off of the cardboard and onto the floor. Since the wheels are pinned up,
the LD is just sitting on its casters, so no brake release is needed.

Figure 3-10. Robot Rolled onto the Floor

10. If the robot came with a top plate, connect the antennas as shown in following figure.

Figure 3-11. Robot Antennas Circled in Red

11. Remove the two wheel pins that held the wheels up during transit.

The wheels are pinned up to protect the motors and drives. When you receive your plat-
form, the drive wheels will not touch the ground until you remove the wheel pins.

For each side of the platform:

a. Remove the platform side skins.

See Removing and Installing Skins on page 152.
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b. Lift the wheel slightly to relieve pressure on the pin, then remove the pin by
pulling the attached ring. See the following figure for the location of the wheel
pin hole.

Save these pins for later service of the drive assemblies.

Figure 3-12. Wheel Pin and Wheel Pin Hole

c. Reinstall the two side skins.

12. Install the battery in the platform.

The platform brakes cannot be released until the battery is installed. Refer to Installing
the Battery on page 44.
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3.5  Battery

3.5 Battery

NOTE: If you purchased a spare battery, this section applies to it also.

Storage Requirements

If the battery needs to be stored, the manufacturer recommends:

ll One month: +5 to 45°C
ll One year: 20 to 25°C

The battery should start storage fully-charged. If storing the battery for an extended period,
recharge the battery periodically to avoid total discharge, which would damage the battery.
Fully recharging a battery every six months is sufficient to keep it charged enough to avoid
damage.

Always store batteries upright.

Maintenance

Every six months:

l Inspect the battery for damage or leaks

l Place the battery on a charger and allow to fully balance (battery shows all solid LEDs
when fully balanced). Fully recharging a battery every six months is sufficient to keep it
charged enough to avoid damage.

3.6 Installing the Battery
Your platform comes fully-assembled, less the battery.

NOTE: Air shipping regulations require that the battery be shipped separately.

Removing the Battery Door Skin

Accessing the battery compartment requires removing the platform's rear battery skin, which is
held in place with magnets.

!
CAUTION: PINCH RISK
The magnets holding the skin in place are strong enough to pinch you if you
are not careful.

No tools are needed for either the removal or installation of the battery door skin.

NOTE: After removing the skin, place it inner-side down, so the outer surface
doesn't get scratched.
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Figure 3-13. Pulling the Bottom of the Rear Platform Cover Out

Figure 3-14. Lowering the Battery Door Platform Skin
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3.6  Installing the Battery

Refer to Removing and Installing Skins on page 152 for details on removing and installing
skins.

1. Remove the battery door skin.

a. Pull the bottom of the skin away from the platform chassis.

This is easiest if you grip it with two hands, toward the center.

b. Lower the skin down enough that its top tab clears the rear skin.

2. Unlatch and open the battery compartment door.

The battery compartment door is lockable, and you might need to unlock it.

3. Lift and slide the new battery into the platform body.

The battery weighs 19 kg.

The battery has recesses at the front and the back for easier lifting.

Figure 3-15. Battery Recesses, for Gripping

A single person can lift and replace the battery. Use one hand in each of the grips, as
shown in the following figure.
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Figure 3-16. Lifting the Battery

The connectors for power and data go toward the rear of the platform.

4. Attach the battery power and data cables to the connectors at the rear of the battery.

Figure 3-17. Battery Cable Connectors, (A) Battery Charge Level, (B) Power Connector, (C) Data
Connector

5. Close the battery compartment door to secure the battery in place.

Closing the battery compartment door holds the battery tightly in place to keep it from
shifting inside the compartment.

6. Reinstall the battery door platform skin.
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3.7  Attaching the Payload Structure and Options

3.7 Attaching the Payload Structure and Options

Payload Structure

You will need to attach the payload structure you designed and built to the platform. Because
the payload structure is user-designed, we only provide the hole pattern for how you can
attach it. Refer to Dimensions and Design on page 67.

The connections, both power and signal, that are available on the platform are covered in Con-
nectivity on page 77.

Options

You may need to attach any accessories that were shipped separately or detached for safety.
See Payload Structures on page 65.

NOTE: There must be either an E-Stop jumper or a user-supplied E-Stop button
attached to the E-STOP port (User Interface) for the platform to function. The
jumper is provided as P/N 12730-000L. An E-Stop button would be user-sup-
plied. Refer to User Interface on page 90.

NOTE: See the following figure.

Figure 3-18. E-Stop Jumper on LD Platform Core
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Warning Buzzer

The Light Pole connector on the core can power a warning buzzer. You can install it in either
the platform or in a location of your choice in your payload structure. In either case, the buzzer
will sound intermitently whenever the AMR is moving in reverse.

How you install the buzzer in the payload structure depends on the payload design, and is
not covered here. To conform to applicable standards, the buzzer must be audible in all oper-
ating conditions and environments.

The buzzer is configured with MobilePlanner, using the following parameters:

NOTE: These parameters are only available with the Mobile Robot Software
FLOW Core 1.0 and later.

Table 3-1. Default Parameters

Parameter Default Setting

DriveWarningEnable True

NOTE: If this parameter is set to False, the
remaining parameters will not be displayed.

IMPORTANT: Disabling the DriveWarn-
ingEnable parameter violates the JIS D 6802
standard. It is strongly recommended that you
leave this set to True.

DoNotWarnDrivingForwards False

DoNotWarnTurningInPlace False

DriveWarningLoudMilliseconds 500; If DriveWarningQuietMilliseconds is 0, this parameter is
irrelevant.

DriveWarningQuietMilliseconds 500; This is the length of time between warnings that the
buzzer is silent. Setting this to 0 will cause a continuous warn-
ing.

Warning Light

Each AMR must have a readily visible flashing light, to warn people that the AMR is ready to
move or is moving. The exact nature of this light depends on how the payload is designed
and built. The user-suppled warning light can be driven from the Light Pole connector on the
core.

You should ensure the light remains visible under all operating conditions, so that, regardless
of your payload structure design, any people near the AMR can see it.

3.8 Installing the Docking Station
The automated docking station can either manually or automatically charge your platform's
battery.
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3.8  Installing the Docking Station

The docking station sits on the floor. You can attach it to a wall with the wall bracket, directly
to the floor with screws through its base, or it can sit stand-alone on the floor with the floor
plate, all of which will keep the docking station from moving when the AMR docks. Each
docking station includes both the wall bracket and floor plate.

NOTE: It is very important that you mount the docking station with one of
these methods, or the AMR will simply move the docking station when it tries to
dock, rather than docking successfully.

For all mounting methods:

l Place the docking station near an AC outlet with 1 - 2 m of clear space around the unit
to ease the AMR’s maneuvers, especially automated ones, onto the docking station.

l The top of the docking station foot is spring-loaded, and lifts off of the bottom of the
base slightly to accommodate variations in the floor surface. The weight of the AMR
will push the top of the foot down.

Requirements

l 100-240 VAC, 50/60 Hz, 8 A

The station's power converter automatically detects the source voltage.

l Ambient operating temperature: 5 to 40°C

l 5% to 95% humidity, non-condensing

Wall Bracket Mount

1. Attach the docking station mounting bracket to a wall, with the bottom edge of the
bracket 98±20 mm above the floor, using user-supplied anchors and screws. There is lee-
way, so you can adjust the height a little bit.
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Refer to the following figure:

Figure 3-19. Docking Station, (A) Wall Mount and (B) Wall Mount Bracket (units are mm)

2. Screw the two shoulder bolts, each with a washer, into the rear of the docking station.
The shoulder bolts are M5 x 4, stainless steel. Their locations are shown in the fol-
lowing figure. Tighten to 9 N·m.
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3.8  Installing the Docking Station

Figure 3-20. Rear View of Docking Station with Wall Bracket

3. Lower the docking station down, so the two bolts on the back of the docking station
slide into the bracket, to secure the docking station to the wall.

Floor-mount, without Floor Plate

Screw the base of the docking station directly to the floor, using three user-supplied screws. For
dimensions of the available holes in the base, refer to Figure 3-19. We recommend M5 self-
tapping screws for this.

Floor-mount, with Floor Plate

This mounting method uses the floor plate. The floor plate is not shipped attached to the dock-
ing station, so you must attach it for this type of mount. It will be in the crate with the plat-
form, right behind the docking station.

Attaching the Floor Plate

Refer to the following figures.

1. Tip the docking station onto its back, so you can access the underside.

2. Remove the two lowest screws (M4 x 12 flat-head), if present.

In the following figure, these screws are circled. The location of the third screw hole is
also circled.

3. Attach the floor plate to the base of the docking station with three M4 x 12 flat-head
stainless steel screws.

The floor plate comes with three screws, so you will have two spares.

The docking station and floor plate do not need to be attached to the floor, as the weight of the
AMR on the floor plate will keep the docking station from moving.



Chapter 3: Setup

Figure 3-21. Underside of Docking Station Foot, Showing Screw Locations

NOTE: These are the three locations for the M4 x 12 flat-head screws. Two are
already in place, and need to be removed before attaching the plate.
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3.8  Installing the Docking Station

Figure 3-22. Docking Station, Mounted on Floor Plate

Figure 3-23. Docking Station Floor Plate Dimensions (units are mm)
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All Mounting Methods 

Install the power cord and turn the power switch to ON. The power switch is next to the
power plug. The blue power LED indicator should light.

Docking Station Contact Adjustment

The contacts on the docking station have five height settings. The station ships with the height
in the highest setting. The height can be changed by tilting the station enough to see the bot-
tom of the base, making the adjustment accessible.

Additional Information: Squeeze and keep the docking station’s foot against the
base to make this adjustment easier.

Adjust the height of the contacts by using the pull-knob on the bottom of the dock. The height
changes by 4 mm for each notch. See the following figure.

Figure 3-24. Docking Station Contact Adjusting Pull-Knob

Set the height of the contacts so that the roller is high enough to stay in contact with the plat-
form as it is docking, but low enough so that the bi-level of the roller guides the paddle under
the platform.
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This chapter describes the steps needed to configure your new platform.

The LD Platform OEM comes with firmware and on-board software installed.

The platform navigates using a map, generated with the MobilePlanner software. The map
must be generated and downloaded to the platform before you can perform the steps covered
in the Operation chapter of this manual.

Though the platform is autonomous, you can monitor and manually control the robot through
the MobilePlanner software, which also allows you to configure parameters. The FLOW Core
User's Manual (Cat. No. I637) covers using this software, and downloading a map to the plat-
form.

IMPORTANT: Turn off the software when not in use.

Other setup, mostly for communication, is handled with the SetNetGo OS, which is accessed
through the MobilePlanner software. It can also be accessed through a direct connection, so
your IT support can set up your wireless without needing the MobilePlanner license.

4.1 Settings and Configuration

Maintenance Ethernet Connection

To prepare your platform for autonomous mobile operation, attach a PC to the platform’s main-
tenance Ethernet port, and connect with the SetNetGo OS through the MobilePlanner SetNetGo
interface.

Figure 4-1. (A) PC, (B) Cat 5 Ethernet, and (C) Maintenance Access Panel

If you do not have wireless yet, you can connect MobilePlanner through the wired Ethernet
port (Maintenance LAN) and set up the wireless network later.
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4.1  Settings and Configuration

The core is preset and tested on a Class-C network (netmask for all ports 255.255.255.0). The
Maintenance Ethernet port is set to IP address 1.2.3.4 and the wireless IP comes set with an
AP-based (“managed”) SSID of “Wireless Network”, unsecured. Consult with your network
systems administrator before modifying these network details through the SetNetGo OS.

The User LAN port is set to IP address 10.10.10.10.

Refer to the FLOW Core User's Guide (Cat. No. I637).

The Maintenance Ethernet plugs into the left side of the platform, under the small access panel
at the upper right corner of the platform (the Pendant port is also there). The access panel is
held in place with a push-push latch, and retained by a lanyard. See Figure 8-1. This is intern-
ally connected to the Ethernet port located on the rear side of the LD Platform core in the pay-
load bay.

The Maintenance Ethernet port is permanently set to IP address 1.2.3.4, with a netmask of
255.255.255.0, for direct, wired access to the onboard systems. Access to the SetNetGo OS is
always enabled on this interface, and does not require a password or a license. Accordingly,
when accessing the port, manually set the off-board computer’s Ethernet to an IP 1.2.3.x, where
x is any number 1 through 254 except 4, and with a netmask of 255.255.255.0. No special DNS
or gateway settings are needed.

Attach a pass-through or cross-over CAT5 (or better) Ethernet cable between the PC and the
Maintenance Ethernet port of the platform. The platform Ethernet is Auto-MDIX, and will
detect the type of cable you are using.

Start the Network Connections: Local Area Connection dialog for the ETH 0 Ethernet port:

(Windows 7) Start > Settings > Network Connections > Local Area Connection

(Windows 10) Start > Settings > Network and Internet > Change Adaptor
Options > Local Area Connection

Select Properties, and, from its dialog, scroll to and double-click the Internet Protocol (TCP/IP
or TCP/IPv4) option. In the Internet Protocol (TCP/IP) Properties dialog, click both ‘Use the fol-
lowing…’ associated radio buttons to enable them, and then type in the IP and Subnet mask
values.

Setting Up Wireless Ethernet

Use SetNetGo OS to configure the wireless Ethernet, among other things. Refer to the FLOW
Core User's Guide (Cat. No. I637) for details.

NOTE: The AMR can work without wireless Ethernet. If there are no other
AMRs that it needs to know about (and avoid), you can have an installation in
which the AMR simply uses its map, knows its patrol route, and performs
without human intervention.

NOTE: For all of the following settings, work with your IT group to verify the
correct IP, radio, and security settings.

The following applies to the wireless Ethernet supported by the platform.
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Access the SetNetGo OS through the MobilePlanner software:

MobilePlanner > SetNetGo > Networking

NOTE: You can use a web browser to connect directly to the SetNetGo OS on a
platform. This allows your IT support to set up the network for you, without
using MobilePlanner which requires a license.

IP Address, Netmask, Gateway, DNS1

Choose Static (DHCP is not recommended), and fill in the IP address, netmask, gateway, and
DNS1, as supplied by your network administrator.

NOTE: See your IT department for the following settings.

Radio Settings

l SSID (e.g. AGV)

Fill in the appropriate wireless SSID for your wireless network.
The SSID is case sensitive.

l Mode

Managed/STA, Ad-Hoc, or Master/AP

l Radio Mode

Auto, 802.11a, 802.11b, 802.11g, 802.11n, 802.11ac

l Channel Set

l Wireless Watchdog IP Address

l Wireless Watchdog Max Count

0 disables this.

Security Settings

Encryption:

l Disabled

l WEP 64-bit

l WEP 128-bit

l TKIP/RC4

l CCMP/AES

l TKIP/CCMP/AES

Authentication:

l OPEN

l WPA-PSK
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4.2  Mapping

l WPA2-PSK

WEP

l WEP Key Number (Key 1 - Key 4)

l WEP Keys

WPA/WPA2-PSK

l PSK

l PSK-Type (Passphrase or Raw Hex)

Click Apply for your changes to take effect.

Wireless Coverage

There must be wireless coverage for multi-AMR installations, or in areas where you wish to
send new commands to or receive status updates from the AMR.

For these cases, ensure you have adequate wireless coverage. Because of the possible vari-
ations in different environments, we don’t specify what components or techniques to use.

We do suggest that you conduct a comprehensive site survey to ensure adequate wireless cov-
erage. You can test your wireless setup coverage by trying to ping it from various locations.

>= -40 dBm is the ideal WiFi signal strength, -60 dBm is the recommended minimum.

Bandwidth Considerations

The typical bandwidth for a fleet averages about 50 Kbps/AMR. This would increase if the
AMR is connected to the Fleet Manager, and is actively viewed by MobilePlanner. This num-
ber can increase or decrease depending on the types of commands and debugging tools that
are enabled in MobilePlanner. In any case, the bandwidth is not likely to exceed 500 Kbps per
AMR (0.5 Mbps).

0.5 Mbps per AMR would easily fit within the capabilities of access points (>=54 Mbps). If you
have multiple access points, this number becomes even less of a concern.

Also, other factors will affect the bandwidth requirements, such as if the AMR supports a cam-
era on top and streams the video through the AMR’s WiFi interface. Based on such pos-
sibilities, the bandwidth usage will vary by application.

4.2 Mapping

Mapping Overview

Out-of-the-box, the platform does not have a working map, and its wired or wireless network
settings are unlikely to match your network. Consequently, it will not do anything autonom-
ously. To have your platform perform autonomously, you need to make a map of its operating
space. Use the MobilePlanner application to make maps.

You develop maps with the MobilePlanner software. You can add a variety of virtual elements
that modify the behavior of an AMR. Virtual elements include forbidden lines and areas,
speed zones, preferred-direction zones, and more, all working to help you configure your work-
space for efficient and safe performance of your mobile application. You can also create your
own virtual elements for application-specific AMR-workspace interactions.
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Maps contain a variety of goals, routes, and tasks that comprise the destinations and activities
of the AMR in the workspace.

Refer to the FLOW Core User's Guide (Cat. No. I637).

Mapping Tasks

l Install the automated docking station before you create a map file. Its distinctive front
angle will be helpful in locating it on the map.

l Drive the platform with the Pendant to make a floor plan scan. We recommend that you
drive it to and position it onto its automated docking station to prepare for the next
steps.

l Load that floor plan scan into the MobilePlanner software on your PC to make and edit
a map.

l Add goals and docks to your map. In particular, refer to:

Working With Map Files > Editing a Map File >
Using the Drawing Tools > Adding Goals and Docks

in the FLOW Core User's Guide (Cat. No. I637).

l Transfer the working map to the Fleet Manager, or back to the platform, if you have
only one AMR, to perform autonomous mobile actions.

The Fleet Manager will automatically download the new map to each AMR in your
fleet as soon as the AMR becomes idle.

l Save map collections and deploy your AMR in any of your working spaces by selecting
the appropriate map file.

4.3 Acceleration, Deceleration, and Rotation Limits

!
CAUTION: PROPERTY DAMAGE RISK
If you change AbsoluteMaxTransVel, you should commission the AMR before
putting it into service.

Reducing the absolute max allowable linear and rotational acceleration, deceleration, and
speed will affect the size of the allowable CG envelope, but could do so in non-obvious ways.
For use-cases where the payload can’t be decreased, or the CG can’t be brought within the
recommended limits, our Field Service department can work with your system designer to
input your needs into our models.

Contact your local Omron Support for details.

From the MobilePlanner software, Config:

Robot Physical > Absolute Movement Maximums

Check the Show Expert + Parameters to see or modify these parameters.

The first four parameters and AbsoluteMaxRotVel are not likely to have significant impact on
the AMR‘s stability. The Accel and Decel parameters will have a major impact. In certain
cases, if the payload is lopsided, you might need to adjust the AbsoluteMaxRotVel.

The limits and defaults for these parameters are listed in the following table.
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4.4  Supplemental Information

Parameter Default Min Max

AbsoluteMaxTransVel (LD-60) 1800 1 2500

AbsoluteMaxTransVel (LD-90) 1350 1 2500

AbsoluteMaxTransNegVel (LD-60) -280 -2500a -1

AbsoluteMaxTransNegVel (LD-90) -210 -2500a -1

AbsoluteMaxTransAccel 1000 1 2000

AbsoluteMaxTransDecel 2000 1 2000

AbsoluteMaxRotVel 180 1 180

AbsoluteMaxRotAccel 360 1 360

AbsoluteMaxRotDecel 360 1 360

a: Although the Min value, in software, is -2500, the hardware safety system on the platform will
generate a fault if the velocity is anything from -300 to -2500 mm/s.

Configuring for an Overhanging Payload

When configuring a robot with an overhanging payload, certain additional precautions and
settings must be made to ensure safety and proper function. To prevent potential danger in the
case of a safety zone intrusion or emergency stop button press, the robot's deceleration must be
dictated by the user-settable parameter Configuration: Robot Physical: Absolute Movement
Maximums: AbsoluteMaxTransDecel. Additionally, the size of the robot's default safety zones
are programmed directly into the laser hardware and are dependent on the following set of
factors:

l Using the robot within its specified payload and center-of-gravity limits

l Using the robot on surfaces that adhere to the robot’s specified floor flatness, levelness,
slope, cleanliness

l The floor coefficient of friction with robot drive wheels

l The AbsoluteMaxTransDecel setting

l The footprint of the robot without any overhangs

If any of these items change, the user is responsible for verifying that the robot will stop at any
speed before hitting a dark colored target representative of the smallest potential obstacle in
their environment. Introducing overhanging payloads or reducing the AbsoluteMaxTransDecel
will directly affect safety zone sizes. Users must increase safety-zone sizes and re-test stopping
ability at all speeds if either of these two parameters are changed. Users should not expect the
robot to stop safely if these factors are changed without also increasing the size of the safety
zones.

4.4 Supplemental Information

Laser Setup

For most installations, the defaults for the lasers should be appropriate, and will not require
any user adjustment. Laser setup and configuration for optional or additional lasers is covered
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in the LD Platform Peripherals Guide, Chapter 7.

The specific parameters for these lasers will come in the model config file that ships on the
unit, or can be provided on request if needed.

l Laser_1 Settings are for the main scanning laser, used both for safety and localization.

l Laser_2 Settings are for the low front laser (TiM).

l Laser_3 Tilted and Laser_4 Tilted are for the side lasers (TiM).
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Everything that you attach to the LD Platform OEM is referred to as the payload structure. In
some custom cases, we design and build the payload structure. In most cases, you will need to
design a payload structure that suits your application.

Figure 5-1. LD Platform OEM-Compatible Payload Structure Examples, (A) Courier, (B) Smif Pod
Transporter, (C) Cart Transporter, (D) Custom Payload, and (E) LD Platform OEM

The image above shows some of the available pre-designed Omron payload structures, as well
as an outline of a user custom-designed payload structure. The platform provides the mobility
and navigation you will need, as well as power and I/O connections between the platform and
your payload structure, so the two can work effectively together.

This chapter discusses considerations to be aware of when you design a payload structure for
your platform.

5.1 Safety

Warning Label

A No Riding label ships, unattached, with each platform. You must place this in a prominent
location on the payload, so operators will see it.
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5.2  Considerations

Other warning labels are applied at the factory.

Warning Lights

To comply with CE requirements, an AMR must have a readily-visible warning device, such
as a flashing light, when it is either ready to move or is moving. The platform comes with
light discs on each side that do this. The core also provides an output, so you can add your
own warning device. This may be necessary for taller payloads, which may make the side
light discs not always visible. The core has a Light Pole connector, which is covered in LD Plat-
form Core Rear, Upper on page 87. This can be used to drive a warning device in a more prom-
inent location for taller AMRs.

Warning Buzzer

The core provides an output for driving a warning buzzer. The default behavior of the buzzer
is to sound when the AMR is moving in reverse, or when the safety systems are off. Its beha-
vior is configurable by the user, so it can be used to sound, for example, whenever the AMR is
moving.

5.2 Considerations

Performance

The main performance factors to consider in designing a payload structure are the size,
weight, and center of gravity of the payload structure, and power requirements. Adding weight
to the platform tends to have less effect on run-time than adding electrical power requirements.
Operating your AMR on carpet will have a significantly shorter run-time than on hard sur-
faces.

Weight

On a hard surface, a certain amount of extra weight will not shorten the AMR's run-time very
much. When adding a payload structure with substantial weight, the center of gravity of the
entire AMR needs to be considered. This is particularly important if you intend to equip the
platform with a robot arm, which would be lifting items off-center from the platform. A heavy
payload structure, with most of its weight concentrated just above the platform, will be much
more stable than the same weight payload structure in which the weight is either off-center or
high above the top of the platform.

NOTE: The weight of your payload structure plus the weight of the parts it is
carrying must not exceed the rated capacity of your platform.



Chapter 5: Payload Structures

Power Consumption

Using devices on your payload structure that consume significant power will noticeably
shorten the run-time of the AMR. You should try to minimize such power consumption
whenever possible. The battery is rated at 1800 W*hr (1.8 kWh). Examples of power-con-
suming payload structures would be one with a robot arm attached, or any motorized fixture,
such as a conveyor, as part of the payload structure. The standard Operator screen and light
discs consume some power, but are not significant compared to the rest of the platform.

Payload Bay Access

The area between the platform and your payload structure is the payload bay. You will occa-
sionally need to access the platform and the connectors in the payload bay. This is where you
can access all of the platform power and I/O connectors. It's a good idea to provide for access
to this when designing your payload structure. If the payload structure is small and light
enough, you can lift it off of the platform to access the connectors in the payload bay. Always
take care to not damage any wiring between your payload structure and the platform. A larger,
heavier payload structure might need some form of hinge, so you can tilt the payload structure
out of the way while you access the payload bay. You should consider harness length and pos-
ition so you can accomplish this without disconnecting or damaging any connectors or har-
nesses.

Dimensions and Design

Keep your payload structure no wider and no longer than the platform. Add whatever features
your application needs above the platform itself.

Keep all of the payload structure higher than the top of the platform. If the payload blocks any
of the platform's sensors, it won't be able to function correctly. This is critical in the case of the
lasers. If you have the optional side-mount lasers for your payload structure, ensure that the
payload structure will not interfere with the laser's beams. Typically, the side lasers are moun-
ted on the sides of the payload structure so that they protrude enough to miss the payload
structure itself with their laser beams.

Many customers have found it prudent to build a protective guard over the side lasers, to pro-
tect the lasers from impact. Ensure that any such guard does not block the laser beam.
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5.2  Considerations
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Figure 5-2. PlatformDeck Dimensions, with M6-threaded Holes (units are mm)

Callout Description

A Upper Mounting Surface

B 24x M6 Threads

C Lower Mounting Surface 40.7 below Upper Surface

In the preceding figure, all of the M6 self-clinching nuts (B) have a torque limit of 3 N·m .

!
CAUTION: PROPERTY DAMAGE RISK
Do not exceed this torque when attaching your payload structure to these self-
clinching nuts. See NOTE that follows.
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Figure 5-3. PlatformDeck Dimensions, with M5-threaded Holes (units are mm)

Callout Description

A 8x M5 Threads

B Lower Mounting Surface 40.7 [1.60] below Upper Surface

In the preceding figure, all of the M5 self-clinching nuts have a torque limit of 14 N-m.

NOTE: The M6 self-clinching nuts are inserted differently than the M5 self-
clinching nuts, to increase the usable thread length. This also decreases the
torque that you can apply to them, so the M5s have a much higher torque limit
than the M6s in this application.

Center of Gravity (CG)

As much as possible, you should keep the payload structure CG centered on the platform, and
as low (close to the platform top) as possible. This will give you the best stability, particularly
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5.2  Considerations

when crossing thresholds or irregularities in the floor. Keep the payload centered on the plat-
form left-to-right, but biased toward the rear of the platform according to the following figures.
The following figure shows the platform‘s center of gravity, without payload structure.

669

345.3

188.7

16.5

383

Figure 5-4. Platform Center of Gravity (CG), (A) CG, (B) Wheel Axis (units are mm)

The following figures show the calculated safe CG placements for payload structures with the
listed weights. The payload structure's CG, in each instance, needs to be within the area
shown. All units are mm.

NOTE: These figures show the limits of where to place the payload structure
CG. You should try to keep your CG as close to the center of these figures as pos-
sible.

60 kg
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Figure 5-5. Isometric View, 60 kg, (A) Vertical Direction, (B) Longitudinal Direction, (C) Transverse
Direction (units in mm)

Figure 5-6. Longitudinal View, 60 kg, (A) Vertical Direction, (B) Longitudinal Direction (units in mm)

Figure 5-7. Transverse View, 60 kg, (A) Vertical Direction, (C) Transverse Direction (units in mm)
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5.2  Considerations

Figure 5-8. Top View, 60 kg, (B) Longitudinal Direction, (C) Transverse Direction (units in mm)

90 kg

Figure 5-9. Isometric View, 90 kg, (A) Vertical Direction, (B) Longitudinal Direction, (C) Transverse
Direction (units in mm)
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Figure 5-10. Longitudinal View, 90 kg, (A) Vertical Direction, (B) Longitudinal Direction (units in
mm)

Figure 5-11. Transverse View, 90 kg, (A) Vertical Direction, (C) Transverse Direction (units in mm)
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5.3  Connections Between Platform and Payload Structure

Figure 5-12. Top View, 90 kg, (B) Longitudinal Direction, (C) Transverse Direction (units in mm)

5.3 Connections Between Platform and Payload Structure
The platform provides a variety of I/O and power connections, which you can use to make
your AMR more effective.

Operator Panel

The Operator screen, E-Stop, Brake-release, ON, and OFF can be "moved" using a single con-
nector (the HMI Panel connector). This allows you to put many of the more common operator
controls somewhere on your payload structure with just one cable.
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Figure 5-13. Standard Operator Panel (units are mm)

Callout Description Callout Description

A Emergency Stop E 15 Pin High Density D-Sub Punch

B Brake Release F 2x 0.120 Through Hole

C On Button G 7x 0.213 Through Hole

D Off Button

A larger Operator panel, with a touchscreen, is available as an option. See Touchscreen on
page 205. Many other connections are available. For details and specifications of available con-
nections, refer to Connectivity on page 77.

Option Connections

The platform provides connectors for user-supplied payload bumpers that you can place on
the payload structure.
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Most of the connections that are available to the user are in the payload bay, which is the
space between the platform and any payload structure placed on top of it. These include I/O
and power connections. Some are required, others are available if needed.

The two connections outside of the payload bay are the Pendant port and the Maintenance Eth-
ernet port, which are located under a small access panel on the left side of the platform, in the
upper-right corner. See Figure 8-1.

Both of these ports are connected to the core inside the payload bay.

6.1 Required Connections

l Pendant port In order to generate maps with the platform, you need to connect a
Pendant to Pendant port.

The Pendant port is located under a small access panel on the left side
of the platform, in the upper-right corner.

This is internally connected to the core in the payload bay.

l Maintenance
Ethernet

The Maintenance Ethernet port is located under a small access panel
on the left side of the platform, in the upper-right corner. This is intern-
ally connected to the core in the payload bay.

The Maintenance Ethernet port is permanently set to IP address
1.2.3.4, with a netmask of 255.255.255.0, for direct, wired access to the
onboard systems. Access to the SetNetGo OS is always enabled on this
interface, and does not require a password or a license. Accordingly,
when accessing the port, manually set the off-board computer’s Eth-
ernet to an IP 1.2.3.x, where x is any number 1 through 254 except 4,
and with a netmask of 255.255.255.0. No special DNS or gateway set-
tings are needed.

l Wireless
Ethernet

For multi-AMR installations, or where you wish to send new com-
mands or receive status updates from the AMR, you need to have
wireless Ethernet.

l Docking
Station

The AMR needs access to a docking station so it can charge itself. The
docking station needs access to AC power.

6.2 Payload Bay Connections - Core
These connections are available for use with standard and user-supplied accessories. The
antennas come with the platform.

The Pendant is an option, but at least one is required per fleet for map-making.
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6.2  Payload Bay Connections - Core

NOTE: Standard connectors, such as audio, are not covered here. This includes
all of the connectors on the right side of the core, labeled (G) in the following fig-
ure.
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LD Platform Core Front, Upper

CAN Bus B Digital I/O Analog I/O

User LANRS232-1RS232-2Aux Sensors

Figure 6-1. Front Upper Core

Table 6-1. Front Upper Core Details

Connection Type Description

User LAN RJ45 General Ethernet, Auto-MDIX, shielded

Aux Sensors HDB15M Low front and optional side lasers

RS-232 x 2 DB9M Port 1 and Port 2, general use

CAN Bus B DB9F Consult your local Omron Support for use.

Digital I/O (HDB44F) HDB44F 16 digital inputs, in 4 banks of 4. Each bank can be
wired as active high or active low depending on the
connection of the BANK# terminal.
VIN range for each input is 0 to 30 V. The input is
ON when VIN > 4 V, OFF when VIN < 1.3 V.

16 digital outputs, protected low-side drivers. Wire
these outputs to positive voltage through the load.
Output is open when OFF and grounded when ON.
Each open-drain output is capable of sinking 500
mA. May be used with loads connected to VBAT,
AUX_20V, _12V, or _5V. You must stay within the
allowed current capacity of the VBAT or AUX power
supplies.

Analog I/O HDB15M General use

Core Right, Upper

Digital Ant1 Ant2

Audio In Audio Out

Audio Out
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6.2  Payload Bay Connections - Core

Figure 6-2. Right Upper Core

Table 6-2. Right Upper Core Details

Connection Type Description

Digital Audio Out TOSLINK:

JIS F05

Reserved for future use.

Ant1, Ant2 RP-SMAF WiFi Antennas

Audio In Audio Out Audio: 3.5mm jack

TOSLINK: JIS F05

Audio can be recorded though amicrophone
connected to the audio IN port, using the
ARAM function 'recordsoundfile'.

CAN Bus B

Connector type DB9F

Use CAN Bus

Pin No. Designation Notes

1, 4, 8 No Connection

2 CANL_B CAN Communication differential pair

3, 6 GND Direct GND

5 SHIELD GND Bead filter to GND

7 CANH_B CAN Communication differential pair

9 CANB_12V_OUT_SW 12 V@ 0.5 A Max (switched in SW)

Digital I/O

Connector type HDB44F

Designation

Pin No. Hardware Software Notes

1 INPUT_1.1 Input_1.1 0 – 30 V Range, Rin= ~3.9 kΩ

2 INPUT_1.2 Input_1.2 0 – 30 V Range, Rin= ~3.9 kΩ

3 INPUT_1.3 Input_1.3 0 – 30 V Range, Rin= ~3.9 kΩ

4 INPUT_1.4 Input_1.4 0 – 30 V Range, Rin= ~3.9 kΩ

5 BANK1 Common for INPUT_1.X



Chapter 6: Connectivity

Designation

Pin No. Hardware Software Notes

6 INPUT_2.1 Input_2.1 0 – 30 V Range, Rin= ~3.9 kΩ

7 INPUT_2.2 Input_2.2 0 – 30 V Range, Rin= ~3.9 kΩ

8 INPUT_2.3 Input_2.3 0 – 30 V Range, Rin= ~3.9 kΩ

9 INPUT_2.4 Input_2.4 0 – 30 V Range, Rin= ~3.9 kΩ

10 BANK2 Common for INPUT_2.X

11 INPUT_3.1 Input_3.1 0 – 30 V Range, Rin= ~3.9 kΩ

12 INPUT_3.2 Input_3.2 0 – 30 V Range, Rin= ~3.9 kΩ

13 INPUT_3.3 Input_3.3 0 – 30 V Range, Rin= ~3.9 kΩ

14 INPUT_3.4 Input_3.4 0 – 30 V Range, Rin= ~3.9 kΩ

15 BANK3 Common for INPUT_3.X

16 INPUT_4.1 Input_4.1 0 – 30 V Range, Rin= ~3.9 kΩ

17 INPUT_4.2 Input_4.2 0 – 30 V Range, Rin= ~3.9 kΩ

18 INPUT_4.3 Input_4.3 0 – 30 V Range, Rin= ~3.9 kΩ

19 INPUT_4.4 Input_4.4 0 – 30 V Range, Rin= ~3.9 kΩ

20 BANK4 Common for INPUT_4.X

21 OUTPUT_1 Output_1

22 OUTPUT_2 Output_2

23 OUTPUT_3 Output_3

24 OUTPUT_4 Output_4

25 OUTPUT_5 Output_5

26 OUTPUT_6 Output_6

27 OUTPUT_7 Output_7

28 OUTPUT_8 Output_8

29 OUTPUT_9 Output_9

30 OUTPUT_10 Output_10

31 OUTPUT_11 Output_11

32 OUTPUT_12 Output_12

33 OUTPUT_13 Output_13

34 OUTPUT_14 Output_14

35 OUTPUT_15 Output_15
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6.2  Payload Bay Connections - Core

Designation

Pin No. Hardware Software Notes

36 OUTPUT_16 Output_16

37 VBAT_IO_OUT4 VBAT@ 0.5 A Max
(sharedwith light pole)

38 VBAT_IO_OUT3 VBAT@ 0.5 A Max

39 VBAT_IO_OUT2 VBAT@ 0.5 A Max

40 VBAT_IO_OUT1 VBAT@ 0.5 A Max

41 - 44 GND
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Digital Input Specifications

Table 6-3. Digital Input Specifications

Parameter Value

Operational voltage range 0 to 30 VDC

OFF state voltage range 0 to 1.3 VDC

ON state voltage range 4 to 30 VDC

Operational current range 0 to 7.5 mA

OFF state current range 0 to 0.5 mA

ON state current range 1.0 to 7.5 mA

Impedance (Vin/Iin) 3.9 kΩ minimum

Current at Vin= +24 VDC Iin≤ 6 mA

NOTE: The input current specifications are provided for reference. Voltage
sources are typically used to drive the inputs.

Figure 6-3. Typical Digital Input Wiring Example  
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6.2  Payload Bay Connections - Core

Callout Description Callout Description

A Supplied Equipment H Input Bank 1

B User-Supplied Equipment J Input Bank 2

C Wiring Terminal Block K Input Bank 3

D Typical User Input Signal L Input Bank 4

E Part Present Sensor M Note: all input signals can be used
for either sinking or sourcing con-
figurations.

F Bank 1 configured for sinking
(NPN) inputs

N Equivalent Circuit

G Bank 4 configured for sinking
(PNP) inputs

Table 6-4. Digital Output Specifications

Parameter Value

Power supply voltage range 5 - 30 VDC

Operational current range, per channel Iout ≤ 500 mA

ON state resistance (Iout = 0.5 A) Ron≤ 0.14 Ω @ 85°C

Output leakage current Iout ≤ 5 μA

DC short circuit current limit 0.7 A ≤ ILIM≤ 1.7 A

Figure 6-4. Typical Digital Output Wiring Example
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Callout Description Callout Description

A Standard Equipment E Load

B User-Supplied Equipment F Outputs 1-16

C Wiring Terminal Block G Equivalent Circuit

D Typical User Loads

Analog I/O

Connector type HDB15M

Pin No. Designation Notes

1 ANALOG_IN1 0 – 10 V Range

2 ANALOG_IN2 0 – 10 V Range

3 ANALOG_IN3 0 – 10 V Range

4 ANALOG_IN4 0 – 10 V Range

5 ANALOG_IN5 0 – 30 V Range

6 ANALOG_IN6 0 – 30 V Range

7 ANALOG_IN7 0 – 30 V Range

8 ANALOG_IN8 0 – 30 V Range

9 ANALOG_OUT1 0 – 20 V Range

10 ANALOG_OUT2 0 – 20 V Range

11 ANALOG_OUT3 0 – 20 V Range

12 ANALOG_OUT4 0 – 20 V Range

13, 14, 15 GND

l The 0-10 V analog inputs have an input impedance of about 35 kΩ.

l The 0-30 V analog inputs have an input impedance of about 110 kΩ.

l The analog outputs have an output impedance of about 200 Ω.

The maximum output current of each analog output is 10 mA. Exceeding the maximum
output current will result in damage to the analog output module.

Aux Sensors

Connector type HDB15M

Use Low Front Laser, optional Side Lasers
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6.2  Payload Bay Connections - Core

Designation

Pin No. Hardware Software Notes

1 RS232_VERT1_TXD /dev/ttyUSB5 (side lasers)

2 RS232_VERT2_TXD /dev/ttyUSB6 (side lasers)

3 RS232_FOOT_TXD /dev/ttyUSB7 (low front laser)

4 5V_SW1 USB_1_and_2_Power 5 V@ 1 A (sharedwith USB port 1)

5, 10 SW_20V_VERT Vertical_Laser_Power 20 V@ 300 mA (side lasers)

6, 7, 8 GND

9 5V_SW2 USB_1_and_2_Power 5 V@ 1 A (sharedwith USB port 2)

11 RS232_VERT1_RXD /dev/ttyUSB5 (side lasers)

12 RS232_VERT2_RXD /dev/ttyUSB6 (side lasers)

13 RS232_FOOT_RXD /dev/ttyUSB7 (low front laser)

14 5V_SW3 USB_3_Power 5 V@ 1 A (sharedwith USB port 3)

15 SW_20V_FOOT Foot_Laser_Power 20 V@ 150 mA (low front laser)
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RS232 1 & 2

Connector type DB9M

Use Port 1 and 2, General Use

Pin No. Designation Notes

1, 4, 6, 9 No Connection

2 RS232_USR#_RXD #=1 or 2

3 RS232_USR#_TXD #=1 or 2

5 GND

7 RS232_USR#_RTS #=1 or 2

8 RS232_USR#_CTS #=1 or 2

LD Platform Core Rear, Upper

Figure 6-5. Rear Upper Core

NOTE: The connectors in the top row of the rear upper core mate with Molex
Mini-Fit Jr™ 5557 series receptacles.
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6.2  Payload Bay Connections - Core

ID Connection Type Description

A Lights Mini-Fit 2 x 3 Connect to a supplied splitter that powers a buzzer using
a default configuration, and provides power for a user-
supplied light tower with 3 lights.

NOTE: The following four functions are pins on the User Interface connector.

B Brake-
release

Mini-Fit 2 x 7 Pins for user-supplied brake release

ON Pins for user-supplied ON button; same function as Oper-
ator Panel ON

OFF Pins for user-supplied OFF button; same function as Oper-
ator Panel OFF

E-STOP Pins for user-supplied E-Stop (must be used or
jumpered)

C User
Bumpers

Mini-Fit
2 x 4

Payload structure bumpers, user-supplied, connected
between E-STOP_SRC and USER_BMP# (for each of the
6 inputs). Contacts 1 - 3 are for a front bumper, 4 - 6 for
rear.
Contacts should be 12 V@ 10 mA.

D Aux Power Mini-Fit
2 x 3

5, 12, and 20 VDCOutputs

E User Power Mini-Fit
2 x 6

Battery and switched battery power

J Maint LAN RJ45,
Shielded

Directly connected to the externally-mountedMain-
tenance Ethernet, Auto-MDIX.

H Pendant DB9F Directly connected to the externally-mounted Pendant
port

G HMI Panel HDB15F Operator screen, E-Stop, Brake_Rel, ON, OFF

F Sonar 2 DB9M Not used

Pendant

Connector type DB9F

Use Pendant
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Pin Designation Notes Pin Designation Notes

1 JOY_XAXIS Analog X input 6 JOY_EN_2L Enable channel 2

2 JOY_YAXIS Analog Y input 7 No Connection

3 JOY_SPEED Analog SPEED input 8 GND

4 JOY_GOAL Goal Button Input 9 5V 5 V@ 100 mA

5 JOY_EN_1H Enable channel 1

Power Connections

The platform provides conditioned 5, 12, and 20 VDC, and raw (battery) 22 - 30 VDC power to
the platform’s and accessory electronics, including the onboard core and laser LIDAR (Light
Detection And Ranging).

All power connectors are Mini-Fit®.

Nominal Qty Actual Maximum
Current Description

5 VDC 1 5 VDC±5% 1 A Switched Aux power

12 VDC 1 12 VDC±5% 1 A Switched Aux power

20 VDC 1 20 VDC±5% 1 A Switched Aux power

22 - 30 VDC 2 battery 4 A Switched

22 - 30 VDC 1* battery 10 A Switched

22 - 30 VDC 1* battery 10 A Safe, Switched

* 10 A Switched and 10 A Safe, Switched share the 10 A of current.

Each supply has an associated LED which, when lit, indicates that the port is actively
powered. See LD Platform Core Status Indicators on page 120.

The Safe 22 - 30 VDC supply automatically gets disconnected when the E-Stop button is
pressed, an obstacle is detected, or the bumper touches something.

Light Pole

Connector type Mini-Fit® 2 x 3

Use Light tower (user-supplied)

Pin Designation Notes Pin Designation Notes

1 GND Cable shield 4 VBAT_IO_
OUT4

VBAT@ 0.5A Max (sharedwith
DIO)

2 LIGHT_P1 Red 5 LIGHT_P3 Green

3 LIGHT_P2 Yellow or
orange

6 LIGHT_P4 Buzzer
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6.2  Payload Bay Connections - Core

Figure 6-6. Sample Light Pole Diagram

Callout Description Callout Description

A Standard Equipment D Typical User Load

B Wiring Terminal Block E Equivalent Circuit

C User-Supplied Equipment

User Interface

Connector type Mini-Fit® 2 x 7

Use Brake release, ON, OFF, E-Stop

Pin No. Designation Notes

1, 2, 3 FBAT_ALWAYS Fused VBAT@ 500 mA

4 E-STOP_USR_1L Short 4 & 11 to close E-STOP_USR_1

5 E-STOP_USR_2L Short 5 & 12 to close E-STOP_USR_2

6 E-STOP_OUT_1L Pins 6 & 13 short when E-STOP_CH1 is closed

7 E-STOP_OUT_2L Pins 7 & 14 short when E-STOP_CH2 is closed

8 OFF_BUTTON Short to FBAT_ALWAYS to signal OFF (min 1 s pulse)

9 START_BUTTON Short to FBAT_ALWAYS to signal ON (min 1 s pulse)

10 MOTOR_BRAKE Short to FBAT_ALWAYS for manual brake release
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Pin No. Designation Notes

11 E-STOP_USR_1H Short 4 & 11 to close E-STOP_USR_1

12 E-STOP_USR_2H Short 5 & 12 to close E-STOP_USR_2

13 E-STOP_OUT_1H Pins 6 & 13 short when E-STOP_CH1 is closed

14 E-STOP_OUT_2H Pins 7 & 14 short when E-STOP_CH2 is closed

NOTE: An E-Stop jumper or a user-supplied E-Stop button needs to be attached
to the E-STOP port on the User Interface connector for the platform to function.
The jumper is provided as part number 12730-000L. An E-Stop button would be
user-supplied.

NOTE: Engaging the E-Stop through the external connector or Operator Panel
(faster than 250 ms), will cause motors to re-engage after E-stop is released.
Motor re-engagement occurs because the core is designed to receive a consistent
E-Stop signal for at least 250 ms. Signals that engage and disengage in a time
period shorter than 250 ms, will cause LD to assume that the change was due to
a bumper press, which will automatically re-engage the motors. No signal on the
E-Stop chain can cause the robot to operate while the E-Stop remains engaged.
Thus it is necessary to leave the E-Stop engaged for at least the full 250 ms dur-
ation if the intent is to keep the robot in a E-Stop state.

!
CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
If you are using a user-supplied E-Stop, you must run the Safety Com-
missioning to verify the E-Stop’s functionality before putting the AMR into ser-
vice. For more information, see E-Stop and Safety Laser Commissioning on
page 151
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6.2  Payload Bay Connections - Core

Figure 6-7. E-Stop Chain Diagram

Callout Description Callout Description

A Standard Circuits H Bumper Right

B User-Supplied Circuits J E-STOP Relay Control Logic

C E-STOP-Source K Voltage of the Battery

D Ground L High Power to Amplifiers

E Front Panel E-STOP M HMI Connector

F User E-STOP N Note: Jumper closed when not
used, MUST open both channels
independently if used.

G Bumper Left O User Interface Connector
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User Bumper

NOTE: The User Bumpers connector is not safety-rated.

NOTE: Pins 1 through 3 are for a front-mounted bumper, 4 through 6 are for a
rear-mounted bumper.

Connector type Mini-Fit® 2 x 4

Use Optional bumper for payload structure

Pin No. Designation Notes

1 USER_BUMPER_1 Short to E-STOP_SRC to signal bumper hit
Front left bumper sensor.

2 USER_BUMPER_2 Short to E-STOP_SRC to signal bumper hit
Front center bumper sensor.

3 USER_BUMPER_3 Short to E-STOP_SRC to signal bumper hit
Front right bumper sensor.

4 USER_BUMPER_4 Short to E-STOP_SRC to signal bumper hit
Rear right bumper sensor.

5 USER_BUMPER_5 Short to E-STOP_SRC to signal bumper hit
Rear center bumper sensor.

6 USER_BUMPER_6 Short to E-STOP_SRC to signal bumper hit
Rear left bumper sensor.

7, 8 E-STOP_SRC 12 V E-STOP Source Output @ 10 mA
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6.2  Payload Bay Connections - Core

AUX Power

Connector type Mini-Fit® 3 x 2

Designation

Pin No. Hardware Software
Notes

1,2,3 GND

4 AUX_5V_OUT AUX_5V 5V@ 1 A Max

5 AUX_12V_OUT AUX_12V 12V@ 1 A Max

6 AUX_20V_OUT AUX_20V 20V@ 1 A Max

User Power

Connector type Mini-Fit® 2 x 6

Designation

Pin No. Hardware Software Notes

1, 2,
3, 4,
5, 6

GND

7 SW_VBAT_OUT1 Battery_Out_1 VBAT@ 4 Amax (switched in SW)

8 SW_VBAT_OUT2 Battery_Out_2 VBAT@ 4 Amax (switched in SW)

9, 10* SW_VBAT_OUT34 Battery_Out_3_and_4 VBAT@ 10 Amax (switched in SW)
Limit to < 5 A per pin.

11, 12* SAFE_VBAT_OUT SW_VBAT_OUT34 gated by
dual-channel E-STOP relays

*9, 10, 11, and 12 share the 10 A of current.

HMI Panel

Connector type HDB15F

Use Operator screen, E-Stop, Brake_Rel, ON, OFF
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Designation

Pin No. Hardware Software Notes

1 RS422_HMI_TX+

Connections to HMI Panel

If using the optional touchscreen
instead of the HMI panel, the
RS422_HMI connectors are not
needed, but the user will have to
provide buttons for ON (Start),
OFF, Brake Release, and E-Stop
functions.

2 RS422_HMI_TX-

3 MOTOR_BRAKE

4, 5 E-STOP_FP_1H, _2H

6 RS422_HMI_RX+

7 RS422_HMI_RX-

8 START_BUTTON

9, 10 E-STOP_FP_1L, _2L

11 HMI_5V_SW HMI_Power

12, 14 GND

13 OFF_BUTTON

15 FBAT_ALWAYS

Sonar 1

Connector type DB9M

Use Platform (rear) sonar

NOTE: Sonar 1 is part of the Internal LD Platform Core connections.

Designation

Pin No. Hardware Software Notes

1, 4, 8 No Connection

Connections to Sonar Module

2 RS422_SNR_RX+

3 RS422_SNR_TX+

5 GND

6 RS422_SNR_RX-

7 RS422_SNR_TX-

9 SW_12V_SNR Sonar_1_Power

Internal LD Platform Core Connections

The following connections are internal (under the platform's top deck), and not normally avail-
able for the user. They are listed here so that you can reconnect them in the event that they
need to be disconnected for parts replacement.
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6.2  Payload Bay Connections - Core

Figure 6-8. Internal Connectors on the LD Platform Core (Front)

NOTE: The Bumper, Speakers, and Batt Comm. connectors on the internal core
mate with Molex Mini-Fit Jr™ 5557 series receptacles.

NOTE: The Charge Contacts and Battery Power connectors on the internal core
mate with Molex Mini-Fit Jr™ 42818 series receptacles.

ID Connection Type Description

A Debug RS-232 DB9M Reserved

B Wheel Lights DB9F Motion and status indicator
Light Discs on the platform sides

C Sonar 1,
RS-422

DB9M Connection to Sonar Module
(Rear sonar sensors)

D Charge
Contacts

Mini-Fit Sr., 
2-pin

E VGA HDB15F Reserved

F USB x 3 USB Type A Reserved

G LIDAR HDB26M Safety Scanning Laser
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ID Connection Type Description

H Right Motor HDB26F NOTE:The Right and Left Motor connectors use the
same type of plug. Take care not to reverse them.

J Left Motor HDB26F

K Battery Power Mini-Fit Sr.,
3-pin

Battery VDC; connects to battery

L Bumper
Switches

Mini-Fit 2 x 4 Connect to standard bumper contacts

M Speakers Mini-Fit 2 x 2 Drives built-in speakers

N Battery
Comm.

Mini-Fit 2 x 3 Battery communication/control

Internal Data Pinouts

Wheel Lights (Light Discs)

Connector type DB9F

Use Motion and status indicator light disc on the platform sides

Designation

Pin No. Hardware Software Notes

1, 2 CANL_A CAN Communication differential pair

3, 4 GND Direct GND

5 SHIELD GND Bead filter to GND

6, 7 CANH_A CAN Communication differential pair

8, 9 SW_12V_WHEEL WheelLight_Power 12 V@ 1 A Max (switched in SW)

NOTE: Sonar 1 is covered in Sonar 1 on page 95.
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6.2  Payload Bay Connections - Core

LIDAR (Light Detection And Ranging)

Connector type DB26M

Use Front navigation laser

Designation

Pin No. Hardware Software

1 RS422_LIDAR_RX+

2 RS422_LIDAR_RX-

3 OSSD1

4 OSSD2

5 WF_OUT

6 O3_OUT

7 STANDBY

8 EDM

9 No Connection

10, 18 SW_20V_LIDAR Main_Laser_Power

11 thru 17 GND

19 RS422_LIDAR_TX+

20 RS422_LIDAR_TX-

21 IN_A1

22 IN_A2

23 IN_B1

24 IN_B2

25 IN_C1

26 IN_C2

Pin 10 +  18: Current < 600 mA

Internal Power Pinouts

Bumper

Connection Mini-Fit® 2 x 4

Connector type DB9F

Use Front bumpers

NOTE: The single front bumper uses four sensors for operation.
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Pin No. Designation Notes

1 BUMPER_R2L Right, Channel 2, Low

2 BUMPER_R1L Right, Channel 1, Low

3 BUMPER_L2L Left, Channel 2, Low

4 BUMPER_L1L Left, Channel 1, Low

5 BUMPER_R2H Right, Channel 2, High

6 BUMPER_R1H Right, Channel 1, High

7 BUMPER_L2H Left, Channel 2, High

8 BUMPER_L1H Left, Channel 1, High

Speakers

Connector type Mini-Fit® 2 x 2

Use Speakers

Pin No. Designation Notes

1 RIGHT+
Right Speaker

2 RIGHT-

3 LEFT+
Left Speaker

4 LEFT-

Batt Comm.

Connector type Mini-Fit® 2 x 3

Use Battery control

Pin No. Designation Notes

1 GND

Connections to the Battery Control

2 RS232_BATT_RXD

3 RS232_BATT_TXD

4 FBAT_ALWAYS

5 START_BUTTON

6 OFF_BUTTON
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Before proceeding, you need to have performed the steps covered in the Setup and Getting Star-
ted chapters, so your platform has a map to work from.

7.1 Operating Environment

Intended Use

The LD Platform OEM is designed to operate in indoor industrial or professional envir-
onments. In general, if a wheelchair can safely and easily navigate the environment (open,
with gentle slopes), then it is safe for the robot.

Guidelines for safe use:

l Clean, dry floors — floors that are regularly swept, and routinely kept free of debris and
liquids.

IMPORTANT: Since the robot is not water proof, floors must be kept rel-
atively dry, as any dampness can cause the wheels to slip. This can cause
problems for braking as well as navigation. Refer to ISO Standard 13849-2
for instructions on how to test the robot in non-standard environments.

l Gentle slopes — wheelchair ramps are a good example of the amount of slope the robot
can safely climb.

l Temperature — 5 to 40°C, with a recommended humidity range of 5% to 95%, non-con-
densing.

Clearance

The platform can operate in an environment that is generally level, with no doors or other
restricted areas that are too narrow for the AMR.

You must ensure that adequate clearance is maintained on each side of the AMR, so that a per-
son cannot get trapped between the AMR and a wall or other fixed object. You should consult
the applicable standards for your area.

An exception to side clearance can exist at pickup and drop off locations, where the AMR
must get close to conveyors or other fixed objects.

!
CAUTION: PROPERTY DAMAGE RISK
Do not allow the platform to drive through an opening that has an automatic
gate/door unless the door and platform are configured correctly with the
Call/Door Box option.

Refer to the LD Platform Peripherals User's Guide (Cat. No. I613) for details on the
Call/Door Box.
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7.1  Operating Environment

Obstacles

If the AMR will be entering high-traffic areas, take appropriate precautions to alert people in
those areas that an AMR might enter. If the traffic consists of other machines, adjust the
AMR’s and/or the other machine’s parameters to reduce the risk of a collision.

Take care to avoid:

l glass doors and walls

l pits without railings or low bumpers

l floors with access panels removed

l loose cables, hoses, etc.

l large, highly-reflective objects

Environment and Floor

Environmental Limits

The following environmental limits apply.

Characteristic Operating Limits

Temperature 5 to 40°C

Humidity 5% to 95%, non-condensing

Altitude Up to 1000 m above mean sea level

Atmospheric

!
WARNING: Do not use the AMR in hazardous
environments (explosive gas and oil mist).

Radiation Do not use the AMR in the presence of ionizing or non-ionizing
radiation.

Floor Characteristics

Floors must provide good traction, typical of good walking conditions. The following specified
limits assume that the AMR's wheels are in good operating condition.

l Flatness and Texture
Driving on rough or uneven floors can affect traction and navigation and also reduce
the life of drive train components. Safety might be affected because the laser's sensing
plane is not always parallel to the floor.

Even on smooth, level floors, dust, dirt, grease, and water (or other liquids) can affect
traction. If the drive wheels slip it can potentially affect operating duration and nav-
igation accuracy.

Use a slip meter (such as the Reagan Scientific BOT-3000e) to measure the floor’s coef-
ficient of friction. The slip meter must:
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l Conform to standards ANSI B101.3, A137.1, A326.3.

l Be validated according to ASTM F2508-13.

The recommended coefficient of friction for floors in the AMR’s work space is in the
range: 0.55 – 1.0.

l Steps and Gaps
Typical floor characteristics that are considered to be steps include any height difference
caused by floor stab settling, expansion gaps, or cracks. Other environmental objects
might create a temporary bump, such as a wood pallet fragment, dropped fasteners or a
temporary floor covering.

l Cleanliness and ESD grounding
A foreign object such as a screw or metal fragment embedded in a wheel can affect its
operation over otherwise compliant floor surfaces. Liquid, dirt, and dust can affect AMR
operation and cause damage to the AMR over time. It might also affect the operation of
the caster.

!
CAUTION: PROPERTY DAMAGE RISK. The AMR is intended for smooth,
hard, and level floors. Although it is capable of driving over steps and gaps,
frequent or high-speed driving over such obstacles shortens the lifespan of
drive train components.

For best performance, OMRON recommends that all floor steps or door thresholds have a roun-
ded profile or are filled to ease the transition between surface planes.

The following limits apply for certain floor characteristics.

Characteristic Operating Limits

Inclines and load Incline (ramp) of 3% for maximum payloads.

Be aware that if the AMR frequently operates on steep
inclines its operational duration is reduced.

Step or door threshold height Up to 10 mm at 600 mm/s.

Gapwidth Up to 15 mm at 1200 mm/s

User's Responsibilities

It is the user's responsibility to ensure adequate traction and stability on any surface, flat or
inclined.

l Traction

The provided center-of-gravity plts assume rigid payload mounting. It doe not account
for motion of the payloadon the AMR, or shifting of center-of-gravity.

l Stability

There are springs on the LD's drive-assembly that affect the down-force of the it's drive
wheels. these springs are not to be adjusted without also testing AMR stability in all
situations.
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7.2  Typical Operation

Getting Stuck

It is possible, though not likely, for the AMR to get into a position from which it cannot move
without Operator assistance.

Some examples are shown in the following figure.

If the platform has to be lifted to be free to drive again, refer to Lifting the Platform Safely on
page 129.

Figure 7-1. Examples of the Platform or AMR Getting Stuck, (A) Platform Stuck Under Overhang, (B)
AMR Option Stuck Under Overhang, (C) Driven off Ledge, and (D) Driven Over Excessive Gap

7.2 Typical Operation
During normal start-up, the platform powers all its onboard systems1 and runs its onboard
software and your integrated processes automatically to provide an application-ready AMR. If
it has been given a map of its workspace and knows where it is within that environment
(localized), your AMR is ready to perform start-up and operate autonomously, without human
intervention.

Paths are not pre-programmed, but instead are generated dynamically onboard the platform.
Paths are updated many times per second to maintain a smooth trajectory and to account for

1As configured either by the factory or through your own parameter changes.
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any obstacles that are detected by the onboard sensors. Navigational parameters are stored
onboard the platform, and can be viewed and modified using the MobilePlanner software,
which is covered in the FLOW Core User's Guide (Cat. No. I637).

The MobilePlanner application, running on your computer, configures the many high-level
operating characteristics of the platform, including speeds and accelerations, sensor safety
zones, minimum battery level allowed before docking for recharging, which map to use, and
many other parameters. The MobilePlanner software typically communicates with the plat-
form over the wireless network. A direct connection, through the Maintenance Ethernet port on
the platform, is also possible.

IMPORTANT: Protect the MobilePlanner Operator Mode with user ID and pass-
word access, to prevent unauthorized operation of an AMR.

7.3 Power and Charging
The platform battery is sealed. It supplies ample power for the motors, electronics, and
accessories.

A battery is not included with the AMR and must be ordered separately. Batteries are not
chared before shipping, and must be fully charged before use.

Typically, the platform manages battery recharging. With the power provided by the auto-
mated docking station, all on board systems function continuously while the battery recharges.

The Operator screen shows % state-of-charge (SOC) remaining for battery.

Run-time, with no load, is approximately 15 hours. This will vary significantly depending on
use and accessory power consumption.

Recharge time is approximately 4 hours.

Battery Indicators and Controls

The battery has (from left to right) one red/green bi-color and three green LEDs, and one push-
button (labeled SHOW LEVEL). The firmware blinks LEDs 1 through 4, back and forth, one at
a time. From left to right, the LEDs indicate:

LED Color Meaning

1 Red Error conditiona

Green 25% state of chargeb

2 Green 50% state of charge

3 Green 75% state of charge

4 Green 100% state of chargec

a: If the red light blinks after pressing the SHOW LEVEL button, the battery is depleted and
needs a recharge.

If the red light blinks constantly, the battery needs service. Connecting the battery to a
platform will write an error code to the log, which will allow Service to better
troubleshoot the problem.
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LED Color Meaning

b: While powered up, the LEDs blink back and forth from 1 - 4.

c: When on docking station, the right-most LED blinks when the battery pack is balancing.
When the battery is full and balancing is complete, all LEDs light solid.

Figure 7-2. (A) Battery LEDs and Push-Button (Show Level), (B) Power Cable, and (C) Data Cable

Pushing the “SHOW LEVEL” button displays its state of charge. This can be useful when a bat-
tery is in storage, and you want to know its state of charge.

NOTE: After pressing the SHOW LEVEL push button, the battery will light all LEDs for a
brief time, then blinks the LEDs back and forth one LED at a time, up to the LED rep-
resenting the current state of charge. It will continue doing this for 4 hours, until it powers
itself off. To turn off this display manually, press and hold the push button for 10 seconds.

Docking Station

The automated docking station provides both a manual and an automated means for rechar-
ging your platform battery.

Autonomous Charging

During normal, autonomous operation, the AMR manages charging automatically through the
automated docking station. The AMR approaches the docking station frontward, and then
turns around and backs onto the docking station to charge. There is about a 10-second delay
between when an AMR docks and the charging LED turns on.

Connecting and disconnecting the AMR with network and onboard clients will not disturb the
charging state (though moving the AMR will, of course). The station supplies ample power for
all onboard systems while charging its battery, so you can continue operating those systems
while charging.
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If the AMR is powered off, it will turn on automatically when pushed onto the docking station.
The robots can be turned off while on the docking station. If the robot is turned off, it must be
removed from the docking station to be started.

Figure 7-3. Docking Station

Indicators, Controls, and Connections

The docking station has a power switch and two LEDs:

l blue indicates that power is available.

l yellow indicates that a charge is in progress.

The power switch, located on the right side of the dock, has an integrated thermal fuse, which
can shut down the dock if it becomes too hot. If this happens, you have to wait for the fuse to
cool down, turn the switch to off (0) and then back to on (1).

11970-000 Rev N LD-60/90 Platform User's Manual 107



108 LD-60/90 Platform User's Manual 11970-000 Rev N

7.3  Power and Charging

Legacy versions of the dock used two fuses in a fuse drawer to protect the dock. Their replace-
ment is covered in Docking Station AC Power Fuse on page 139.

The power plug for AC supply is next to the power switch. Power requirements are 100 - 240
VAC, 50 - 60 Hz, and 8 A.

The plug for connecting the manual charging cable is on the left side of the station, as viewed
from the front.

Environmental Requirements

l Ambient temperature range: 5 to 40°C

l Humidity: 5% to 95% non-condensing

Maintenance

Clean the docking station contacts quarterly with isopropyl alcohol. See Docking Station on
page 106.

The guide roller is field-replaceable. See Docking Station Roller and Bearing on page 138.

If necessary, you can adjust the height of the docking station contacts. See Docking Station
Contact Adjustment on page 55.

Manually Charging the Battery

Battery in Platform

To manually charge a battery inside the platform, push the AMR backwards, with E-Stop
engaged, so that the rear of the platform slides over the docking station contacts.

NOTE: Press and hold the brake-release button to move the platform.

NOTE: If you push the platform too far onto the docking station, it will not
charge. Make sure that the yellow charge light comes on and stays on.

Standalone Battery

You can charge the battery, outside of the platform, by using the connector on the left side of
the docking station (viewed from the front) with the provided charging cable. This will most
likely to be used for charging a spare battery, while the second battery is still in the platform,
and the AMR is in use. This side charging port is intended only for charging spare batteries
outside of the robot. It is not for charging batteries inside the robot.

NOTE: The docking station's side port is not live at all times. In order to begin
charging a battery on the side port the user must press and hold down the State
of Charge button on the battery after plugging it in. Holding down the button for
3 seconds will begin the charging process and energize the port. The side port
will de-energize automatically when the user disconnects the battery.

There is about a 10-second delay between when you connect the battery cable and when the
charging LED turns on.
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NOTE: The docking station cannot charge a platform and a separate battery at
the same time. If a platform is on the station, the power to the manual charge
connector is cut off.

Some users manually charge a spare battery, and swap that for the battery inside the platform.
Typically, this is done at the start of each shift, so the AMR is available for the entire shift
without recharging.
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Balancing the Battery

The battery is composed of multiple cells, which must stay balanced to maintain maximum
run-time.

There are three ways to manage battery balancing:

l Set the AMR‘s DockUntilDoneCharging parameter to True. In this case, the battery will
balance before saying it's done charging, so the battery will get balanced every time the
AMR docks. You do not have to do anything extra to balance the battery.

In this mode, the battery will typically take about 10 minutes to balance after charging.

NOTE: We recommend this mode for installations that aren't doing bat-
tery swapping.

l Exchange the in-service battery, periodically, with a fully-charged spare battery.

A spare battery plugged into a docking station will be balanced after it is charged. In
this mode, you don’t have to worry about battery balancing, although it does add the
task of manually swapping batteries.

The interval between battery swaps depends on the AMR‘s use. This includes the
weight it carries, the electrical load of any accessories, and percentage of time it is in ser-
vice. You will need to determine the best interval for your situation. Swapping the bat-
tery at every shift change is a commonly used interval.

NOTE: We recommend this mode for battery swapping, if you are not
charging the battery while it is inside the AMR.

l Set the AMR’s DockUntilDoneCharging parameter to False, to let the AMR get a partial
charge by docking. The StateOfChargeToChargeTo and MinutesToChargeFor parameters
need to be set to appropriate (non-zero) values. You would then do a periodic battery
swap with a fully-charged and balanced battery, such as once a week.

o StateOfChargeToChargeTo determines the state of charge the battery needs to attain
before the AMR can stop charging.

A 90% value here would get the battery mostly charged, but not balanced.

o MinutesToChargeFor determines the number of minutes the battery needs to
charge before the AMR can stop charging.

The AMR will stop charging when the battery reaches either of these parameter
values.

NOTE: If both of these parameters are left at the default of 0, and Dock-
UntilDoneCharging is set to False, the AMR will dock, and never undock.

In this charging mode, we recommend that you swap batteries weekly, at a minimum. If
you see a reduction in run-time, you should do a swap more often than that.

NOTE: The longer you wait to balance a battery, the longer it will take to
balance. A battery that is badly out of balance can take well over 10 hours
to balance after charging.
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7.4 Operator Panel
The Operator screen, E-Stop, Brake-release, ON, and OFF can be "moved" using a single con-
nector (the HMI Panel connector). This allows you to put many of the more common operator
controls somewhere on your payload structure with just one cable.

Figure 7-4. Standard Operator Panel (units are mm)

Callout Description Callout Description

A Emergency Stop E 15 Pin High Density D-Sub Punch

B Brake Release F 2x 0.120 Through Hole

C On Button G 7x 0.213 Through Hole

D Off Button

A larger Operator panel, with a touchscreen, is available as an option. See Touchscreen on
page 1. Many other connections are available. For details and specifications of available con-
nections, refer to Connectivity on page 77.

Screen

The screen is a color TFT, 320 x 240 pixels, 8.89cm diagonal. It can display 256K colors, and is
backlit.

NOTE: If the backlight times out, tapping lightly on the screen turns it back on.
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NOTE: This is not the same as the Touchscreen option.

Default/Sample Screen Contents

The following image shows the first screen that appears during boot-up:

Figure 7-5. Initial Boot Screen

After the platform boots up, you will see the main screen:

Figure 7-6. Main Screen Fields

Callout Description Callout Description

A WiFi Signal Strength D Battery Level

B IP Address E Robot ID

C Status/ Faults/ Instructions (up to
six lines)

l The main screen can display up to six messages, in order of importance.

l The main screen will display only one fault at a time.
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l The main screen will display any event or condition that causes an ARAM restart or
AMR shutdown, and give the cause of the restart or shutdown.

E-Stop

When pressed, the red, latching push-button prevents any AMR motion by disabling the
motors. To reset the E-Stop, twist the button slightly, so it pops up.

The motors must also be explicitly enabled, either with the dialog box that will pop up or with
the ON button; this is not the case if the AMR is docked or experienced a critical driving fault.
This can be done either with the MobilePlanner (with Map > Show Robot on) software, or
with an ARCL command. See the following figure:

Figure 7-7. Motor Enable Pop-up Dialog

In normal use, the E-Stop button has three primary purposes:

l You need to interrupt or stop the platform for some reason, to keep it from performing
its currently scheduled task (and don’t have access to MobilePlanner).

l You are working near the platform and don’t want it to move.

l You want to use the Brake Release button.

NOTE: There is a two-second delay between the release of an E-Stop and the
platform resuming its activity. During the two seconds, the platform scans its
path for potential obstacles, and will resume commanded motion if there is
adequate space to maneuver.

ON Button

The ON button restores power after the OFF button was pressed, and the software finishes shut-
ting down the AMR.

It can also be used to restore power after an E-Stop has been released.

NOTE: If your battery is P/N: 12072-000, a docked and charging robot will
ignore the OFF button until it leaves the docking station.

11970-000 Rev N LD-60/90 Platform User's Manual 113



114 LD-60/90 Platform User's Manual 11970-000 Rev N

7.5  Other Controls and Indicators

NOTE: If your battery is either P/N: 18578-000 or 20452-000, a robot that is
powered OFF while docked will not respond to the ON button until after it is
physically removed from the dock.

OFF Button

The red OFF button removes power from all systems except the charging hardware circuits.
The platform's software systems prevent loss of data on shutdown, and save the platform’s
last known location so it automatically localizes when it is next powered on.

NOTE: The OFF button can be disabled by the keyswitch, which can be locked
and the key removed.

Brake-Release Button

The brake release is used when you need to manually move the AMR.

Releasing the brakes requires battery power and pressing an E-Stop. The brake-release button
must be held in for the brakes to remain released.

NOTE: The LD-90x has a high gear ratio, and is very difficult to move, even
with the brakes released.

7.5 Other Controls and Indicators
When sold by itself, the platform does not come with a beacon or light tower, which are user-
supplied. Factory-supplied payload structures often include a beacon.

Light Discs and Beacon

The platform has circular lights on the sides that indicate motion, turns, and several other
states.

A user-supplied beacon, typically mounted on the AMR payload structure, can provide extra
signaling. The beacon indicates movement, and signals an Operator that the AMR is waiting
for assistance.

Their states are described here, and summarized in the following tables.

Driving Straight

Blue arcs on each side of the platform will appear to rotate in the direction of the platform's
travel, to let nearby people know that it is moving (or about to move). Beacon blinks green.
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Turn Signal (for turns >30°)

The blue drive indicators will include a blinking orange segment at the front of one light disc
to indicate that the platform is about to turn in the direction of the signal.
Beacon blinks green.

Stopped, no errors (ready)

Entire light disc on each side pulses blue slowly (0.25 Hz). Beacon is steady green.

Slow pulse:

Driving with Warning (doesn't prevent driving, such as low battery)

The light disc will be orange instead of blue for Stopped, Driving, and Turn Signals.
Beacon alternates green then yellow.

Turn Signal with Warning (doesn't prevent driving, such as low battery)

Same as Turn Signals, but both the blue rotating arc and blinking segment are orange. The
moving arc and the blinking segment have independent timing.
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Driving Slowly, E-Stop Inactive

When driving under 300 mm/s, the LD does not generate E-Stop, however it still actively per-
forms safety checking and successfully avoids obstacles. The pattern is essentially the same as
driving, except the background blinks orange. The moving arc and the blinking segment have
independent timing.

Stopped with Warning (such as low battery)

When Stopped with Warning, the light discs turn orange instead of blue. Beacon alternates
long green with short yellow.

Slow pulse:

Obstacle Detected

The light disc blinks yellow if the AMR stops for an object in its safety zone. Beacon blinks yel-
low.

NOTE: There is a two-second delay between the end of an obstacle-detection con-
dition and the platform resuming its activity. During the two seconds, the plat-
form scans its path for potential obstacles. It will remain stopped until its path is
clear.

Lost

When the AMR is lost, the light discs each display two orange arcs, traveling from the 6
o'clock to the 12 o'clock position and back, in opposite directions. Beacon blinks yellow.
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Charging

When docked, a green arc indicates the current state of charge (SOC), showing steady green
from the top of the disc to the current SOC. A small white arc travels back and forth between
the two ends of the green arc. Beacon blinks green (red if E-Stopped).

75% 100%25% 50%

Platform Left
Side

Platform Right
Side State of Charge

0 to 90 cw 0 to 270 ccw 25%

0 to 180 cw 0 to 180 ccw 50%

0 to 270 cw 0 to 90 ccw 75%

full circle full circle 100%

NOTE: The state of charge displayed is continuous, not limited to 25% incre-
ments.

E-Stop

The light discs blinks red in an E-Stop condition. Beacon blinks red.

Booting

When booting, the light discs displays two blue arcs, traveling from the 6 o'clock to the 12
o'clock position and back, in opposite directions. Beacon alternates green, yellow, then red.
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In the following table:

l Blink indicates that a disc or light is on for a period, then off for a period.

l Pulse indicates a 0.25 Hz fade on and off.

l Circle indicates that the lights appear to be going in a circle.

l Half-circles indicates two arcs, moving opposite each other between the top and bottom.

l Solid indicates that a light is on continuously.

l Alt indicates that the beacon switches between different lights, with no pause. Two
lights with Alt means one light is always on, but not two at once.

Table 7-1. Indicator Meanings

Light Disc Beacon Meaning

Color Pattern Color Pattern

Blue Moving
Circle

Green Blink Driving straight,
all ok

Blue/
Orange
@front

Moving
Circle/
Blinking signal

Green Blink Turning > 30° in dir-
ection of orange turn
signal, all ok

Blue Pulse Green Solid Stopped, all ok

Orange Moving
Circle

Green
/Yellow

Alt Drive with warning,
doesn't prevent driving
e.g. low battery

Orange/Orange
@front

Moving
Circle/
Blinking signal

Green
/Yellow

Alt Turn with warning

Blue/
Orange

Moving
Circle/
Blinking signal

Green Blink Driving slowly,
<300 mm/s

Orange Pulse Green/Green/Green
/Yellow

Alt Stoppedwith warning

Yellow Blink Yellow Blink Object detected in
safety zone

Orange Left+Right
Half-circles

Yellow Blink Lost

Green/White
arc

Partial Circle/-
moving small arc

Green normally, Red
if E-Stopped

Blink Charging

Red Blink Red Blink E-Stop, stops driving

Blue Left+Right
Half-circles

Green/Yellow/Red Alt Booting
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LD Platform Core Status Indicators

The left side of the LD Platform OEM Core has 12 indicator LEDs that give a quick visual
status on the health of the Core (see inset below). There are also two stickers mounted on the
main deck and left side of the LD Platform to provide explanations of the LED meanings.

Figure 7-8. LD Platform Core LED Status Indicator Stickers

The following table gives the meanings of the Core's twelve status LEDs:

Indicator Meaning

Left Column

LOGIC The microcontroller has power

PC The core and the servo controller are communicating

E-STOP An E-Stop has been activated

DRIVE The drive wheels are under servo control

Middle Column

20V 20 V power is available

12V 12 V power is available

5V 5 V power is available

VBAT Raw battery power is available

Right Column

LAN MAINT The Maintenance Ethernet connector is showing activity

LAN USER The USER LAN connector is showing activity

WLAN TheWiFi is showing activity

HD The hard drive is showing activity
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7.6 Sensors
AMRs are equipped with sensors for safety and navigation. Refer to the following sections
below for more information on the specific types of standard and optional sensors.

Lasers

The LD Platform OEM has two on-board lasers for navigation and safety.

Figure 7-9. LD Platform OEM Lasers (bumper skin removed), (A) Low Front laser, and (B) Safety Scan-
ning Laser

Safety Scanning Laser

The onboard navigation laser is a very precise scanning sensor that provides 500 readings in
a 240° field of view. The laser operates in a single plane, positioned at 190 mm above the floor.
In most environments, the sensor provides highly-accurate data.

The laser cannot reliably detect glass, mirrors, and other highly-reflective objects. Use caution
when operating the platform in areas that have these types of objects. If the platform will need
to drive close to these objects, we recommend that you use a combination of markings on the
objects (e.g., tape or painted strips), and also use forbidden sectors in the map, so that the plat-
form knows to plan paths safely around these objects.

Low Front Laser

The low front laser, mounted to the front bumper ((A) in the image above), detects obstacles in
front of the robot, such as an empty pallet, which might be too low for the safety scanning
laser to see.

Laser Field of View

Refer to the figure below for details on the field of view for the AMR's laser sensors.
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Figure 7-10. Laser fields of view (A), Laser center(B)

Sonar

Each sonar pair consists of one emitter and one receiver. The sonar emitters and receivers are
identical physically, but the platform uses them differently. The range is up to 5 m, though the
typical accurate range is only about 2 m.

The platform’s two rear-facing sonar pairs are for obstacle-sensing while backing up.

The only two times the platform will back up is when docking on the docking station, or when
the bumper has hit an obstacle. In the latter case, the platform will back up just enough to
freely rotate without touching the obstacle.

Sonar Field of View

Refer to the figure below for details on the field of view for the AMR's sonar sensors.
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Figure 7-11. Sonar fields of view (A), Drive wheel center (B)

Other Sensors

Encoders and Gyroscope

Each wheel has an encoder that tells the navigation system how far the wheel has turned, and
in which direction. Each wheel also has a Hall sensor.

The core has an internal gyroscope to track the platform's rotation.

The platform uses a combination of rotation and distance traveled to back up the navigation
laser during localization. These limit the area on the platform's map that the platform needs to
search.
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Bumper

A bumper, with a low-sensing laser, is mounted at the front of the platform, in case the
obstacle-avoidance systems fail to detect an obstacle. The AMR comes to a complete stop when
the bumpers are hit with a force of at least 67 N.

You can add optional user (payload structure) bumpers using the User Bumper connector on
the rear upper core, in the payload bay. There are six pins for front left, center, and right
sensors, and rear right, center, and left sensors. The core provides the connector, but the pay-
load bumpers are user-supplied.

NOTE: The User Bumpers connector is not safety-rated.

7.7 Start up

Procedure

Press and hold the power ON button for half a second, then release. It takes about a minute for
all the systems to start up and make their various interconnections. If the platform doesn't
start up, try power OFF, check your connections, and then power ON.

Startup is complete when the light discs stop indicating boot (two blue light segments, moving
in opposite directions from 6 o'clock to 12 o'clock and back).

By default, the core, navigation laser, and some auxiliary power start automatically when you
press ON. To change that behavior, or to assign AUX power to your own accessories, modify
their related parameters in MobilePlanner software. You can also control power from a client
connected with the core.

Pendant

The Pendant plugs into the left side of the platform, under the small access panel at the upper-
right corner of the platform. See Location of Parts on the Platform on page 127. This is intern-
ally connected to the Pendant port located on the rear side of the core in the payload bay.

IMPORTANT:We recommend locking the Pendant up when not in use, to pre-
vent an unauthorized person from operating an AMR.

Figure 7-12. Pendant, (A) Speed Control, (B) Goal Button, (C) Directional Control, and (D) Trigger

Pendant Use

Use the Pendant to drive the AMR manually and to create the scan used to make a map.
Squeeze the trigger to enable the directional control button.

Push the directional control button forward or back to make the platform move in that dir-
ection. Push the directional control button to the side to make the platform rotate in that dir-
ection. Diagonal positions of the directional control button move the platform in an arc.

Releasing the trigger causes the AMR to slow to a stop. To stop more quickly, continue to
squeeze the trigger and pull or push the directional control button to its limit in the opposite
direction of the platform’s travel.
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Use the Pendant’s GOAL button for marking positions while making a map scan.

!
CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
The safety scanning laser will not trigger the E-Stop chain when driving with
the Pendant. eAlthough the safety scanning laser is integrated with the emer-
gency stop circuit at all times, the operator must maintain full control of the
pendant functions and the AMR when the pendant is in use.
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This chapter covers periodic maintenance and user-serviceable parts replacement for the
LD Platform OEMs and the docking station. It does not cover maintenance of the payload
structure, which is the user's responsibility.

Figure 8-1. Location of Parts on the Platform

Callout Description Callout Description

A LD Platform Core F Safety Scanning Laser

B Platform Sonar Controller G Low Front Laser

C Rear Sonar X4 (2 pairs transducers) H Light Disc x2

D Battery Door Skin J Front Bumper

E Pendant/Ethernet Access Panel K Front Caster x2, Drive Wheel x2,
Rear Caster x2
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8.1 Safety Aspects While Performing Maintenance

IMPORTANT: Only skilled or instructed persons, as defined in theMobile Robot
LD Safety Guide (Cat. No. I616), should perform the procedures and replacement
of parts covered in this section.

Electrical Hazards

WARNING: ELECTROCUTION RISK
The docking station has AC power inside. Its covers are not interlocked.

l Do not use power extension cords with the docking station unless properly rated.

l Never access the interior of the platform with the charger attached.

l Immediately disconnect the battery after opening the battery compartment door.

Avoid shorting the terminals of the battery.

l Do not use any charger not supplied by Omron Robotics and Safety Technologies, inc.

l If any liquid is spilled on the AMR, power off the AMR, clean up all possible liquid,
and allow the AMR to air dry thoroughly before restoring power.

Burn Hazard

CAUTION: BURN RISK
Parts of the drivetrain can get hot during operation. Allow the platform to cool
before servicing.

Pinch Hazard

Platform Skins

!
CAUTION: PINCH RISK
The skins are held in place with strong magnets, which can pinch you if you
are not careful. Follow the instructions in the Maintenance chapter for hand-
ling skins.

Magnetic Field Hazards

Platform Skins

!
WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers stay back 30 cm from the platform skins, which are held in
place with strong magnets.
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Docking Funnel

!
WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers should stay at least 30 cm away from the underside of the
platform, which is exposed during certain maintenance procedures when the
platform is tipped on its side.

8.2 Safety Measures Prior and After Maintenance
Prior to performing maintenance work (safety inspection, cleaning, removing parts, installing
parts, etc.), following safety measures must be taken:

l Ensure that the AMR has come to a complete stop, by pressing the E-Stop button on the
Operator Panel

l Power OFF the AMR by pressing the OFF button on the Operator Panel

Once maintenance work has completed, and the AMR is ready for use, take following actions:

l Power ON the AMR by pressing the ON button on the Operator Panel
l Release the E-Stop

8.3 Lifting the Platform Safely
If, for any reason, you need to lift the platform by hand, take care to lift from safe lifting points.

!
CAUTION: PROPERTY DAMAGE RISK
Lifting the platform from the wrong points can damage the platform.

Front Lifting Points

Lift on each side of the laser, under the upper side of the laser slot. Do not lift at the center -
there is no supporting frame. Do not lift anywhere else! Refer to the following illustration:
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Figure 8-2. The Upper Surface of the Laser Slot. (A) Lift Here Only, and (B) No Lift

Rear Lifting Area

Lift at the center underside of the platform, where the skin has a cutout section. Do not lift any-
where else! Lift from the frame, not the skin. Refer to the following illustration:
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Figure 8-3. Bottom of Battery Door Skin. (A) Lift Here

8.4 Safety Inspection

Warning Devices

Do weekly inspections of the following warning devices for proper function.

Flashing Light

Each AMR must have a readily visible flashing light, to serve as a warning whenever the
AMR is ready to move or is moving. The exact nature of this light will vary depending on the
design of the payload structure. Maintenance should be done to ensure the proper function of
any user supplied lights.

Light Discs

Every week, check the light discs on each side of the AMR for proper function.

Buzzer

Check the warning buzzer for proper function. To comply with applicable standards, it is
important that the buzzer be audible in all operating conditions and environments.

Warning Labels

Check all warning labels on the AMR every week for presence and legibility. Replace any
labels that are missing or illegible. The labels, with our part numbers, are:
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l Medical Implant, Magnetic Field Warning Label, 18621-000

o Docking funnel, underside of platform

There is a medical implant label on the underside of the platform, on the docking fun-
nel. This magnet is only exposed during maintenance, when the platform is tipped on
its side.

l Yellow circle surrounding the E-Stop button, 11229-167

This is labeled EMERGENCY STOP.

l No Riding Label, 18178-000

Because of variability of payload structures, we can’t specify where this label will be.
The Setup instructions say to place it in a prominent location on the payload structure.
Verify that the label is there and legible.

l Incline Limit Label, 18622-000

CAUTION
MAXIMUM

GRADE
CAPABILITY =

8.3%

The Incline label is placed on the front-right of the top plate.

l Automatic Vehicle Label, 18623-000
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CAUTION

AUTOMATIC
VEHICLE

An Automatic Vehicle label is attached to the rear skin of the platform.

8.5 Cleaning
The drive motors and gearboxes are sealed and permanently lubricated, so they do not require
periodic maintenance.

Work Area Maintenance

In general, keep the AMR‘s work area clean and free from clutter that could block it.

Immediately remove anything spilled on the work area floor (e.g., dust, ice, pooled water, etc.)
which would interfere with the AMR’s ability to drive safely and navigate. Any substance that
reduces the AMR’s traction with the floor will impair the AMR’s ability to drive, stop, turn,
and navigate. Pay particular attention to goal locations and commonly traveled paths.

Platform Cleaning

The following table gives a summary of cleaning procedures for the platform.

Table 8-1. Cleaning

Item Period

Clean docking station
contacts

3 months

Clean axles and tires As needed

Clean all lasers 6 months/ as needed

Clean Platform Casters As needed

NOTE: The frequency of these procedures depend on your particular system, its
operating environment, and the amount of use. Operating in an environment
with a lot of dust or dirt will require more frequent cleaning. Use the intervals in
this section as guidelines, and modify the schedule as needed.

Tires

Occasionally clean the tires with a mild soapy solution. Remove any accumulated dirt or
debris on the tires which can degrade the AMR’s performance.

This applies to both the drive wheels and the casters.
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Axles

Keep the axles free of carpet, hair, string, or anything that could wrap around and bind up the
platform’s drive.

Lasers

Occasionally clean the lenses of the navigation laser and any other lasers used. Use only a soft
cloth with alcohol-based, non-abrasive cleaners, and wipe thoroughly.

Docking Station Contacts

The two docking station contacts need occasional cleaning. The suggested interval is 3 – 6
months, depending on frequency of charging.

WARNING: ELECTROCUTION RISK
Unplug power from the docking station before starting. Remove the charger’s
power cord.

Clean the contacts with Isopropyl alcohol.

!
CAUTION: PROPERTY DAMAGE RISK
Do not lubricate the docking station paddle, which will reduce its life.

Cleaning Casters on ESD Platforms

Casters on the ESD platform are critical components as they provide the path to ground. As
such, they require regular, periodic cleaning to preserve ESD protection capability.

!
CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
This procedure requires placing the platform on its side. Unless you can do
this safely with the payload attached, you will need to remove the payload.

You will need the following tools:

l Gloves

l Wipes

l Isopropyl Alcohol

l Protective, supporting material on which to rest the platform (e.g., foam)

1. Remove the payload structure, if necessary.

2. Remove the right and left side skins, and set them aside.

3. Lift and pin the drive assemblies to more easily maneuver the platform. This puts entire
robot weight on casters.

4. Place the protective, supporting material on the right side of the platform. Using the
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right side prevents possible damage to the maintenance access panel.

5. Carefully tilt the platform onto its right side onto the protective, supporting material.

6. Use a wipe wetted with Isopropyl Alcohol to thoroughly clean the casters.

7. After cleaning all casters, carefully tilt the platform upright.

8. Un-pin and lower the drive assemblies.

9. Re-install the payload structure if it was removed.

10. Re-install the two side skins you removed earlier.

11. Clean the side skins if needed.

8.6 Maintaining and Replacing Batteries

Maintaining Batteries

l Every three to four months, inspect batteries (both stored and in-use) for damage or
leaks.

If a battery is found to be leaking, do not expose it to water. If possible, submerge it in
mineral oil.

Contact your local Omron Support immediately for disposal instructions.

l Store batteries fully charged and upright at (one month) +5 to 45°C; (one year) 20 to
25°C.

l Every three to four months, charge stored batteries to a full charge.

Replacing the Battery

The battery is expected to last for approximately 2000 recharge cycles.

NOTE: There are no user-serviceable parts inside the battery case. Do not open
it.

IMPORTANT: Replace the battery only with a Omron Robotics and Safety Tech-
nologies factory-supplied battery.

Dispose of the battery according to all local and national environmental regulations regarding
electronic components.

CAUTION: PROPERTY DAMAGE RISK
Follow appropriate ESD procedures during the removal/replacement phases.
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Removal

!
CAUTION: PERSONAL INJURY RISK
The battery is heavy (19 kg). Use safe lifting practices when removing or
installing the battery.

1. Remove the battery door platform skin.

a. Pull the bottom of the skin away from the platform chassis.

This is easiest if you grip it with two hands, toward the center.

b. Lower the skin down, so its top tab clears the rear outer skin.

2. Unlatch and open the battery compartment door, at the back of the platform.

The battery compartment door is capable of being locked. You may need to unlock it
before opening.

3. Disconnect the power and data cables before removing the battery.

4. Slide the battery back and out of the platform.

There is a hand grip at the front and the rear of the battery, to help you lift it.

Installation

Refer to Removing and Installing Skins on page 152 for details on removing and installing
skins.

1. Remove the battery door skin.

a. Pull the bottom of the skin away from the platform chassis.

This is easiest if you grip it with two hands, toward the center.

b. Lower the skin down enough that its top tab clears the rear skin.

2. Unlatch and open the battery compartment door.

The battery compartment door is lockable, and you might need to unlock it.

3. Lift and slide the new battery into the platform body.

The battery weighs 19 kg.

The battery has recesses at the front and the back for easier lifting.
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Figure 8-4. Battery Recesses, for Gripping

A single person can lift and replace the battery. Use one hand in each of the grips, as
shown in the following figure.

Figure 8-5. Lifting the Battery

The connectors for power and data go toward the rear of the platform.

4. Attach the battery power and data cables to the connectors at the rear of the battery.
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Figure 8-6. Battery Cable Connectors, (A) Power and (B) Data

5. Close the battery compartment door to secure the battery in place.

Closing the battery compartment door holds the battery tightly in place to keep it from
shifting inside the compartment.

6. Reinstall the battery door platform skin.

8.7 Replacing Non-Periodic Parts
Replace the following parts on an as-needed basis.

Docking Station Roller and Bearing

The roller, which guides the AMR onto the docking station, can become worn after extended
use. The time to replace the roller should be based on your visual inspection and judgment of
when it is too worn. We do not specify a quantitative measure for this.

Refer to the following figure for the location of the roller.

WARNING: ELECTROCUTION RISK
Unplug power from the docking station before starting. Remove the power cord
at the docking station.

A shoulder bolt holds the roller to the docking station.

1. Remove the shoulder bolt from the center of the roller. Retain the shoulder bolt.

2. Remove the roller and bearing from the docking station.

3. Install the new roller and bearing, using the retained shoulder bolt.
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Figure 8-7. (A) Docking Station Roller, and (B) Switch

Docking Station AC Power Fuse

NOTE: The current version of the docking station uses a thermal fuse, built into
the power switch. There are no user-serviceable fuses.

NOTE: The following procedure applies only to legacy docking stations.

The only user-serviceable fuses are in the docking station. The two external AC fuses are loc-
ated between the power switch and the AC power plug.

Symptoms: When the docking station is switched on, the blue power light does not come on.
(Verify that the unit is plugged into AC power.)

WARNING: ELECTROCUTION RISK
Unplug power from the docking station before starting. Remove the power cord
from the charger.

Remove the fuse assembly by squeezing the two tabs toward each other, and pulling it away
from the docking station. See the following figure.
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Figure 8-8. Docking Station Fuse

The fuses are available from the factory as P/N 02212-000L. Equivalent fuses are available gen-
erically. The fuses need to be 250 V, 10 A, and Time-lag. An example of a fuse that meets this
is:

LittelFuse 0215010.XP, 5x20 mm cartridge type

Docking Station Internal Fuse

NOTE: The following procedure applies only to legacy docking stations. There
are no user-serviceable fuses on the current docking station.

Symptoms: When the docking station is switched on, the blue power light does not come on,
but the docking station can charge a battery manually.

WARNING: ELECTROCUTION RISK
Unplug power from the docking station before starting. The docking station
cover is NOT interlocked. Remove the power cord at the charger.

1. Remove the ten screws from the back cover of the docking station.

Two of these are on the sides, near the bottom.
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Figure 8-9. Docking Station Rear Cover Screws (8 of 10)

Retain the screws for reassembly.

2. Remove the rear cover of the docking station.

3. Locate the in-line fuse.

It will be near the top of the docking station, just to the right of the central terminal bar.

4. Remove the old fuse, and replace it with a new fuse.

The fuse is P/N 13091-000.

5. Reinstall the docking station rear cover, and secure with the ten screws previously
removed.

Rear Sonar Units

The platform's four rear sonar units can be replaced individually. All four sonar units are
identical, although two are used as emitters and two as receivers, in pairs.
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1. Remove the inner and outer rear covers from the platform.

Figure 8-10. Sonar Connectors with Connectors Exposed

2. Unscrew the connection between the sonar cable and the sonar unit's lead.

Ensure that both the connectors and leads are labeled, and match. If not, label them.

3. Compress the two flat springs holding the sonar unit, and remove it from the cover.

4. Press the new sonar unit through the hole in the rear outer cover, from the outside.

5. Connect the sonar cable to the new sonar unit's lead.

6. Reinstall the rear covers.

Sonar Controller

The sonar controller is located in the payload bay.

Figure 8-11. (A) Sonar Controller, (B) Core
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1. Move the payload structure out of the way, so you have access to the payload bay.

2. Locate the sonar controller.

The controller is at the front of the payload bay, screwed into the payload bay deck with
two screws, and is plugged into the Sonar 1 connector on the core. This connector is not
accessible from the payload bay, but does not need to be unplugged for this procedure.

3. Unscrew the controller from the payload bay deck by removing two screws.

Retain the screws for mounting the replacement controller.

4. Unplug the larger cable from the sonar controller.

Be careful not to let the cable end slip into the chassis.

5. Unplug the four sonar unit cables from the controller.

These are the smaller cables that go to the individual sonar units. Make sure these are
labeled and tied up, so they can't slip into the chassis.

6. Connect the four sonar unit cables to the new controller.

Ensure that the cable labels match the controller labels.

7. Plug the larger cable into the new controller.

8. Screw the new controller to the payload bay deck, using the two screws removed from
the old controller.

9. Reinstall the payload structure.

10. Dispose of the old controller according to local and national regulations concerning elec-
tronic components.

Light Discs

The two light discs and their controllers are single units, so replacing a controller also replaces
all of the lights on that side of the platform.

1. Remove the side skin from the side that needs the light disc replaced.

Refer to Removing and Installing Skins on page 152.

2. Unscrew the four screws holding the light disc PCA to the side skins.

Retain the screws and round cover for installing the new assembly.

3. Remove the light disc PCA.

4. Screw the new assembly and round cover to the side skin, using the screws from the
old assembly. The PCA is keyed so that it can only be installed in one orientation.

5. Reinstall the side skin, connecting the cable to the new light disc PCA.

6. Dispose of the old light disc PCA according to local and national regulations con-
cerning electronic components.

Operator Panel

The Operator panel will typically be located on a user-supplied payload structure, so the
removal and replacement of this will vary from one AMR to another. It plugs into the HMI
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Panel connector on the core.

Wheels and Tires

The wheels and tires should be checked every 3 months. If they show signs of cracking, excess-
ive wear, or any damage they should be replaced. Refer to the following figure.

Figure 8-12. Samples of Tire Wear

The wheels/tires are not user-serviceable parts. If the tires are worn or cracked, contact your
local Omron support.

Drive Assemblies

The platform drive assemblies are field-replaceable. This will replace the drive motor, gearbox,
encoder, and wheel/tire assembly. See the table below for part numbers. Care must be taken to
order the correct drive assembly intended for either the LD-60 or LD-90. Installing a drive train
assembly with an incorrect gear ratio for the AMR will result in reduced performance and
potential damage to the robot.

IMPORTANT: Drive assemblies of different gear ratios do not have obvious dif-
ferentiating visual characteristics once unpacked. Care must be taken when main-
taining fleets with multiple LD models that user ordered drive train assemblies
are properly organized to prevent servicing AMRs with incorrect parts.

Table 8-2. Replacement drive train assemblies

Item AMR Model Part Number

Assembly, Right Drive Train, 30:1 LD-60 12745-000

Assembly, Left Drive Train, 30:1 LD-60 12746-000
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Item AMR Model Part Number

Assembly, Right Drive Train, 40:1 LD-90 12745-040

Assembly, Left Drive Train, 40:1 LD-90 12746-040

Assembly, Right Drive Train, 60:1 LD-90x 12745-060

Assembly, Left Drive Train, 60:1 LD-90x 12746-060

Removal

1. Remove the inner rear skin.

2. Unlatch and open the battery compartment door, at the back of the platform.

The battery compartment door is lockable. You may need to unlock it before opening.

3. Disconnect battery power by unplugging the two cables at the rear of the battery.

4. Remove the side skin a small distance from the platform on the side where you want to
replace the drive assembly. Refer to Removing and Installing Skins on page 152.

The light disc PCA cable will still be attached.

5. Disconnect the cable from the light disc PCA, so you can move the side skin completely
away from the platform.

This will expose the drive assembly.

Figure 8-13. LD Drive Assembly (arrow)

6. Lift the drive wheel up, compressing its springs enough so that you can insert a
6-dia. x 10 mm pin into the hole on the rear side of the assembly (there is a hole on
each side). This will keep the springs compressed (the wheel will be in the up position),
and make removal easier. If you saved a wheel pin when you uncrated the platform,
you can use that. An M5 x 10 screw also works well for this.
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Figure 8-14. Spring-Compression Hole (arrow)

7. The drive assembly is held in place with three nuts on studs across the top, and two
sets of two screws at each side, near the bottom of the assembly.

Remove the three nuts and four screws (and their washers) holding the drive assembly
to the platform.

Retain these nuts, screws, and washers for attaching the new drive assembly.

Figure 8-15. Mounting Studs and Nuts at top of Drive Assembly
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Figure 8-16. Mounting Screws at Bottom-Right of Drive Assembly

8. Remove the drive assembly from the platform.

The motor cable to the core will still be attached.

9. Disconnect the motor cable at the drive assembly.

Installation

1. Lift the new drive wheel up, compressing its springs, enough so that you can insert a 6-
dia. x 10 mm pin into the hole on the rear side of the assembly (there is a hole on each
side).

This will keep the springs compressed (the wheel will be in the up position), and make
installation easier.

If you saved a wheel pin when you uncrated the platform, you can use that. An M5 x
10 screw also works well for this. See Spring-Compression Hole (arrow) on page 146.

NOTE: Make sure that the pin is short enough that you can pull it out
after the assembly is in place.

2. Connect the motor cable to the new drive assembly.

3. Install the new drive assembly over the three studs at the top of its bracket.

Use the nuts, screws, and washers you removed from the old drive assembly.

4. Remove the pin or screw you used to hold the wheel in the up position.

5. Put the side skin next to the platform, and attach the cable to the light disc PCA.

6. Reinstall the side skin.

7. Connect the battery power and data cables, and close the battery compartment door.

8. Reinstall the rear skin.
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Front or Rear Casters

Check the casters every 3 months, and replace them if they show signs of cracking, excessive
wear, or any damage.

All four casters are identical, and are mounted to the platform in the same way.

NOTE: If you can lift the platform enough to access the screw that holds on the
caster, you can avoid removing the payload structure and the battery, which is
only necessary to tilt the platform on its side.

1. Move the payload structure out of the way.

If the payload structure can be completely removed, do so. This enables you to tip the
AMR on its side, so you have access to the casters underneath.

2. Remove the inner rear skin.

3. Unlatch and open the battery door skin, at the back of the platform.

The battery compartment door is lockable. You may need to unlock it before opening.

4. Disconnect the battery by unplugging the two cables at the rear of the battery.

5. Remove the battery from the platform.

6. Remove the side skins.

7. Lay the body of the platform on its side, exposing the casters.

!
WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers stay back 30 cm from the underside of the platform,
which is exposed during certain maintenance procedures when the plat-
form is tipped on its side.

Regardless of whether you removed the battery:

1. Remove the M10 x 30 mm screw holding the caster to the platform.

The screw was installed with Loctite 263.

Retain the screw for attaching the new caster.
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Figure 8-17. Platform Caster Replacement

Callout Description

A (4) M6 x 22 Screw, Flat Head Socket

B Caster, Heavy Duty, with Bolt Hole Fitting

C M10 x 30 mm Screw, Flat Head Socket

D Use Locktite 263 on the M10 x 30 Screw

E Completed Assembly

2. Remove the caster from the platform.

3. Put the new caster in place, and attach with the M10 x 30 mm screw you removed from
the old caster.

Use Loctite 263.

Torque to 27 N·m (20 ft·lbf).

If you removed the battery for this procedure:

1. Return the platform to its upright position.

2. Reinstall the battery, connect the power and data cables, and close the battery com-
partment door.

3. Reinstall the battery door skin.

4. Reinstall the side skins.

Safety Scanning Laser

The Safety Scanning Laser is not user-serviceable. If it needs to be replaced, contact your local
Omron Support.
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LD Platform Core

The LD Platform core is an enclosed unit, with internal fans as the only moving parts.

1. Move the payload structure out of the way, so you can access the payload bay.

2. Remove the battery door skin.

3. Unlatch and open the battery compartment door, at the rear of the platform.

The battery compartment door can be locked. You may need to unlock it.

4. Disconnect the battery power and data cables from the rear of the battery.

5. Disconnect all of the cables attached to the top portion of the core.

Refer to Payload Bay Connections - Core on page 77.

6. Remove the core mounting bracket from around the core.

The bracket is two pieces, held in place with four screws down into the chassis, with
four more going sideways into the core itself. Retain all of these screws for installing the
new core. See the following figure:

Figure 8-18. Core Mounting Bracket

7. Remove the Sonar 1 cable from the core.

This cable is too short to allow the core to be lifted until the cable is removed.

8. Gently lift the core up, until you have access to the internal connections.

9. Remove all of the cables that are attached to the internal core connector panel.

The Left Motor and Right Motor connectors use the same type of plug, and can be inad-
vertently reversed. Ensure that you can clearly identify the left from the right.

See Internal LD Platform Core Connections on page 95.

10. Remove the old core.

11. Connect all of the cables that were attached to the internal core connector panel to the
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new core internal connector panel. See Internal LD Platform Core Connections on page
95.

Wait until after the next step to reconnect the Sonar 1 cable.

12. Put the core into the chassis.

13. Connect the Sonar 1 cable to the core.

14. Install the core mounting brackets around the new core.

Using the screws and washers you removed from the old core, put four screws into the
sides of the core, with four more going down into the platform chassis.

15. Reconnect all of the cables to the top portion of the core.

Refer to Payload Bay Connections - Core on page 77.

16. Reconnect the battery power and data cables to the battery.

17. Close and latch the battery compartment door.

18. Reinstall the inner rear skin.

19. Reinstall the payload structure.

20. Dispose of the old core according to local and national regulations concerning electronic
components.

E-Stop and Safety Laser Commissioning

Under normal circumstances, the AMR is commissioned at the factory, and will not need to be
re-commissioned. However, you must redo the E-Stop Commissioning and the Safety Laser
Commissioning procedures under the following circumstances:

l If you replace the core.

l If the hardware detects a failure, the AMR may automatically decommission itself. If
this happens, ARAM will display a fault pop-up in MobilePlanner.

l If you are using a user-supplied E-Stop.

l If you want to perform the commissioning procedures on a regular basis as part of their
preventive maintenance process.

NOTE: After performing either of these tests, you can access the other test by
clicking Next Test on the final screen.

E-Stop Commissioning

This procedure verifies that pressing the E-Stop button triggers the E-Stop circuitry. This is veri-
fied by ensuring that you hear the brakes activate after pressing the E-Stop button.

1. Ensure that the E-Stop button is NOT depressed before starting.

2. In MobilePlanner software, select:

Main Menu > Robot > Safety Commissioning
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3. Follow the on-screen instructions to complete the test. You can print a certificate after
successfully completing the commissioning.

Safety Laser Commissioning

This procedure verifies that the navigation laser reports speed zone information correctly, and
the E-Stop circuitry trips when an obstacle that the laser should detect is placed in front of the
AMR. The speed zones are listed in the table that follows. For the LD-60, each speed zone rep-
resents 300 mm/s, so if the maximum speed is 1500, six zones should be reported. (When you
press the Drive button in the wizard, the wizard will display the maximum AMR speed.)

Maximum Speed (mm/s)

Zone LD-60 LD-90
LD-105CT LD-130CT

0 300 225 150

1 600 450 300

2 900 675 450

3 1200 900 600

4 1500 1125 750

5 1800 1350 900

6 1800 1350 900

7 1800 1350 900

1. From the MobilePlanner software, select:

Main Menu > Robot > Safety Commissioning

2. Follow the on-screen instructions to complete the test. You can print a certificate after
successful completion of the commissioning.

Accessing the Payload Bay

Access to the payload bay depends on the design of your payload structure. A small, light pay-
load structure may be easily disconnected and simply lifted off, taking care not to damage any
of the wires connected to the platform.

A taller or heavier payload structure may have hinges, so that it can be tilted off of the plat-
form after being mechanically disconnected. For most payload structures, this will enable a
single technician to access the payload bay without assistance. Use care when accessing the
payload bay, that the wires and connections between the platform and the payload structure
are not disturbed when the payload structure is tilted.

Removing and Installing Skins

Most of the maintenance procedures require removing some of the platform's skins, most of
which use strong magnets to hold them in place. The rear skin has an additional brace for sup-
port, the front bumper uses screws and magnets, and the access panel uses a push-push latch.
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!
CAUTION: PINCH RISK
The magnets holding the skins in place are strong enough to pinch.

Additional Information: In general, it is better to install the payload structure
before installing the skins.

Figure 8-19. LD Platform OEM Skins

Callout Description

A Access Panel - covers the maintenance Ethernet port and Pendant con-
nector.

B Left side skin - covers the LD left drive train.

C Right side skin - covers the LD right drive train.

NOTE: Both side skins hold a light disc and cover.

D Battery door skin - covers the battery access door.

E Rear skin - covers the LD rear components, and houses the sonar trans-
ducer pairs.

F Front upper skin - Above the safety scanning laser and speakers.

G Bumper - Above the lower bumper assembly and low front laser.
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With the exception of the bumper, no tools are needed for either the removal or installation of
the platform’s skins.

Removing Skins

NOTE: After removing skins, place them inner-side down, so the outer surfaces
don't get scratched.

You can remove the skins in the order in which they are listed above.

l Remove the battery door skin before removing the rear skin and side skins.

l The front upper must wait for the two side skins.

l You can remove the two side skins, rear skin, and bumper without removing any other
skins (note that you must remove the access panel before removing the left skin).

NOTE: The light disc covers are not covered here because they are only
removed from the side skins to replace one of the light disc controllers.

Battery Door Skin

This provides access to the battery compartment door.

1. Pull the bottom of the skin away from the platform chassis.

This is easiest if you grip it with two hands, toward the center.

2. Lower the skin down, so its top tab clears the rear skin.

Access Panel

This provides access to the Maintenance Ethernet and the Pendant ports.

1. Push the left (front) side of the panel in, until the latch releases it.

Pushing the panel a second time will reattach it to the platform.

2. Pull the left side out, and slide the panel to the left.

The panel is attached with a lanyard.

You will need to place this panel out of the way when removing the left side skin.

Side Skins

1. For the left side skin, put the access panel out of the way.

2. Pull the bottom of the skin, near both sides, away from the chassis.

3. Work your way up the edges of the skin, pulling it away from the chassis as you go.

4. Remove the skin a few centimeters from the chassis.

The light disc wires plug into connectors on the inside of each side skin.

5. Unplug the light disc connector, and move the side skin away from the platform.

Repeat for the other side skin.
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Front Upper Skin

This skin attaches to the chassis the most tightly of any of the skins.

1. Grip the skin at the two outer edges.

2. Pry the skin away from the chassis.

Bumper Skin

This is the only skin that requires tools to remove.

1. Remove the screws at the sides of the skin.

Retain the screws for installing the new bumper skin.

2. Unscrew the retaining screws, then pull the skin off of the bumper.

Rear Skin

This skin houses the two rear sonar pairs, which you will disconnect once the skin is part-way
off the chassis. Each pair consists of one emitter and one receiver.

1. Pull the top of the skin away from the chassis a few centimeters.

The skin will pivot on the metal brace at its bottom edge.

2. Pull the four sonar wires, with their connectors, out of the chassis holes.

Refer to the following two figures.

Figure 8-20. Sonar Leads, with Connectors Still in Chassis

3. Unscrew all four sonar connectors.

Ensure that both sides of all connectors are labeled, and match. If not, label them.
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Figure 8-21. Sonar Connectors, with Connectors Exposed

4. Tilt the skin down to about 45°, and slide the brace on the bottom of the skin out of its
clip.

This will separate two pairs of magnets, so you will feel some resistance at first.

Installing Skins

Install the skins in the reverse of the order in which they are listed above.

l You must install the front upper and rear outer skins first and second.

l The access panel must wait for the left side skin.

Bumper Skin

This is the only skin that requires tools to install.

1. Place the skin on the bumper (held on with magnets and screws).

2. Install the screws (removed during the skin removal) at the sides of the skin.

Front Upper Skin

1. Grip the skin at the two outer edges.

2. Align the bottom edge of the skin so it slides under the chassis support.

3. Tilt the top of the skin into position.
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Rear Skin

Because this skin houses the rear sonar units, you must reconnect them once the metal brace
across the bottom is in the clip just below the battery access hole.

1. Slide the metal brace into the chassis clip.

Watch the two magnets on the bottom of the skin and align them with the magnets on
the chassis. This is your best guide for getting this skin in its proper place.

These are inboard of the clip holding the brace, so you will have to look on each side of
the skin to check their alignment.

2. After aligning the magnets at the bottom, tilt the skin up to within a few centimeters of
the chassis.

3. Pull the sonar connectors out of the chassis (if not already out).

4. Screw the four sonar connectors to their corresponding sonar leads.

Ensure that the labels for the connectors and leads match.

5. Tuck the connectors into the four holes in the chassis, until just an centimeter of sonar
lead is sticking out.

6. Tilt the top of the skin up to meet the chassis.

Side Skins

1. Move the skin to within a few centimeters of the chassis, and plug in the light disc con-
nector.

Connect the light disc to the fitting on the inside of the side skin.

2. Place the top edge of the skin on the chassis, so the magnets hold it there.

Make sure the gaps on each side of the skin are the same width.

3. Tilt the bottom edge of the skin down.

4. Check each side of the skin to ensure that the skin edges on each side of the gap stick
out the same amount away from the chassis.

This is most likely to be uneven near the top of the skin.

5. If either edge sticks out more than the neighboring skin, pull the neighboring skin away
from the side skin slightly, and release.

This should allow the side skin to snap into place, so both sides of the gap stick out the
same amount.

Repeat for the other side skin.
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Figure 8-22. Right Side Skin, Showing Even Gaps at Edges

NOTE: The gaps between the side skins and the bumper will be smaller than
the other gaps, and will not be even.

Access Panel

1. Slide the panel to the right, so its tab goes under the left side skin.

A lanyard attaches the panel to the skin to prevent getting lost.

2. Press the left (front) side of the panel in, and the latch will hold it.

This is a toggle latch - pressing it once engages it, pressing it a second time releases it.

Battery Door Skin

1. Slide the skin up, so its top tab fits under the rear skin.

!
CAUTION: PINCH RISK
This skin is the most likely to pinch you if you are not careful, par-
ticularly at its bottom edge. Hold the skin at the bottom, in the center,
with two hands.

2. Hold the skin near the center and, with both hands, tilt the bottom of the skin down,
towards the platform chassis.
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There are a number of options available for the LD Platform OEMs to enhance their per-
formance and abilities.

9.1 Fleet Manager, for Multi-AMR Coordination
This is a network appliance, and the Fleet Operations Workspace Core which runs on it.

It prevents traffic problems between different AMRs in a fleet, and ensures completion of all
jobs submitted to its queue. This is covered in the Fleet Manager User's Guide.

9.2 Pendant
This is mainly used to manually drive the platform when doing a scan, in preparation for
making a map of the workspace. You need at least one Pendant for each fleet of AMRs. Once a
map is generated, it can be shared with multiple AMRs working in the same space.

9.3 Spare Battery
You need at least one spare battery if you opt to swap the AMR’s battery, rather than having it
charge itself at a docking station. See Manually Charging the Battery on page 108.

9.4 Payload Structure Bumpers
This is in addition to the standard front bumper on the platform. Up to one front and one rear
user-supplied bumpers are supported, each with left, right and center sensors.

NOTE: The User Bumpers connector is not safety-rated.

9.5 Call Buttons/Door Boxes
Call buttons issue a request for an AMR to go to the goal associated with the button. There
may be multiple call buttons, even in an installation where there is only one AMR.

Door Boxes are used to open an automated door, so the AMR can pass through. See
LD Platform Peripherals User's Guide (Cat. No. I613).

9.6 Electrostatic Discharge (ESD) Skins
The bumpers and skins of a non-ESD AMR can accumulate an electrical charge which, if dis-
charged into ESD sensitive components, could damage those components.

The optional ESD skins encase the AMR in an electro-conductive surface that provides a skin-
to-chassis-to-wheel grounding path that drains off any charge the AMR might accumulate dur-
ing operation.
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Figure 9-1. LD Platform OEM with ESD Skins

9.7 High Accuracy Positioning System

Overview

The High Accuracy Positioning System (HAPS) option allows an AMR to achieve accurate
alignment at a specific location, such as at a fixed conveyor. It is available as an option for all
Omron Robotics and Safety Technologies AMRs.

The HAPS option uses a sensor to follow a strip of magnetic tape that has been applied to the
floor at a location where high accuracy is needed. Two sensors allow the AMR to follow the
tape both forward and backward. With one sensor, the AMR can only follow the tape when
driving forward.

Apply tape to the floor leading up to the tool or conveyor that you want the AMR to approach
closely. Markers (short sections of the tape) are used to signal the AMR where to stop.

The simplest installation consists of a goal on the AMR‘s map, a length of magnetic tape, and
one marker. The goal will have tasks that direct the AMR to proceed to the tape, follow the
tape, and stop at the marker.

For locations with multiple places where you want the AMR to stop, you would use a con-
tinuous tape strip for all stops, with one marker at each stop, one goal for each marker, and an
Engage task for each goal. The goals would all be at the same location, near the start of the
tape. The Engage tasks allow an AMR to follow the tape, performing tasks from the successive
goals, without ever having to return to the location of the goals.

Components

The factory-supplied component is the HAPS sensor. One sensor allows accurate positioning
driving forward. For installations that need the AMR to drive both forward and backward
along the tape, two sensors are required.

In either case, the system requires magnetic tape applied to the floor at the specific locations. (It
is generally the customer's responsibility to install the magnetic tape.)

The HAPS option requires ARAM 4.7.6 or later software.



Chapter 9: Options

Sensor Installation on the LD-60 and LD-90

Use the information in this section to install HAPS sensors.

Mounting Locations for the LD-60 and LD-90

See "Mounting Positions for Brackets and Sensors (units are mm)" shows the mounting loc-
ations for the LD-60 and LD-90.

239.8

139.5CL
A

B

C

D

E

F

Figure 9-2. Mounting Positions for Brackets and Sensors (units are mm)

Key Meaning Key Meaning

A Axle D Mounting Hardware (Screw andWashers) x2 or x4, Removed from
Drive Units and then Re-installed

B Rear Sensor E Front Sensor

C Rear Sensor
Bracket

F Front Sensor Bracket

!
WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers should stay at least 30 cm away from the underside of the
platform.
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Single and Dual-Sensor Installation, Part 1

1. Remove the side covers on both sides of the platform.

2. Remove the payload structure to expose the payload bay and the core.

The specifics of what is involved with this step depends on your payload structure.

3. Tip the AMR onto its left side.

4. Attach two cable-tie anchors in the area behind the right drive wheel, as shown in the
following figure.

Figure 9-3. Cable-tie Anchors Behind Right Wheel

Proceed with either Single-Sensor Installation or Dual-Sensor Installation, and then perform the
steps in Single and Dual-Sensor Installation, Part 2 on page 165.

Single Sensor Installation

A single sensor goes in the forward position of the AMR.

1. Remove two M5 stainless socket-head cap screws, split lock washers, and flat washers
from the underside of the platform. See the following figure for the locations of the
screws.

Save the screws and washers for installation of the sensor.
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Figure 9-4. Screws to Remove, Circled

2. Attach the bracket to the underside of the AMR, with the cable between the bracket and
the platform. The sensor will already be attached to the bracket.

Use the M5 screws and washers previously removed. Use Loctite 243.

3. Route the sensor wires back to behind the right drive wheel, as shown.

Figure 9-5. Front Cable Route, Shown in Yellow

4. Install two cable-tie anchors to the underside of the platform, along the path of the
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cable.

5. Cable-tie the wires from the front sensor to the anchors.

6. Proceed to Single and Dual-Sensor Installation, Part 2 on page 165.

Dual Sensor Installation

1. Remove four M5 stainless socket-head cap screws, split lock washers, and flat washers
from the underside of the platform. See the following figure.

Save the screws and washers for installation of the sensors.

Figure 9-6. Screws to Remove, Circled

2. Attach the front bracket assembly to the underside of the AMR, with the cable between
the bracket and the platform. Its cable will be labeled FRONT.

The cable will have two branches, each attached to a sensor and bracket assembly.

Use the screws and washers previously removed. Install the M5 screws with Loctite
243.

The sensor will already be attached to the bracket.

3. Attach the rear bracket assembly to the underside of the AMR.

Use the M5 socket-head cap screws and washers previously removed. Install the M5
screws with Loctite 243.

The sensor will already be attached to the bracket.

a. Install two cable-tie anchors to the underside of the platform, between the two
bracket assemblies. See the following figure.
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Figure 9-7. Mounted Sensors

b. Cable-tie the wires from the front sensor to the rear to the anchors.

4. Proceed to the next section, Single and Dual-Sensor Installation, Part 2.

Single and Dual-Sensor Installation, Part 2

1. Route the sensor wires, both data and power, up through the platform chassis, just
behind the right drive wheel, and through the cutout shown in the following figure.

Figure 9-8. Cutout in Payload Bay for Cables

Cable-tie the cables to the anchors previously installed behind the right wheel. See Fig-
ure 9-3.
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2. Put the AMR upright, and re-install the side covers.

3. Plug the splitter cable (Mini-Fit Jr™, included) into the AUX PWR port on the upper rear
core.

Figure 9-9. Upper Rear of Core, Showing AUX PWR Port

4. Plug the sensor power connector into one branch of the splitter cable.

This can power one or two sensors.

5. Plug the RS-232 connector(s) into the upper front of the core.

Figure 9-10. Upper Front of Core, Showing RS232 Ports

The front sensor plugs into RS-232-1.
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The rear sensor plugs into RS-232-2.

6. Reinstall the payload over the payload bay.

Tape and Marker Application

The standard tape used is South facing up, with adhesive on North.

IMPORTANT: You cannot use the same marker tape configuration for both LD-
250 and for LD-60, LD-90 and LD-xxxCT models in hybrid fleets because of their
different sizes and turn radius.

To determine the distance between the LD platform and its final alignment goal (such as a
machine with which it interfaces) Refer to the LD model User's Guide to obtain the exact
dimensions of the platform.

For example, for LD-60, LD-90 and LD-xxxCT models, the platform body is 499 mm wide. In
this case, setting a distance of 275 mm from the center of the tape to the intended conveyor cre-
ates a gap of 25.5 mm between the AMR's side and the goal. If your payload has an overhang
at the side, you must adjust the width accordingly.

165.572.1
CL CLCL

  697 

499 

A AB

C D

Figure 9-11. Location of Front and Rear Sensors
LD-60 and LD-90models (units are mm )

Key Meaning Key Meaning

A Sensing C Rear Sensor

B Axle D Front Sensor

Apply markers 20-30 mm to the right of the main tape track. See the following figure.
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D

400 30.0°
500
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C

H J
K

F G

E

Figure 9-12. Two-stop System (units are mm)

Key Meaning Key Meaning

A Goal 1 and Goal 2 (at some location) F Conveyor 1

B Main Track G Conveyor 2

C Rear Sensor H Marker 1

D Front Sensor J Marker 2

E Direction of Track K 20-30 mm between main track andmark-
ers

If you use the same magnetic tape for markers as for the main tape strip, apply the markers
upside-down, relative to the tape. If you use tape with North up (rather than the South-up
tape) ensure that the markers are applied with their South side up.

The recommended marker length is 300 mm. Shorter markers can be used if the AMR is oper-
ating at slower than default speeds (< 500 mm/second).

The AMR will stop with the front sensor at the front end of the marker. Note the model-
dependent locations of the sensors to calculate where you should place the markers in relation
to the location where you want the AMR to stop.

NOTE: Even if you drive backward to reach a marker, the AMR will inten-
tionally overshoot, and then drive forward to align its front sensor with the front
of the marker. You should extend the markers at least 40 mm past the goal to
enable the AMR to reacquire the goal if it overshoots.

Define Goals

An AMR with front and rear sensors needs 500 mm of tape for alignment.

Each marker needs its own goal. A suggested goal location is 400 mm from the tape, near the
start of the tape, with an orientation of 30° from the angle of the tape. This allows the AMR to
approach the tape at normal speed without overshooting it. If you use a sharper angle, aimed
more directly at the tape, you need to reduce the AMR‘s ApproachSpeed to prevent overshoot.
See the preceding figure and Robot Operation on page 169. Goal 1 would apply to Marker 1,
Goal 2 to Marker 2.
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For multiple markers, all goals should be placed at the same location. Each goal will contain
the tasks associated with one marker.

HAPS Software Configuration

The HAPS parameters are configured using the MobilePlanner software.

Robot Physical

1. Go to:

MobilePlanner > Config > Robot Physical

2. Check the Show Expert + Parameters check box.

3. For GuideSensor_Front:

a. Check the AutoConnect check box.

b. Set the Port parameter value to /dev/ttyUSB9.

4. For GuideSensor_Rear, when a second sensor is present:

a. Check the AutoConnect check box.

b. Set the Port parameter value to /dev/ttyUSB10.

Robot Operation

1. Go to:

MobilePlanner > Config > Robot Operation

2. Check the Show Expert + Parameters check box.

3. Select the FollowGuide entry in the Sections pane.

l ApproachSpeed is the speed, in mm/sec, to drive when approaching the tape
from the goal.

l FollowingSpeed is the speed, in mm/sec, to drive while following the tape.

l ReverseFollowingSpeed is the speed, in mm/sec, while following the tape in
reverse. Maximum is 300 mm/second. This only applies for a second sensor.

l SlowCaptureSpeed is the speed, in mm/sec, to drive after deceleration when find-
ing the end of a marker. This should be slow, such as 20 mm/sec.

l followingAccel is the acceleration to use. 0 means default.

l followingDecel is the deceleration to use. 0 means default.

l FrontClearance is the minimum distance to an obstacle in front of the AMR
before the AMR will stop. It should leave room to path plan away.

This needs to be small enough so the AMR does not stop too soon when
approaching a conveyor or other fixed object that you want it to approach
closely.
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l SideClearance is the minimum distance to an obstacle on either side of the AMR
before the AMR will stop. It should leave room to path plan away.

This needs to be small enough so the AMR doesn’t stop too soon when approach-
ing a conveyor or other fixed object that you want it to approach closely.

l AvoidLocationDependentObstacles will avoid map obstacles like forbidden lines
and areas, if True.

Goals/Tasks

The two tasks relevant to the HAPS option are FollowGuide and Engage.

NOTE: In this context, a goal is a goal on the AMR’s map. It is used as a start-
ing point for tasks that will drive the AMR along the tape, stopping at markers
along the tape. There will be no goals on the tape itself.

The FollowGuide task has the following parameters:

l successCriteria

This will usually be captureMarker, to stop at a marker. It is possible to use either end
of the tape, if two sensors are present, but markers offer more flexibility.

l markerNumber

Which marker on the tape the AMR will stop at.

l markerLength

Physical length of the marker. 300 mm is typical.

l acquireTrackAfterMarker

Where the AMR will enter the tape, relative to the markers on the tape. This is determ-
ined by the location and angle of the goal, relative to the tape and markers. Normally,
this will be 0, meaning the AMR will enter the tape before any markers.

The Engage task calls a macro when the AMR arrives at the goal, so the AMR can be sent on a
series of tasks, such as a FollowGuide task to go to a marker.

If successive goals are at the same location, and each has the Engage task on it, the AMR can
be sent on multiple tasks without returning to the goal location. This allows you to have the
AMR go to multiple markers without ever leaving the tape to return to the goal location.

l Each marker needs its own goal.

l Each of the goals needs to be at the same location.

l Each of the goals needs to have the Engage task.

l Each of the Engage tasks will have a different engageMacro.

When a goal’s engageMacro finishes, if the next goal assigned to that AMR is at the same loc-
ation as the previous goal, and has the Engage task, the AMR will not drive back to the goal,
but instead will start executing the engageMacro associated with the new goal.

The parameters associated with the Engage task are:
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l EngageMacro = A macro, generally containing the FollowGuide task, that tells how to
get to the correct spot on the tape.

l DisengageMacro = A macro that tells the AMR how to remove itself from the tape safely
from that marker position. If no macro is given, the robot will go to autonomous mode
automatically.

l UseGoalPosition = How close goals need to be for them to be considered as being at the
same location. A tolerance larger than the distance between the goals will make it so
that the goals are considered as being at the same location. After entering True for this
value, you will be given a choice of distance. The defaults are generally fine.

Note that this is the goal position, and not the position that will result after the Fol-
lowGuide or Engage tasks.

l FaultEngageMacro = How the robot will deal with failures when engaging.

l FaultDisengageMacro = How the robot will deal with failures when disengaging.

l EngageOnlyIfFromGoal = Set to False or blank when using FollowGuide.

l lockModeduringMacro = Boolean to decide if the robot’s mode will be locked during the
engage process.

l whenEngagedSupress = Choose to suppress the goal driving, so the AMR doesn’t drive
back to the goal location between goals.

Do not set this to suppress macros, as they are needed to use the engageMacro of each
successive goal.

Specifications

Feature Specification

Sensor

Depth 30 mm

Width 160 mm

Rating IP64

Environment -40 to 85° C

LEDs Power, Tape present, Left marker, Right marker

Magnetic Tape

Width 25 mm

Orientation South up

Markers (Magnetic Tape)

Width 25 mm

Length 300 mmmin. for 500 mm/sec drive speed

Orientation North up

Separation from tape 20 - 30 mm
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Feature Specification

Connections

Front sensor RS232-1 (/dev/ttyUSB9) on the core

Rear sensor RS232-2 (/dev/ttyUSB10) on the core

Power, both sensors Aux Power, using the included splitter cable

Dimensions

A

B

Figure 9-13. Overall Dimensions of the Sensor, (A) Top View and Dimensions, and (B) Front View and
Dimensions (units are mm)

9.8 Acuity Localization
Acuity localization uses a camera to detect overhead lights, enabling the AMR to localize itself
in an environment where laser localization by itself is not an optimal solution.

Laser localization is largely tolerant of changing environments, but it becomes difficult where
more than 80% of the features seen by the laser change. This includes settings such as ware-
houses, where many objects like shipping pallets or rolling carts change locations often, or
which block the laser’s view of mapped features. Acuity is also useful when wide-open spaces
don’t provide enough features for laser localization.

When Acuity Won’t Work

l Acuity Localization will not work with indirect lighting.

l In general, Acuity Localization works if at least three light fixtures can be seen by the
camera. More is always better. If some of the light bulbs within a light fixture go out, it
should not affect Acuity, as long as there are some lights still on in the fixture.

Installation Scenarios

There are three basic scenarios that affect which sections of this chapter you will need:
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l Acuity Localization has been ordered with a platform and a factory-designed payload
structure.

l Acuity Localization has been ordered with a platform, to be installed on a payload struc-
ture designed by you.

l Acuity Localization has been ordered as a kit, to be installed as an upgrade to an exist-
ing platform on a payload structure designed by you.

In the first case:

l You will not have to configure any software or import camera calibration, as that will
have been done at the factory.

l The location of the camera assembly will be predetermined, so payload structure design
is taken care of.

In the second case, the Acuity-related software will be installed at the factory.

In the third case, this entire chapter will be relevant.

Payload Structure Design

l The location for the camera needs to provide a flat, level surface at least 57.2 mm in dia-
meter.

l The camera lens must be not be obstructed by any other part of the AMR. It has a 140°
field-of-view, so take care that nothing higher than the camera lens is close beside the
camera.

l The mounting location needs to provide a sturdy support for the camera, as any vibra-
tion or other movement of the camera makes localization difficult.

l The payload structure needs four 4.6 mm holes and one hole, at least 17 mm in dia-
meter, in the center of that hole pattern. See Hole Pattern of the Camera Enclosure Base
(units are mm) on page 176.

Two of the 4.5 mm holes and the 17 mm hole must line up with the AMR‘s direction of
travel.

NOTE: For localization, the holes (and camera) need to be aligned within
one degree of rotation about the X and Y axes of the platform. See the fol-
lowing figure for hole orientation.
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A

Figure 9-14. (A) Direction of Travel, Hole Pattern

Tasks

l Install camera assembly

l Connect power and data cables between camera and platform core

l Enable Acuity in MobilePlanner software

l Load camera calibration file

l Measure camera position and tilt, enter into MobilePlanner software

l Create map (will contain both laser and Acuity data)
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Components

l Camera Assembly

o Camera

o Three M3 x 4 screws

o Bracket

o Base

o Four M4 x 12 screws

o Tube

o Neutral Density
(ND) filter, 55 mm

o Foam dust seal

l Cables

o Ethernet cable

o Power cable (Hirose
to 2x3 Mini-Fit Jr.™)

o Power splitter cable

l Software

l Digital Level

l Fast Ethernet switch
(optional, user-supplied)

Only needed if the
Auxiliary Ethernet port on
the platform is being used by
another peripheral.

A

B

C

D
E

F

J

H

G
Direction of Travel

Omron Adept Technologies, Inc.

4550 Norris Canyon Road 150

San Ramon, CA 94583

Model: Acuity

P/N: 13700-000

Figure 9-15. Acuity Camera Components

Callout Description Callout Description

A Neutral-Density Filter F Bracket

B Foam Dust Seal G Direction of Travel label

C Tube H M4 x 12 screws go up through
base

D Camera J Base

E Camera mounting screws
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Installation

NOTE: In this section, the figures show the camera assembly being mounted to
a test bracket. This is only used to show where the screws will attach. A typical
installation will have the mounting holes in the top of the AMR’s payload struc-
ture.

Camera Assembly

1. Attach the camera enclosure base firmly to the payload structure using one of the four
supplied M4 x 12 screws. The screw has to be inserted from inside your payload struc-
ture, through the payload structure surface, and into the single clinched nut in the cam-
era enclosure base.

NOTE: It will simplify configuration, by minimizing the Theta offset, if
you mount the camera base so that the hole with the clinched nut is
facing toward the left of the AMR (+Y).

l Mount the base to the mounting location using an M4 x 12 mm socket head
screw. You may need to use a longer screw depending on the thickness of your
mounting location. A washer and lock washer are recommended, though not
shown here.

l Note the orientation of the base with regards to the direction of travel. Make sure
the other three holes are aligned before tightening the screw.

M4 x 12  

4x  Ø 4.6  

Ø 57.2

Ø 31.0

Ø 17.3

A

B

C

D

C

E

B

F

G

H

Figure 9-16. Hole Pattern of the Camera Enclosure Base (units are mm)
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Callout Description Callout Description

A Camera Enclosure Base E Note: Test Bracket is for Illus-
tration Only.

B Direction of Travel F Screw

C Through Hole G Note: Test Bracket is Shown for
Illustration Only. To Mount to
Your Own Location, See Detail
of Base Mounting Holes.

D Detail of Base Mounting Holes H Mounting Location

2. Mount the camera bracket to the camera enclosure base.

The bracket will only fit on the base one way.

Attach the camera bracket firmly to the base using 3 M4 x12 mm socket head screws.
You may need to use longer screws depending on the thickness of your mounting loc-
ation. Washers and lock washers are recommended, though not shown here.

3x M4 x 12 

A

B

C

D

Figure 9-17. Mounting the Camera Bracket (units are mm)

Callout Description Callout Description

A Camera Mounting Bracket C Camera Enclosure Base

B Note: Test Bracket is Shown for D Screw
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Callout Description Callout Description

Illustration Only. To Mount to
Your Own Location, See Detail
of Base Mounting Holes.

The screws have to be inserted from inside your payload structure, through the payload
structure surface and camera enclosure base, and into the three clinched nuts in the bot-
tom of the camera bracket.

There is a sticker on the camera bracket that shows the direction of travel of the AMR.
See the following figure. Verify that the arrow on the sticker is pointing toward the front
of the AMR.

Direction of Travel

4225 Hacienda Dr

Pleasanton, CA 94583

Model: Acuity

P/N: 13700-000

Omron Robotics 

and Safety Technologies, Inc.

Figure 9-18. Label on Camera Mounting Bracket
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 R5.1 (0.20) 

23.6 

 5.1

 6x R1.5

 

 26.7 

 33 

 0 

8.4

72.1

2x 91.7

103.6

 0 

 9.9

 R5.1

 0 

 5.8 

91.7

103.6

 0 
 16  30.5

 Ø 42.9

 16
Ø 17

3x Ø 5.3 

90° on Ø 31 CL

 5.1 

 10 

 5.1

 9.9

A

B

B

C

Figure 9-19. Dimensional Drawing of Camera Bracket, (A) Through Holes Equally Spaced at,
(B) Through Hole, and (C) Label on Back (units are mm)

3. Attach the camera to the camera bracket.

a. Attach the camera cables to the camera before mounting the camera.

Refer to Camera Connections on page 180.

b. Attach the camera to the mounting bracket using three M3 x 4 mm button head
screws.

NOTE: The camera needs to be mounted as high in the bracket as
possible, without its lens adapter interfering with the ND filter.
This prevents the tube itself from limiting the camera’s angle of
view.
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3x M3 x 4 A

B

C

Figure 9-20. Attaching Camera to Camera Bracket, (A) Button Head Cap Screws, (B) Camera
Mounting Bracket, and (C) Camera (units are mm)

Camera Connections

The camera requires a power cable and an Ethernet cable connected to the platform
core. These will pass through the center (17 mm) hole in the camera enclosure base and
bracket.

IMPORTANT: The Acuity camera's signal cabling is sensitive to inter-
ference from noise and its power supply is sensitive to ripple. Route sig-
nal cables to avoid interference. If your payload's power demand is high,
or you need to add other devices to the AUX power circuit, carefully test
Acuity operation before deploying and contact your local Omron Support
if you have problems.

a. Feed the Hirose end of the power cable and one end of the Ethernet cable up
through the 17 mm hole in the center of the base and bracket, from inside your
payload structure.

b. Connect the Hirose end of the power cable to the camera.

See the following figure.
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Figure 9-21. Hirose Plug

c. Connect the Ethernet cable to the camera.

d. Connect the 3x2 Mini-Fit Jr. power cable from the camera to the 3x2 Mini-Fit Jr.
power splitter cable (inside the payload structure).

e. Connect the Mini-Fit Jr. splitter to the core’s AUX POWER port.

The splitter will leave one available Mini-Fit Jr. power connector available for
other uses.

f. Connect the Ethernet cable from the camera to the Auxiliary Ethernet port on the
core.

NOTE: If other peripheral items, such as the touchscreen interface,
also require the use of the Auxiliary Ethernet connection, then a fast
Ethernet switch will be required (user-supplied).

4. Attach the tube onto the base.

The threads at the bottom of the tube are coarse, and match the threads on the base. The
threads at the top of the tube are fine, and match the filter.
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A

B

Figure 9-22. Attaching the Tube to the Base, (A) Tube, and (B) Camera Enclosure Base

5. Install the foam dust seal and ND filter.

a. Insert the foam seal around the camera lens and press into the tube until the seal
sits on the camera body.

b. Thread the neutral density filter onto the camera enclosure body (tube).
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A

B

C

D

Figure 9-23. (A) Filter, (B) Foam Seal, (C) Tube, and (D) Completed Assembly

Software Installation

This step only needs to be taken if you are adding Acuity Localization as an upgrade to an
existing system.

Install the Acuity supporting libraries first. This package will either be supplied with the Acu-
ity order, or it can be obtained through our applications engineering staff.

Enabling Acuity

In MobilePlanner

NOTE: Light Localization and Laser Localization are designed to be used at the
same time. In cases where laser readings are unreliable, Laser Localization can
be disabled to ensure that only Light Localization is being used. Optional instruc-
tions for disabling Laser Localization will also be included in this section.

In order to enable Acuity, you need to check the LightLocalization parameter box in
MobilePlanner > Config. In this configuration section DisableLaserLocalization can also be
checked in the case that only using Light Localization is preferred.

Robot Operation > Localization Modules
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Figure 9-24. Enabling Acuity in the MobilePlanner Software

These will only be visible if the Show Expert + Parameters box is checked. To make a change,
you will need to click and drag the desired parameter from the expert Parameters tab into the
Configuration tab.

For instances where only Acuity operation is desired both boxes should be checked. This will
cause the AMR to use only the Acuity camera for localization.

After enabling Acuity, save the changes to the configuration. The AMR’s software will reboot.

NOTE: After making and saving Acuity changes within MobilePlanner, the
robot has to be power-cycled for those changes to take effect.

In SetNetGo

Select MobilePlanner > SetNetGo

Network > User LAN Ethernet

Make sure the radio button for Interface mode: is set for Accessory, and that DHCP Server for
Accessories is set to Enable. See the following figure.

Figure 9-25. Accessory Radio Button, DHCP Server for Accessories Enabled

NOTE: The DHCP server must also be turned on, and a range specified. These
will be set at the factory if you buy an AMR with a touchscreen or Acuity Local-
ization.
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From the Map

NOTE: This method of enabling or disabling modes of localization is for expert
use only. You should not use this method unless you fully understand it.

If LaserLocalization is not disabled explicitly through the use of the Disable LaserLocalization
parameter, then it can be disabled using a map task. After enabling Acuity localization by
checking the box for LightLocalization and saving the configuration, new configuration sec-
tions related to LightLocalization will become visible, as will a set of tasks to be used in the
AMR’s map. Among these new tasks will be:

l DisableLaserLocalization

l DisableLaserLocalizationCancel

l DisableLightLocalization

l DisableLightLocalizationCancel

These tasks can be used to selectively switch between Acuity and laser localization.

NOTE: These tasks cannot be used while the AMR is moving. Place the tasks in
a macro, in a virtual door, or after a goal where the AMR is expected to switch
localization modes.

Use the Custom Response, Startup to run the DisableLaserLocalization task when the AMR
boots. Later, if you want to switch localization methods, use the tasks listed to disable one type
and cancel the disabling of the other type.

Importing the Camera Calibration

Each AMR equipped with Acuity Localization will be supplied with a calibration file, which
you will need to import before Acuity Localization can be used.

This process is completed using the standard MobilePlanner import:

File > Import Config

The file name for the camera calibration file matches the camera serial number.

To import the camera calibration:

1. With LightLocalization enabled, use the Command tool in the MobilePlanner toolbar to
select PopupCameraSerialNumber.

2. If you do not see the Commands tool in MobilePlanner, right click in the blank space in
the toolbar area.

Check the selection for Custom Commands.

3. Click the Command drop-down arrow, and click PopupCameraSerialNumber.

You will see a popup with the camera serial number:
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Figure 9-26. Getting the Camera Serial Number

4. Load the camera calibration file, which was provided with the Acuity system, from
MobilePlanner by selecting File > Import Config, then navigating to the location of the
file on your PC.

The name of the calibration file will match the serial number of your camera, with a .txt
extension. Make sure that the checkbox for Acuity Camera Calibration is checked in the
dialog box, and click OK to load the calibration file. After importing the Acuity Camera
Calibration file, save the configuration again. See the following figure.

Figure 9-27. Importing the Acuity Camera Configuration File
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Compensating for Camera Position and Tilt

Enter the position of your camera with respect to the AMR into the MobilePlanner software.
Refer to the following figure.

697

Z = 0

+X

+Y

+Z

X = 0

Y = 0

+theta

Z = 0

17.5

5.5

A

X = 0

Y = 0

500

Figure 9-28. Measuring the Camera-platform Offsets, (A) At Sensing Plane of Camera (units are mm )

1. Measure the X and Y distance from the center of the AMR (X = 0, Y = 0) to the center of
the camera (X = 0, Y = 0).

2. Measure the vertical distance from the floor to the plane of the camera’s sensor.

To measure this distance, measure from the floor to the top of the camera (not the top of
the lens) and subtract 17.5 mm.

Alternatively, measure from the floor to the top of the rectangular portion of the camera
and subtract 5.5 mm. Round all measurements to the nearest millimeter.

3. Enter the measured values in MobilePlanner > Config

Robot Physical > Acuity Camera Position

in the parameters CameraOffsetX, CameraOffsetY, and CameraOffsetZ.

If the camera is toward the front of the AMR it will have a positive X value. If it is
toward the rear of the AMR it will have a negative X value.

If the base is mounted per instructions, the camera will have its rear side, with threaded
holes for mounting it, facing +Y of the AMR (the AMR‘s left side). This will result in a
CameraOffsetTh (theta) of 0. If this is not the case, then a theta offset must be applied.
For example, if the back of the camera is facing the rear of the AMR, the Cam-
eraOffsetTh will be 90, as a counter-clockwise rotation is positive.
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4. Finally, measure the tilt of the camera with respect to the floor using the dual-axis
digital level that was included with the Acuity package.

NOTE: The Acuity Localization kit can be ordered without the level. In
such cases, it is assumed that you already received one kit WITH the
level, and will use that for multiple Acuity Localization setups.

a. Bring the AMR to a level, hard floor. Do not use carpeted floor.

b. Place the digital level on the floor with the edge pressed against the right wheel
cover, buttons toward the front of the AMR, and the display facing straight up.
See the following figure.

c. Zero the level. (Press ZERO.)

The bubble on the display should be centered, and the values for X and Y tilt
should be near zero.

A

B

Figure 9-29. Zeroing the Level, (A) Front of Robot, and (B) Correct Level Orientation

d. Place the level, facing up, over the camera and top of the bracket.

The USB port on the level (which is not used in this procedure) should be on the
same side of the level base as the slot for the camera bracket. The level and base
should have been delivered to you this way. See the following figure.
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A

B

Figure 9-30. Level Base, (A) USB Port, and (B) Camera Slot

It will only fit one way, with the slot in the plastic base of the level fitting over
the back side of the camera mounting bracket. The slot is called out in the pre-
ceding figure.

5. Enter the values directly from the display into MobilePlanner > Config

X AXIS = Robot Physical > Acuity Camera Position > CameraTiltX

Y AXIS = Robot Physical > Acuity Camera Position > CameraTiltY

Be sure to include the + or – sign. You can press the HOLD button on the level to lock
the values.

Figure 9-31. Transferring Level Readings to the MobilePlanner Software

6. Reinstall the foam dust seal on the camera, and screw the camera tube back onto its
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base. Ensure that the camera’s light filter is in place in the top of the tube.

Making a Map of Your Environment

In order to have your AMR perform autonomous mobile activities, you need to make a map of
its environment. Use the MobilePlanner software to make a map. Refer to the FLOW Core
User's Guide (Cat. No. I637).

The tasks involved are:

l Make a scan of the operating space while driving the AMR with the pendant.

NOTE: It is a good idea to have the automated docking station installed
before you make the scan. The distinctive angle and shape of the front of
the docking station will be useful in locating and setting it up in the map.

l Load that scan from the AMR into MobilePlanner, on your PC, to create and edit the
map.

l Transfer the working map back to the AMR or Fleet Manager.

l Localize the AMR with the newly-created map.

This is especially important for Acuity localization. Ensuring that the AMR is properly
localized, as opposed to offset by one or more lights, is critical.

Scanning the Environment

Light-Related Parameters

l Parameters in the Light Analysis Section are used for mapping only.

l Parameters in the Light Localization section apply only to runtime, not mapping.

l Light Video Analysis parameters apply to the images used for both mapping and loc-
alization.

If the MinRefreshInterval—the rate at which new images are acquired—is higher than
the LightTimer in the Light Localization section, then light localization will be limited
to the MinRefreshInterval. The AMR can’t localize faster than it is receiving new
images from the camera.

The laser and light data are generated from the same scan. You only have to drive the AMR
through the environment once to gather the information necessary for a map containing points
and lines generated from the laser data, as well as rectangles, used to represent facility light-
ing, generated from the camera images.

Light Height

Before scanning, measure the height from the floor to the lights. Use the height of the lights,
not the ceiling, as most lights are set away from the ceiling by some amount. For diffused fluor-
escent lights, in an office setting, the ceiling height is typically fine. Metal-halide dome lights
in high-bay warehouses are typically hung from the ceiling by about one meter.

Enter the height of the lights in the AMR’s configuration in the Robot Operation > Light Ana-
lysis section. The 3d: MinLightHeight parameter should be about 15% less than the measured
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height, and 3d:MaxLightHeight should be 15% more than the measured height. All lights
between those heights will be included when the map is created.

Enter the actual measured height into the 3d:DrawingLightHeight parameter (this is strictly for
display purposes, and does not affect AMR operation).

If there are areas within the environment that have different light heights, you do not have to
scan the space again. Pick one light height to be first, and enter the values for Min and Max
light height into the configuration before scanning. You can adjust these later, and multiple
maps can be processed from the same scan file. This will be covered later.

Light Size

Measure the size of the lights. By default the maximum light length is set at 2000 mm to pre-
vent the detection of large, erroneous lights on a map. If your lights are longer than this, you
will need to increase the 3d:MaxLightLength parameter, which is in the Robot Operation >
Light Analysis section. The AMR will not be able to scan lights which are long and con-
tinuous, such that the light cannot be captured in a single image. For particularly large lights,
it may be necessary to change the 3d:DrawingMaxSize parameter, visible when the Show
Expert + Parameters box is checked, which limits the perimeter of a light. The default for this is
10000 mm.

Scan Pattern

Scanning for Acuity Localization is carried out the same way as for the laser alone, starting
and stopping the scan from the MobilePlanner software. When scanning for Acuity, make sure
you drive the AMR underneath each light that is visible from any point you want the AMR to
go. This generally requires more driving than for a laser-only scan.

For a space that is about 30 x 30 meters, the following path was used for the scan. Lights are
represented as light blue rectangles on the map created from this scan.

Figure 9-32. Sample Mapping Strategy
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Figure 9-33. Resultant Map

Creating a Map

After finishing the scan, proceed with creating a map:

1. Open the scan file on the AMR using MobilePlanner > File > Open on Robot.

l Select the IP address of your AMR.

l Both a .2d and a .z2d version of the scan file you just created will exist on the
AMR.

Choose the .z2d version of the scan file, which contains both the light data and
laser data.

The laser scan will be processed first, followed by the extra processing for the lights. If
all of the parameters were set properly, the light blue light items will be visible on the
map overlaid on the points and lines from the laser data.
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Figure 9-34. Initial Map, with both Laser and Light Data

2. If you are satisfied with the map:

NOTE: Check that the lights are where you think they should be, and
their general dimensions are accurate.

a. Save it to your PC.

NOTE: If you have lights at multiple heights, do not click Finish
on the Scan Processing Tools toolbar.

b. Click Save on Robot, then select the IP address of either the AMR or the Fleet
Manager, if your AMR is part of a fleet.

3. If you are not satisfied with how the lights appeared on the map, click Config on the
Scan Processing Tools toolbar to open the configuration dialog box. This gives you
access to the Light Analysis parameters, which you can change as needed:

l 3d:MinLightHeight

l 3d:MaxLightHeight

l 3d:MaxLightLength

l 3d:DrawingMaxSize

In the preceding image, the light length was 2.5 meters, so the default light length of 2
meters was too restrictive and needed to be changed.

Lights at Multiple Heights

The scan contains the necessary data for all of the lights in the environment. When you create
a map from the scan, you specify a height range for the lights you want included in that map.
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If your environment has lights at multiple heights, you will need to create multiple maps from
your one scan, using different light heights. You will then insert the appropriate map sections
into the initial map, which will add the lights from the adjusted light height range. This needs
to be done for as many different light heights as you have in the environment.

Creating a Revised Map

These steps are performed after saving the initial map, which included lights within the initial
height range you specified.

NOTE: Do not click Finish on the Scan Processing Tools toolbar.

1. Click Config and change the 3d:MinLightHeight and 3d:MaxLightHeight parameters to
bound the next light height in your environment.

2. Click Apply, and say Yes to the pop-up.

Applying the changes will cause only the light map to reprocess.

3. If you are satisfied with the appearance of the lights in this height range, save the new
map with a different file name.

NOTE: Check that the lights are where you think they should be, and
their general dimensions are accurate.

4. Repeat these steps for as many different light heights as are needed.

Inserting a Map

1. Open the initial map file.

2. Select File > Insert Map.

3. Select the map file you want to insert.

Figure 9-35. Selecting a Map File to Insert
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Figure 9-36. Inserted Map

4. Click and drag the purple highlighted map to line it up with the initial map.

a. Try to get the features of the two maps close, dragging the purple insert.

b. Zoom in very close. You should be able to align the two laser maps perfectly, as
they are identical maps with only differences in the lights.
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Figure 9-37. Zoomed-in Insert Map

c. Click Insert to complete the insertion.

5. Zoom back out and use the Region Tool, from the Insert Map Tools toolbar, to click and
drag a rectangular region that includes the lights you want inserted.

Figure 9-38. Region Tool

6. Click the dropdown arrow next to the Insert button on the Insert Map Tools toolbar and
click Advanced.

This will open the Advanced Insert dialog box.

7. Click Clear All, then select just the Light check box in the Advanced Areas section.

8. In Advanced Options, check the boxes:

l Include user-created map items, i.e. non-data types

l Retain overlapping items of the same type in the containing map

NOTE: If lights of different types are physically behind one another in the
environment it may be necessary to scan that space twice, once with just
each light type exclusively. This means that you would have to turn off
lights at one height, then scan, and repeat with only the other lights
turned on.
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Figure 9-39. Advanced Insert

9. Click Insert on the Advanced Insert Dialog box and save your changes.

10. Repeat the steps in this section for all other map areas with different light heights.

11. If you are satisfied with the map:

a. Save it to your PC.

NOTE: If you have lights at multiple heights, do not click Finish
on the Scan Processing Tools toolbar.

b. Click Save on Robot, then select the IP address of either the AMR or the Fleet
Manager, if your AMR is part of a fleet.

NOTE: After mapping DO NOT manually move, resize, reorient, or otherwise
modify the light items on the map. If lights did not turn out as expected, some
combination of parameter changes should allow reprocessing of the scan in
order to achieve better results.

Localizing Manually

It is very important to localize the AMR well by hand when starting it on a new map for the
first time, or re-localizing if it became lost. It is possible to offset the AMR up/down or left/right
by a row of lights. This will cause the AMR to think it is one row of lights from where it really
is, so it will not be able to drive to goals, and might drive into forbidden zones.

NOTE: Even with laser localization disabled, the laser stays active for obstacle
avoidance, so the AMR will not run into physical objects.
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After the initial localization, the AMR will continuously verify and adjust its position on the
map as it moves through the environment.

Interpreting Light Objects on the Map

Lights are represented by light blue rectangles. If lights do not appear on the map, enable their
display by using the Map > Map Data > Light Items menu item in MobilePlanner.

From Map > Robot Data > Other Robot Data,

l LightMatch compares the lights that an AMR has detected with its camera to the lights
on the map. Light matches are displayed in green.

l LightMisses shows lights that are seen by the camera and meet the criteria for a proper
light, but which do not match a known light on the map. Light misses are displayed in
magenta.

l Lights3d displays all lights in red, regardless of their match or miss status. Generally
this is left off to prevent cluttering the display.

Camera Specifications

Feature Specification

Field of View 140°

Power Input 12 VDC (±10%) supplied from platform,
through power connector

Power Consumption 3.3 W maximum

9.9 Side Lasers

NOTE: There are two types of side laser installations. One is attaching them dir-
ectly to the user-designed payload, which is what this chapter covers.

Side lasers can be added to an AMR to provide additional obstacle detection. The OS32C laser
scans at 190 mm (7.48 in.) from the floor. Any obstacle that does not cross that plane will not
be seen. Side Lasers scan in a vertical plane near the path of the robot, allowing the AMR to
detect obstacles at other heights that the AMR must avoid. These are available as an option for
users building their own payload structures.

Positive Obstacles
Positive obstacles are those which would block the robot’s path, such as tables and desks.
Detecting positive obstacles is the primary and recommended use for Side Lasers.

Negative Obstacles
Negative obstacles are voids in the driving area of the robot, such as downward stairs, loading
docks, or missing floor tiles.

Negative obstacle detection with Side Lasers should not be used as the primary method for
avoiding negative obstacles. It is intended to be used as a secondary method of detection, with
the primary method being traditional safety techniques to aid avoiding negative obstacles.
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Primary methods include blocking off areas with missing floor tiles, staging safety equipment
near areas missing floor tiles, and restricting traffic to dangerous areas.

Negative obstacle detection on the robot is implemented in software only and does not consist
of CAT 3/PLd safety lasers. A test plan should be developed and executed prior to adding new
functionality to equipment that currently exists in a production environment. Perform testing
with each specific application and configuration to ensure the robot’s safety. Test detection
after changing parameters for each different expected obstacle. With customer payloads and
laser positioning, dynamic testing must be done for each design at field application speed to
ensure robot safety.

Installation

Use the following information on installing Side Lasers.

Components

The Side Lasers come as a kit with the following components:

l 2x lasers

l 2x laser guards

l Wiring harness

l Assembly kit, with mounting plate

See the following image for an example of the parts provided in this kit.

Mounting Stud

Mounting Plate

Mounting Screw

Laser scanner
Laser Guard

Figure 9-40. Side Laser assembly

The side laser kit is P/N 13456-100, and can be added to existing payload structures.

Mounting
Side lasers need to be mounted on your AMR payload structure, one on each side. Because of
the wide potential for differently shaped and sized payloads, users must install the side laser
assembly at locations of their discretion.
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When mounting the Side Lasers, care must be given to ensure that the mounting location and
angle is appropriate for proper functionality. Considerations to cable routing should be made
when positioning the assembly to prevent chafing, binding, or other cable strain. Clearance for
the laser guard provided with the kit should also be considered when choosing a mounting
location. It is recommended to mount the side lasers at a position that prevents detection of
any part of the AMR or the payload structure. Care must also be taken that the laser is ori-
ented properly, to ensure correct operation. The side lasers must be mounted in an orientation
so that their scanning planes are vertical and parallel to the AMR's axis. Do not aim the front
of the side laser towards the ceiling or floor to avoid false object detection.

NOTE: In situations where mounting the side lasers in an unorthodox way in
unavoidable, blind spots can be configured in the scanning area to prevent false
object detection.

IMPORTANT: Power OFF the AMR and complete appropriate Lock-out, Tag-out
procedures prior to installing or relocating side lasers.

Tools Required

Listed below are the tools required for mounting the side laser assembly to a payload.

l Laser assembly kit
l 3.3 mm drill bit
l 3 mm hex key

Dimensions

The dimensions for the side laser assembly are provided below:

 110 

Figure 9-41. Side laser assembly rear dimensions (units in mm)
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Figure 9-42. Side laser assembly top view dimensions (units in mm)

 53 

 57 

 119 

Figure 9-43. Side laser assembly side view dimensions (units in mm)

Procedure
1. At the planned location for mounting, create holes for an M4 screw spaced at the proper dis-
tance for the mounting plate provided with the laser assembly.

2. Create holes of the same size for the laser guard to be installed, making sure to position the
holes such that the laser guard can be installed over the laser without obstructing the sensing
area.

3. Install the laser using the provided M4 hex screws, applying a torque of 1.0 N-m.

4. Install the laser guard over the laser using the provided M4 screws, applying a torque of 1.0
N-m.

Connections

The harness should be connected after the physical mounting procedure is completed.
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The lasers connect to the Aux Sensor connector located on the upper front of the platform core
using the supplied W-cable. This allows you to use one port for both side lasers and the low
front laser.

Configuration
The parameters for the side lasers are set using the MobilePlanner software.

The first set of parameters are in:

Robot Physical > Laser_3 and Robot Physical > Laser_4.

Configuring the side lasers is generally performed by importing the factory-supplied con-
figuration into the AMR’s current configuration. Contact your local Omron Support for assist-
ance.

For Laser_3 (right) and Laser_4 (left), the relevant parameters are:

l LaserAutoConnect: Should be checked to turn on the laser.

This parameter will not be shown unless Show Expert + Parameters is checked.

This tells the system that the laser exists, and should be connected at startup.

The other parameters will be hidden unless this parameter is checked.

l LaserX, LaserY, LaserZ: The location of the laser on the robot.

Measure to the sensing plane of each laser, which is about 20 mm from the top of the
sensor housing.

o LaserX is mm, front-back, of the laser center from the robot’s idealized center of
rotation.

o LaserY is mm, left-right, of the laser center from the robot’s idealized center of
rotation.

o LaserZ is mm, from the floor to the center of the laser.

l LaserIgnore: By default, the sensor scans an area of 270 degrees.

This area should be modified so that the laser does not sense parts of the AMR. Zones
entered here will be excluded from the search area.
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A

Figure 9-44. Left Side Laser (Laser 4), (A) This Laser is Flipped Upside-Down

The format for the angles is startangle1: stopangle1, startangle2: stopangle2, etc.

Readings inside these angles will be ignored.

An example would be

-20:-180,45:180

l LaserFlipped: For the laser on the left side of the robot, check the box.

This says the laser is upside-down, so the readings are interpreted correctly.

l LaserType: Set this value to tim3XX unless otherwise requested.

l LaserPortType: Set to serial when using the Aux Sensor connector.

l LaserPort: The ports available on the Aux Sensor connector are /dev/ttyUSB5 and
/dev/ttyUSB6. Assure that the correct port is designated by the sensor’s X,Y,Z position.
The wiring harness is labeled so that /dev/ttyUSB6 is connected to the left laser.

l LaserPowerOutput: Set to Vertical_Laser_Power.

l LaserIsTilted: Designates that the lasers are side-mounted and will scan vertically.
Check the box.

The parameter LaserIsTiltedNegativeSensor should be disabled if this is checked.

Figure 9-45. MobilePlanner Side Laser Parameters
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In MobilePlanner, navigate to Robot Operation > Laser_3 and _4 Tilted. This portion of the con-
figuration allows the laser to be configured for the application’s specific environment.

In select cases, you will need to modify the Cumulative parameters. Sensor readings are often
held on the map so that the robot remembers an obstacle even when it cannot be actively seen.
The length of time that the robot will remember these readings is
MaxSecondstoKeepCumlative. In dynamic environments where the robot will be encountering
many obstacles, but many open paths for the robot exist, this value should be about five
seconds. If your environment has a restricted number of possible robot paths, this number
should stay relatively large, such as thirty seconds, so that the robot does not rediscover the
same obstacle multiple times. Contact your local Omron Support if you have difficulty tuning
these parameters for your environment.

Figure 9-46. MobilePlanner Cumulative Parameters

After each side laser is configured, ensure that the laser designated to be on the left side is
physically mounted on the left side of the robot. The easiest way to do this is to turn off one of
the lasers using the LaserAutoConnect parameter and watch the laser readings in MobilePlan-
ner. In the image below you can see that the enabled side laser is showing readings on the left
side of the robot.

Figure 9-47. Checking the Left Side Laser
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9.10 Touchscreen
The touchscreen provides a means for Operators to interact with an AMR wherever the AMR
is. This can be used by the Operator to:

l check the status of the AMR

l enter the next goals for the AMR

l pause or release the AMR

In some systems, the touchscreen will come incorporated as part of an AMR, so there will be
no installation required by the user. You may still need to configure its behavior with Con-
figuration on page 210, and the Operation section will still apply.

The touchscreen is also offered as a standalone product, for users who want to incorporate the
touchscreen into their own platform-based AMR.

Installation

Components

The standalone touchscreen kit includes:

l Touchscreen with attached bracket

l Power supply (DC/DC converter) with bracket

l Power cable, from core to power supply

l Power cable, from power supply to touchscreen

l Ethernet cable, between touchscreen and core

l Gasket, between touchscreen and AMR mounting surface

This protects the touchscreen from vibrations of the AMR.

l Spacers, to prevent the touchscreen from being pressed too hard into the gasket

l FLOW Core software

Software Installation

The FLOW Core software includes support for the touchscreen. This software needs to be
installed before any of the steps in Configuration are performed.

When you purchase an Omron Robotics and Safety Technologies AMR, this software suite will
be pre-loaded on it. It can be updated using the SetNetGo OS.

Mounting

If the touchscreen isn’t pre-installed, the placement of the touchscreen on the AMR is up to the
customer. In most cases it will be placed near the top of the payload structure, so an Operator
will have easy access to it. The touchscreen has a bracket, with four mounting holes. The
dimensions are shown in the following figure.
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NOTE: The touchscreen electronics need to be protected, so the mounting sur-
face needs a cutout that will accept the touchscreen. Do not surface-mount.

!
CAUTION: The touchscreen glass is fragile. Take care not to flex the touch-
screen in any way, and to protect the screen from impact.

Mounting Surface Cutout

The mounting surface for the touchscreen needs a cutout large enough for the screen to be
viewed. The four mounting points can either be thru holes, in which case the mounting bolts
will be visible from the outside of the AMR, or you can weld standoffs to the inside of the
mounting surface, to conceal the mounting hardware.

!
CAUTION: The touchscreen is not centered, horizontally, in the bracket it
comes with. If you are installing the touchscreen yourself, you will need to
account for this, or there will be a small gap at the right side of the screen. See
the following figures.
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Figure 9-48. Mounting Dimensions for the Touchscreen, (A) Through Hole (units are mm )
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Figure 9-49. Front of touchscreen with Bracket

Standoffs/Spacers

Standoffs or spacers need to be used between the mounting bracket and the inside surface of
the payload structure, where the touchscreen is being mounted. You can either use the sup-
plied spacers and thru-holes to mount the screen, or you can weld user-supplied standoffs to
the inside of the payload structure surface, in which case the screw heads would not be visible
from the outside.

!
WARNING: Use standoffs or spacers to prevent pressing the touchscreen too
hard against the mounting surface. Excess pressure can cause delayed, incor-
rect, or no response when the touchscreen is touched, or possibly break the
screen’s glass. The standoffs ensure that the gasket is compressed, but the
touchscreen is not stressed. See the following figure.
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Figure 9-50. Standoffs/Spacers for Mounting the touchscreen (Welded Shown) (units are mm )

Key Meaning Key Meaning

A Top View E Optional Through Hole for Mounting from the
Front

B Mounting Screws F Thick Foam Tape Gasket around Inside of Panel
Opening

C Standoff G Recommended touchscreen Mounting

D Threaded Standoff on Inside of
Panel

H Front View

1. Install the gasket between the touchscreen and the inside of the payload structure sur-
face.

Line up the gasket with the hole in the payload structure surface, so the gasket aligns
with the screen cutout.

2. Attach the touchscreen to the inside surface of the payload structure.

If the mounting standoffs are welded to the inside of the payload structure, use four M4
x 8 mm (0.31 in.) screws to attach the touchscreen bracket. Use a threadlocker, such as
Loctite 222.

If you are using thru holes, you will have to determine the length of bolt needed to go
through the mounting surface, spacer, bracket, and into the nut. Use either nylock nuts
or a threadlocker, such as Loctite 222. Unthreaded spacers are provided for this method
of mounting.

3. Mount the power supply bracket to existing holes in the top of the platform (payload
bay).

Two holes in the bracket secure the bracket to the platform, two other holes in the
bracket line up with holes in the power supply.

See the following figure.



Chapter 9: Options

 2 x Ø 5.51 

 0 

 2 x 16

 2 x 21.01 

 2 x 26.01 

 2 x 30.99

 2 x 61.47 

 53.29 

 0 
 7.65 

 2 x 9.65 

 14.63 

 83.01

 90.65 

 2 x 92.71 

 97.64 

 2 x Ø 3.99 

 0 

 2 x 15.29 

 2 x 16.26 

 21.29  

 0 
 5 

11.25 

 

77.75 

 77.98 

Figure 9-51. Power Supply Mounting Bracket Dimensions (units are mm )

Connections

These connections should be made after the mounting procedure is completed.

1. Connect the 5 VDC power cord from the power supply to the touchscreen.

2. Connect an Ethernet cable between the platform core, User LAN port, and the left Eth-
ernet port on the touchscreen. See the following figure.

3. The touchscreen DC-DC converter connects to the 6 pin user power port on the LD Core.

7.6
7.6

20 20

A

B C

Figure 9-52. Connections on the Touchscreen (units are mm )

Key Meaning Key Meaning

A Power C Do Not Use

B Ethernet to User LAN on Core
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Setup

NOTE: After making and saving changes within User LAN Ethernet Settings,
the robot has to be power-cycled for those changes to take effect. If the only
change is to enable DHCP, then the robot does not have to be power-cycled.

In the MobilePlanner software, select:

MobilePlanner > SetNetGo

Network > User LAN Ethernet

Ensure that:

l the IP address subnet doesn’t conflict with the Wireless Ethernet IP subnet

l Interface mode is set to Accessory

l DHCP Server for Accessories is set to Enable

l DHCP IP Range is large enough to provide IP addresses for all connected devices

Figure 9-53. Accessory and DHCP Server for Accessories Enabled

Configuration

You configure the touchscreen's appearance and behavior with the MobilePlanner software.
The tasks include what mode is used, setting up goals for relocalization, and specifying a cus-
tom screen logo and the language to be used for the display.

Operating Modes

Specify the touchscreen mode: either Choose Dropoff or Patrol Route.

l Choose Dropoff mode allows the Operator to input the next dropoff goals.

l Patrol Route mode simply drives around a specific route. The AMR will have goals that
it stops at, but the Operator will not be able to alter the order of those goals.

For Choose Dropoff, you specify how many dropoff buttons there will be, and how each button
is labeled, as well as the goal on the AMR's map that gets associated with each button.
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For Patrol Route, you specify the name of the route and whether to start the patrol on bootup.
The route will include whatever goals the AMR will stop at, and how long it will wait at each
specific goal.

These parameters are accessed from:

MobilePlanner > Config, then Robot Interface > Touchscreen

Select either Choose Dropoff or Patrol Route with the Pages > MainPage parameter, which has
a dropdown selection box.

Choose Dropoff Mode

The following parameters only apply to the Choose Dropoff mode.

Dropoff Priority

This is accessed under Pages > ChooseDropoffPage.

You can enable high-priority dropoffs, which will be serviced before normal-priority dropoffs.
The Operator can specify that a goal is high-priority when it is being selected for the upcoming
dropoff.

AllowHighPriorityDropoffs

This allows some dropoffs to be specified as high-priority. This is enabled by
default, and you can disable or re-enable it in the MobilePlanner software.

HighDropoffPriority

This is the priority assigned to any dropoff that is specified as high-priority.
Higher priority jobs will be serviced before lower-priority jobs by the queuing
manager. This has no effect if AllowHighPriorityDropoffs is disabled.

Dropoff Buttons

This is accessed under Pages > ChooseDropoffPage.

DropoffButtonCount

This specifies the total number of buttons that will be available on the touch-
screen page. You can scroll the page to see other buttons, if all of the buttons can-
not be displayed at once.

DropoffButtonx

There will be a DropoffButton1 through DropoffButtonx, where x = DropoffBut-
tonCount. Each contains the two following parameters:

GoalName

This is a combo box that lists all of the goals that have been created
on the map. Select the map goal to be serviced when this dropoff
button is pressed.

NOTE: A goal can have a wait time associated with
it, to give an Operator time to load or unload the
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AMR. This is configured, in the map, using the
MobilePlanner software.

You can eliminate a button from the screen by making GoalName
blank. The other buttons will fill in, so there will be no blank spaces
in the screen.

ButtonLabel

This is the text label or icon displayed on the dropoff button. If
empty, the GoalName is displayed.

Patrol Route Mode

The following parameters only apply to the Patrol Route mode.

In this mode you need to specify the name of the Patrol Route that the AMR will patrol. The
route needs to have already been set up using the MobilePlanner software. You also need to
specify if the AMR will start its patrol automatically, or if it requires an Operator to press Go.

Select Pages > PatrolRoutePage

l In RouteName, enter the route to be patrolled.

l Check AutoStartRoute for the AMR to start its patrol as soon as the Patrol Route screen
is displayed (the AMR has finished booting).

Localization Goals

You need to configure at least one localization goal. You can configure more if you want. A loc-
alization goal is needed to relocalize a lost robot from the touchscreen.

Each localization goal should have:

l a heading

The AMR will need to be aligned with the heading when relocalizing.

This applies to both laser and Acuity Localization.

l mapped features that don’t change much

Things that get moved frequently, such as pallets, chairs, or carts do not make good
mapped features, because the map will not match what the AMR is seeing.

l mapped features that don’t get blocked

If a mapped wall is often used for stacking boxes or storing carts, the AMR may have
trouble seeing the wall behind those objects.

l multiple visible lights, when using Acuity Localization

The more lights the AMR can see, the better.

l a high localization score

This represents the percent of readings that the AMR currently sees that match the fea-
tures on its map.
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NOTE: Localization goals do not have to be dedicated to localization - they can
also be used as normal goals for regular use.

In MobilePlanner, select:

Config > Robot Interface > Touchscreen

From there, use ChooseLocalizationPage to set LocalizationButtonCount to the number of loc-
alization goals you want, and then specify the GoalName and ButtonLabel for each.

Figure 9-54. Localization Goal Parameters

Screen Logo

In MobilePlanner, select

Config > Robot Interface > Touchscreen

From there, use Style/Appearance.

A logo is displayed in the upper-left corner of the touchscreen. The default logo is Omron , as
shown in the following figure.
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Figure 9-55. Sample Touchscreen, with Logo, in Choose Dropoff Mode

You can customize this with a logo of your choosing using the following steps:

1. Upload a PNG image file to the AMR using the MobilePlanner software:

File > Download/Upload

2. Open the AMR Configuration window and choose:

Robot Interface > Touchscreen

3. Edit the SmallLogo parameter.

a. Click the file-select button to open the file chooser.

b. Select the newly-uploaded file.

c. Click Open.

4. Click Save, to save the configuration.

NOTE: If the SmallLogo field is left blank, the default Omron logo will be dis-
played.

NOTE: If a different version of the same file name is uploaded to the AMR, you
will need to power cycle the AMR to see the change.
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Contact Information

Omron Robotics and Safety Technologies, Inc.

4225 Hacienda Dr

 Pleasanton, CA 94588

Tel: (925) 245-3400

https://www.ia.omron.com/

Figure 9-56. Help Screen, with Contact Information

Help shows information on the installed software and contact information.

NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software.

In MobilePlanner > Config:

l Robot Interface > Touchscreen > ContactInformation

l Check the ShowContactPage check box.

l Enter appropriate information in ContactName and the fields following it.

Setting Screensaver

In MobilePlanner, select

Config > Robot Interface > Touchscreen

From there, use Screensaver.

If the AMR is in motion when the screensaver comes on, it will use the Busy icon, and display
a status message (where it’s going). If the AMR is not in motion, it will display the Available
icon. The rounded rectangle, icon, and any text inside the rectangle will move around the
touchscreen display area.
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Screensaver Enabled

This is a checkbox that determines whether a screensaver is displayed when the touchscreen is
inactive. Checking the box enables the screensaver.

TimeoutSeconds

This is the number of seconds that will elapse before the screensaver is turned on. This has no
effect if the Screensaver Enabled box is not checked. The range is 1 - 999 seconds.

StayOnTouch

This is a checkbox that determines if touching the screensaver has the same effect as touching
Stay. If this is checked, the robot will stay when the screensaver is touched.

Setting Display Language

You can select what language is used for the display from a dropdown box in the MobilePlan-
ner software.

NOTE: Some messages from the AMR will be in English, regardless of the lan-
guage set here. These include status and mode messages.

From MobilePlanner, select:

Config > Robot Interface > Language/Location

Select RobotLanguage, which has a dropdown selection box.

This parameter is not touchscreen-specific, so it may affect other displays that involve written
language. As of this writing, only the touchscreen is affected. This parameter does not affect
synthesized speech.

Operation

Screen Initialization

When first powered up, the bottom of the touchscreen will display its boot status.

1. Initializing robot core connection...

NOTE: This may take a minute or two to initialize.

2. Initializing touchscreen software...

3. Connecting to the robot core...

4. Downloading data from the robot core...
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Figure 9-57. Screen Initialization Status Display

After initialization, either the Choose Dropoff or Patrol Route screen will be displayed.

Screen Top Bar

The top of the screen shows basic AMR information. This includes a bar graph indicating the
WiFi signal strength, the name of the AMR, and the battery state of charge. If the AMR is con-
nected to an Fleet Manager, it will also be specified here.

Left Screen Pane

The screen logo is displayed in the upper part of the left pane. This doesn’t change, regardless
of the mode you are in.

Below the screen logo, the AMR status is displayed, first graphically, and below that, in text.

Figure 9-58. Screenshot Showing Top Bar and Left, Right, and Center Panes
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Figure 9-59. AMR Status Icons

NOTE: The Busy icon may also include an arrow pointing down, indicating a
pickup, an arrow pointing up, indicating it is doing a dropoff, or an exclamation
mark, indicating an alert condition. Figure 9-55. shows a dropoff.

The bottom of the left side of the touchscreen provides a Stay button, to delay the departure of
the AMR, and a count-down timer, indicating when the AMR will depart.

Each press of the Stay button adds 1 minute to the time the AMR will wait before continuing
to its next goal.

l If you press Stay while the AMR is stopped, it will add 1 minute to the time the AMR is
scheduled to wait before continuing to its next goal.

l If you press Stay while the AMR is moving, it will stop, and stay for 1 minute.

NOTE: The Stay count-down timer can be zeroed at any time by pressing Go at
the bottom of the center pane.

The screensaver can be set up to behave the same way the Stay button does, so that pressing
the screensaver adds 1 minute to the time the AMR will wait.

Right Screen Pane

The right side of the touchscreen displays Home, Dropoffs, Status, and Help tabs. Pressing one
of these tabs changes the context of the center pane.

The Dropoffs tab is not displayed in Patrol Route mode.

l The Home tab is used to switch the center pane to show the AMR’s current mission. If
an error condition exists, such as the AMR overheating or being lost, the software will
automatically select the Home tab. See the following figure.
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Figure 9-60. Payload Alert, Displayed from the Home Tab

The preceding screen will not be displayed unless the robot configuration has been set
up in the MobilePlanner software:

Config > Robot Physical > Payload > NumSlots

This must be set to a positive value, i.e. the number of payload slots.

Config > Robot Interface > Payload Present Messages and Behavior

l The AlertWhenPayloadNeededForDropoff must be checked.

l The PayloadNeededForDropoffShortDescription must have a value. In this case,
the value is “Payload Needed”, which is displayed in the screen’s left pane.

l The PayloadNeededForDropoffLongDescription must have a value. In this case,
the value is “The robot has a destination but does not have a payload. Please
load an item or cancel the dropoff.” This will be displayed in the screen’s center
pane.

NOTE: The payload parameter section will not be displayed
unless the payload slots at the top of the Payload Present Messages
and Behavior are set to a non-zero value.

The Home screen also has an entry for relocalizing a lost robot from the touchscreen.

When you select Home from the right pane tabs (rather than when the software
switches to Home), the center pane will display information about the robot's current
mission, such as the job details or the current route task.

l Dropoffs (Choose Dropoff mode only) shows the available goals, giving the Operator the
ability to choose the next goals, and shows the status of the robot with respect to the
goals it has been assigned.

In Patrol mode, this option isn’t displayed.
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l After pressing the Status tab, you will be given a choice of either Alerts, Robot, I/O, or
Peripherals (which accesses screen-cleaning mode).

The number of alert messages that are available for viewing is indicated by a number in
a red circle on the Status button. See the preceding figure.

Figure 9-61. Status Tab and Sub-menu

o Alerts shows an abbreviated list of all active alert messages.

Touching on a specific message will display that full message.

o Robot shows robot status, such as the IP address, what it is currently doing, and
its mode.

Position Details, within the Robot Status screen, shows the robot’s position, head-
ing, velocity, and localization score.

o I/O will display any of the Core Digital Inputs / Outputs that have been con-
figured as a “custom” type.
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Figure 9-62. Status > I/O Screen (Top Inputs are not shown in this example)

o Peripherals > Touchscreen allows you to lock the touchscreen, so that you can
clean the screen without it interpreting that as input. The screen stays locked for
one minute, and then returns to normal function.

l Help shows information on the installed software and contact information.

NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software.

Omron Robotics and Safety Technologies, Inc.

4225 Hacienda Dr

 Pleasanton, CA 94588

Tel: (925) 245-3400

https://www.ia.omron.com/

Figure 9-63. Help > Contact Information

Help also provides access the Replay Recorder page, which lets you record data for later play-
back (generally used for troubleshooting).

Replay Recorder

The replay recorder will record data for troubleshooting. Once the start page is opened, you
just click Start. When you are done recording, click Stop. The Duration and Replay File fields
are filled in by the recorder.

After the recording is completed, you will need to use the MobilePlanner software to download
the file generated.
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Figure 9-64. Replay Recorder Start Page

Figure 9-65. Replay Recorder, After Clicking Stop

Center Pane

The content of the center pane changes depending on what has been selected from the right
pane. The bottom of the center pane will almost always have a Go button, to zero the Stay
count-down timer, and tell the AMR to proceed to its next goal.
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Relocalization

The touchscreen gives you a way to relocalize the AMR if it becomes lost. Before you can do
that, you need to have set up at least one localization goal, with a heading, at which the AMR
can localize. You can set up multiple such goals, if you like. See Localization Goals on page
212.

If the AMR becomes lost, the touchscreen will automatically select the Home tab (from the
right pane), and display a message indicating that the AMR is lost. It will also offer an option
to Recover.

1. Press Recover.

2. Follow the on-screen instructions.

You will be instructed to manually move the AMR to a localization goal, and then tell
the software which goal you moved the AMR to.

Dropoffs (Choose Dropoff Mode only)

In this mode, the touchscreen communicates with the queuing manager, which then com-
municates with the AMR.

NOTE: Until the queuing manager has been enabled, the touchscreen will not
display any of the dropoff goal buttons. Refer to the FLOW Core User's Guide (Cat.
No. I637).

In this mode, the center of the screen displays touch-sensitive dropoff buttons, indicating the
goals associated with them. If there are more buttons than can be displayed at once, a sliver of
the next row of buttons is shown, to indicate their existence. See Figure 9-55.

Navigation of the center pane, when there are more buttons than can be displayed at one time,
is done by touching the screen, between buttons, and dragging the pane up or down.

The color and border of a dropoff button indicate the status of the associated job.

l Ready (not selected) will be medium blue, with no border.

l Planned (selected, Go has not been pressed) will be dark blue, with no border.

At this stage, you can de-select the goal or change its priority.

l Requested (brief state between Go being pressed and job being scheduled by the queuing
manager) will have the same appearance as Planned.

At this stage, the selected dropoff goals have been sent to the queuing manager. The
goal can be canceled, and the priority can be changed.

l Pending (scheduled by the queuing manager) will be dark blue with a medium blue bor-
der.

At this stage, the job for this goal can be canceled, and the job priority can be changed.

l In Progress (AMR is en route to this goal) will be dark blue with a green border.

At this stage, the job for this goal can be canceled, but the priority cannot be changed.

l Interrupted (such as Stay being pressed or a fault occurring) will be dark blue with an
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orange border.

At this stage, the job for this goal can be canceled, but the priority cannot be changed.

l Completed or Canceled dropoff buttons will revert to Ready status.

Operators can use this pane for entering the goals where they want the AMR to go for
dropoffs, after leaving its current location.

Pressing a dropoff button and then Go requests that the AMR be sent to that goal. Pressing sev-
eral buttons in sequence, followed by pressing Go, requests that the AMR be sent to all of those
goals, in the order in which the dropoff buttons were pressed. The order may be altered by
assigning high-priority to any of the goals.

The number of buttons, the content of each button, and the goal associated with each button is
configured with the MobilePlanner software.

l Goals will be serviced by the AMR in the order in which you press their buttons.

l The selected dropoff goals are not sent to the queuing manager until you press Go. After
being received by the queuing manager, each goal is considered to be a job.

l Pressing a Planned (selected) dropoff button will de-select it, without affecting other
Planned dropoff buttons.

Simply pressing a Pending or In-Progress goal button will not affect the associated job.
An explicit Cancel is required to cancel a job in either of those states.

l Buttons will change appearance when you select/de-select them, change their priority,
when the job is received by the queuing manager, when an AMR is on its way to the
button's goal, and when the job is completed (and AMR dismissed).

Cancel Request (X)

When a dropoff button has a blue or green border, meaning its job is Pending or In Progress,
the Operator can touch the button and a Cancel pop-up button (X) will be displayed on the but-
ton. Touching that pop-up will cancel the job for that goal. This does not affect any other jobs.
See Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups on page 225.

High Priority (!)

If you touch-and-hold the dropoff button for a goal that is planned or requested, or simply
touch the button for a job that is pending, a High-Priority pop-up button (!) is displayed. Touch-
ing this pop-up will toggle the priority for the goal or job between high and normal priority.
See the following graphic.

When a job is assigned high priority, its dropoff button will display a visible high-priority
indicator (!). A high-priority job will be serviced before all normal-priority jobs, even if those
jobs were entered at an earlier time.

This means that if you press Goal1, then Goal2+HighPriority, then Goal3, they will be serviced
in this order: Goal2, Goal1, Goal3.

If you de-select a high-priority dropoff button, and then re-select it, it will appear as normal pri-
ority (the high-priority flag is not persistent).

NOTE: Changing a high-priority dropoff button or job to normal priority will
move that button or job to the end of the queue, so it will be serviced last.



Chapter 9: Options

Figure 9-66. Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups

Figure 9-67. Touchscreen Dropoff Goals Page, with Stay and Count-down Timer

Stay Button

If the AMR is en route to a goal when Stay is pressed, that goal’s button will turn dark blue
with an orange border.

If the AMR has entered a wait task associated with a goal or job, pressing Stay merely extends
that wait, and the button border stays green. (The job isn’t interrupted from the queuing man-
ager’s perspective, the wait task has just been prolonged.)
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Go Button

The bottom of the center pane, in Dropoffs and user-selected Home mode, is a Go button. This
zeroes the countdown timer, and causes the AMR to immediately proceed to its next goal. This
can be used in conjunction with the Stay button to pause the AMR, and give the Operator
more time to load or unload the payload.

Patrol Route Mode

The AMR does not communicate with the queuing manager in this mode.

Figure 9-68. Touchscreen, Patrol Route Page, in Stay Mode

Specifications

Touchscreen

Feature Specification

Touch Panel PCAP touch sensor, 5 simultaneous touches, black bordered cover lens

TFT Display TFT LCD panel, 18/24 bit RGB parallel interface.

7.0 in. WVGA -Wide Viewing Angles, 5-Touch

Backlight Constant current LED supply

Power Input 5 VDC supplied through power connector

Power
Consumption

6.5 W maximum

Operating
Temperature

0° to 60° C
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Power Supply

MeanWell SD-15B-05

15 W, 18-36 V input, 5 V output

Output DC Voltage 5 V

Rated Current 3 A

Current Range 0 - 3 A

Rated Power 15 W

Voltage Adj. Range 4.75 - 5.5 VDC

Voltage Tolerance ± 2.0%

Input Voltage Range 18 - 36 VCD

DC Current (Typ.) 1.9 A/12 VDC

Protection Overload 105 - 160% rated output power

Over-Voltage 5.75 - 6.75 V

Environment Working Temp. -10° to +60° C

Working Humidity 20 - 90% non-condensing

Storage Temp. -20° to +85° C

Storage Humidity 10 - 95% non-condensing
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10.1 Dimension Drawings

B

A

500

50

190

379 383

699

Figure 10-1. Platform Top, Side, and Front Dimensions Showing, (A) Top of Covers, and (B) Mounting
Surface (units are in mm )

NOTE: Refer also to Figure 5-2. and Figure 5-3. for mounting hole dimensions
for the payload structure.
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Figure 10-2. Docking Station Dimensions for, (A) Wall/Floor Mounts, (B) Free Standing, and (C) Wall
Mount Bracket (units are in mm )

10.2 Platform Specifications

Physical

Description Specification

Length 699 mm

Width 500 mm

Height (body) 383 mm

Body clearance 50 mm

Weight (with battery) 62 kg
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Description Specification

Rating

IP Rating IP20

Cleanroom rating Fed Class 100, ISO Class 5

Pendant IP rating IP56
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Description Specification

Drive Train

Drive wheels 2 grey non-marking foam-filled rubber

Wheel dimensions 200 x 50 mm nominal

Passive Casters 2 front, 2 rear, spring-loaded

Caster diameter 75 mm nominal

Brakes 2 (one each axle)

Steering Differential

Performance

Description Specification

Performance

Max payload – level LD-60: 60 kg
LD-90: 90 kg

Swing radius 354 mm

Turn radius 0 mm

Translational speed, max LD-60: 1800 mm/s
LD-90: 1350 mm/s

Rotational speed, max LD-60: 180°/s
LD-90: 180°/s

Stop position repeat-
ability (Single robot)

l To a position: ±65 mm position

l To standard target: ±25 mm position, ± 2°
rotation

l With HAPS: ±8 mm position, ±0.4° rotation

l With CAPS: ±8 mm position, ±0.5° rotation

Stop position repeat-
ability (Fleet)

l To a position: ±85 mm position

l To standard target: ±35 mm position, ± 2°
rotation

l With HAPS: ±10 mm position, ±0.5° rota-
tion

l With CAPS: ±12 mm position, ±0.5° rotation

Traversable step, max LD-60: 15 mm
LD-90: 10 mm

NOTE: A speed of 250 -300 mm/s for the LD-60 and 250 mm/s
for the LD-90 is required for these steps. Faster or frequent
driving over such steps or gaps will shorten the lifespan of the
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Description Specification

drivetrain components. Lower speedsmay not traverse the step.
Steps should have smooth, rounded profiles.

Traversable gap, max LD-60 and LD-90: 15 mm

Climb grade, 60 kgmax 1:12

Traversable terrain Generally wheelchair accessible

Minimum floor flatness FF25 (based on the ACI 117 standard)

NOTE: ACI 117 is the American Concrete Institute’s standard for
concrete floors. FF is flatness, FL is the level. Higher FF numbers
represent flatter floors. FF 25 is a fairly lenient specification.

Battery

Run-time 15 hours, approx., no payload

Duty cycle 80%

Weight 19 kg

Voltage 22 to 30 VDC

Capacity 72 Ah

Energy 1.84 kWh nominal

Recharge time 4 hours, approx.

Life span Approximately 2000 Cycles

Sensors

Description Specification

Sensors

Safety Scanning Laser 1 at front of platform
190 mm above floor
240°, Class 1, eye-safe
PLd Safety per ISO-13849

Sonar Pairs
(Each pair is one emitter and one
receiver, working together)

2 at rear of platform, 2 m range

Position encoders 2 encoders (one each wheel)
2 Hall sensors (one each wheel)

Analog gyroscope (Core) 320°/s max rotation

Bumper 1 at front of platform

Side Lasers (option) 2 on sides of payload structure,
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Description Specification

user-mounted

Low Front Laser 1 in bumper

Upward-facing camera
(Acuity option)

1 on payload structure, user-mounted

Payload Structure bumpers
(option)

6 inputs, user-designed andmounted
sensors (3 front, 3 rear)
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Battery Outputs

Nominal Qty Actual Maximum
Current Description

5 VDC 1 5 VDC±5% 1 A Switched Aux power

12 VDC 1 12 VDC±5% 1 A Switched Aux power

20 VDC 1 20 VDC±5% 1 A Switched Aux power

22 - 30 VDC 2 battery 4 A Switched

22 - 30 VDC 1* battery 10 A Switched

22 - 30 VDC 1* battery 10 A Safe- Switched

* 10 A Switched and 10 A Safe- Switched share the 10 A of current.

10.3 Docking Station Specifications

Description Specification

Current 8 A
Thermal fuse in AC power switch
(10 A Time-lag fuse at switch for legacy dock)

Contacts 2

Voltage 100-240 VAC, 50/60 Hz

Power consumption 800 W

Short circuit current rating (SCCR) 1500 A

Humidity 5% to 95% non-condensing

Temperature 5 to 40°C

Dimensions -WxDxH
with Floor plate

349 x 369 x 315 mm
495 x 495.5 x 317 mm

Weight 8.2 kg

Mounting Wall bracket, directly to floor, or on floor with floor plate

Indicators Power on - blue
Charging - yellow

Connector For out-of-platform battery charging
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Chapter 11: Glossary
This glossary contains terms found in this manual, as well as general terms associated with
robotics.

Term Definition

802.11a, b, or g A standard for wireless local area networks (WLAN) in the 2.4
GHz and 5 GHz frequency bands.

A/V Audio/Visual

Acuity Amobile robot localization system using an upward-facing cam-
era to detect overhead lights instead of using its laser.

AMR A platform with a payload structure attached to it. This is your
complete mobile robot, which will transport your products,
parts, or data.

When referring to the initial setup, configuration, and con-
nections, we will refer to the platform.

We use the term AMRwhen talking about controlling or mon-
itoring the full mobile robot with attached payload structure.

ambient operating tem-
perature

The temperature range of the robot's environment in which
continued operation is possible.

amplifier The component within the core that provides the power needed
to drive the mobile robot motors.

ARAM Advanced Robotics Automation Management. The software
that performs all of the high-level, autonomous robotics func-
tions, including obstacle avoidance, path planning, localization,
and navigation, culminating in the mobile robot's motion.

ARAMCentral The software running on the Fleet Manager appliance. Manages
the AMRs' map, configuration and traffic control, including
multi-AMR avoidance, destination, standby, and docking.

ARCL Advanced Robotics Command Language. A simple, text-based,
command-and-response operating language. Usedwith the
optional Fleet Manager (FM) appliance, ARCL can helpmanage a
fleet of mobile robots.

Auto-MDIX A connection port feature that automatically detects the Eth-
ernet cable type being used (straight-through or crossover) and
configures the connection appropriately.

balance (battery) The charging procedure that equalizes each cell in the battery
pack to increase the life span of a battery. The LD battery pack
automatically performs this procedure at the end of a complete
charge cycle.

beacon An optional indicator lamp,mounted on the AMR to provide
extra signaling.
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brake release A function that releases the robot brakes to allow manual pos-
itioning of the robot.

Call/Door Box A button or switch that allows an AMR to be requested from a
remote location, or that enables the system to control an auto-
mated door so the AMR can pass through it.

CAN bus Controller Area Network. A serial communications protocol that
allows electronic control units and devices to communicate with
each other.

cart A framemounted on four casters, that attaches to an
LD Platform Cart Transporter. Increases the payload capacity,
and allows the payload to be decoupled from the mobile robot.

CAT5 Category 5 Ethernet cable

CG Center of Gravity

cost An arbitrary numeric value assigned tomap grids, lines, routes,
etc. to determine the cumulative, net effect of a robot’s actions.
Breaks maps into discrete squares called grids. Squares with
walls, etc. have an infinite cost, and free squares, by default,
have a value of 0.1. By design, mobile robots always seek to
execute their assigned tasks and goals at the lowest possible
cost.

Cost-Based Path Planning Amethod of planning optimal, "least expensive" paths from
“point a” to “point b” for the robot to follow.

coupled A robot configuration in which the cart transporter and the cart
are attached to one another via coupling plates, and the cart
moves with the transporter.

coupling laser A laser mounted in the cart transporter's coupling plate for align-
ing the transporter and cart during coupling.

debuginfo file A zip file downloaded from SetNetGo that contains detailed
information about the status of the system, used by Omron
engineers for troubleshooting.

dongle A small hardware device attached to a computer that contains
the credentials (e.g., license key) required to run a specific pro-
gram.Without a dongle, MobilePlanner will only open in Oper-
ator Mode. A dongle is also used in each mobile robot core to
enable the use of the ARAM software.

DROPOFF A job segment typically usedwhere an AMR's payload is trans-
ferred from the robot to the goal. See "PICKUP".

duty cycle The percentage of time that the robot system can be con-
tinuously operated, without experiencing overheating.

E-Stop Emergency Stop

EM Fleet Manager
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emergency stop A function that overrides robot controls and removes power
from the robot and stops robot motion. An emergency stop (E-
Stop) button is typically a red push-button on a yellow back-
ground.

encoder A device on each wheel of the mobile robot that tells the nav-
igation system how far, and in what direction, the wheel has
turned.

Fleet Manager A network appliance that runs ARAMCentral. Manages a fleet of
AMRs, and provides a central location to manage maps and con-
figurations, has a queuingmanager to match jobs to available
robots, is a central point of communication for integrating fleet
robots, and coordinates fleet traffic.

ESD skins ElectroStatic Discharge skins encase the AMR in an electro-con-
ductive surface. Provides a skin-to-chassis-to-wheel grounding
path that drains off any charge the AMRmight accumulate dur-
ing operation.

Ethernet A type of computer network used in local area networks (LANs).
Typically uses a Category 5 (CAT5) or (CAT6) Ethernet cable;
supports data speeds up to 100 Mbps.

FIFO First-In-First-Out, refers to the method used to prioritize jobs
by the order in which they were received.

fleet Two or more mobile robots operating in the same area, gov-
erned by the same Fleet Manager.

forbidden (lines, areas) The lines or areas (on amobile robot's map) through or into
which the robot is not permitted to drive or enter on its own. In
special cases, you can direct a robot to enter a forbidden area.

gateway An access point that joins two networks so devices on one net-
work can communicate with devices on another network.

goal A map-defined virtual destination for mobile robots (e.g., pickup
or drop-off points).

GUI Graphical User Interface

gyroscope A device that measures rotational velocity. Assists with the nav-
igation of the AMR.

Hall sensor A sensor that uses magnets to track a mobile robot's wheel rota-
tion. This device provides a back up to the optical encoders on
each wheel.

HAPS High Accuracy Positioning System. Uses a sensor on the under-
side of the AMR to detect magnetic tape placed at locations,
such as at a stationary conveyor, where you want the AMR to
achieve particularly accurate positioning.

HAPSmarkers The short sections of magnetic tape applied to the floor that sig-
nal to the robot where to stop. Used at conveyors or other
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tight-tolerance drop-off/pickup locations.

heading Describes the direction that the robot is facing.

HMI Human Machine Interface. An operator panel is an example of
an HMI.

HMI post A post on the LD Platform Cart Transporter that supports the
two side lasers, the rear facing laser, and the Operator Panel.

I/O Input/Output

Instructed persons Persons that are adequately advised or supervised by skilled per-
sons to enable them to avoid electrical andmechanical dangers.

Interlock Amechanical or electrical device intended to prevent machines
from operating unless certain conditions are met.

IP Internet Protocol. A set of communication standards for trans-
mitting data between networked devices. An IP address is a
computer's unique internet "address" that allows the user to
identify each device in the network.

IPnn Ingress Protection. A rating given to electrical enclosures that
defines the level of protection provided against the intrusion of
solid objects, dust, andwater. The first 'n' is a number between
1 and 7 that identifies the level of protection against solid
objects (dust, tools, etc.). The second 'n' is a number between 1
and 9 that identifies the level of protection against moisture.
The higher the rating, the greater the level of protection.

job A robot activity - usually consists of either one or two “job seg-
ments” (either PICKUP or DROPOFF). The Fleet Manager
receives all job requests from Advanced Robotics Command Lan-
guage.

Pendant A handheld, external input device for manually drivingmobile
robots, primarily used for map creation. Connects to the mobile
robot’s Pendant connection port.

jumper A short length of conductor that connects two points in an elec-
trical circuit, often used to bypass optional safety devices.

keyswitch A switch that can be toggled by turning a key. When in the
locked position, disables the OFF button.

latchingmechanism Themotorized locking system that secures the LD Platform
Cart Transporter and the cart together.

LD Platform Cart Transporter An AMR designed to attach tomovable carts and transport
them from a pickup location to a drop off location.

LD Platform OEM A self-navigating and self-charging AMR, designed for moving
material indoors and around people. Designed for 60kg or 90kg
payloads depending on the specific model of robot.

light disc The circular lights on the sides of the LD platform that indicate
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motion, turns, and other robot states.

light pole See "beacon".

localization The process by which mobile robots determine their location in
their operating environment. Laser localization uses the robot’s
laser to scan its environment, which it compares to its internal
environment map. In light localization, the mobile robot uses a
camera and overhead lights to determine its location.

macro In MobilePlanner, a virtual “container” with a series or
sequence of nested tasks and/or goals. Similar to routes. You
can use macros as many times as needed to perform the same
sequence of discrete functions in different tasks.

map A representation of the robot's environment within MobilePlan-
ner, that the robot uses for navigation.

MARC The Mobile Adept Robot Controller (MARC) firmware controls
the mobile robot's motors, and computes and reports the
robot's pose (X, Y, and heading) readings and other low-level
operating conditions to ARAM.

MDOC Manufacturer's Declaration of Conformity

MDOI Manufacturer's Declaration of Incorporation

FLOW Core A set of mobile-robotics software applications for programming
and operating one or a fleet of mobile robots and the Fleet Man-
ager.

MobilePlanner The primary software application for programmingmobile robot
actions. Provides the tools for all major AMR activities, such as
observing a fleet of AMRs, commanding individual AMRs to
drive, creating and editingmap files, goals, and tasks, andmodi-
fying AMR configurations.

MobilePlanner (Operator
Mode)

The most basic version of MobilePlanner that has tools to mon-
itor robots, robot statistics, and add jobs. Does not have tools to
create or edit maps.

OAT Omron Adept Technologies, Inc.

operator panel A user interface for mobile robots that provides access to an E-
Stop button, ON andOFF buttons, a brake-release button, and
a keyswitch.

path The route a mobile robot takes to drive from place to place in its
environment.

patrol route A specific route (a series of tasks, goals, or macros) that the
robot will follow without human intervention.

payload Anything the mobile robot carries.

payload bay The area between the platform and the payload structure.
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payload structure Anything you attach to the platform. This could be as simple as
a box for holding parts or documents that you want trans-
ported, or as complicated as a robotic arm that will be used to
pick up parts to transport.

PICKUP A job segment where an AMR typically acquires a payload. See
"DROPOFF".

platform The base mobile robot (with or without payload) – includes
chassis, drive train, suspension, wheels, battery, safety scan-
ning laser, sonar, on-board core with gyroscope and software to
navigate, interface connections for payload, and covers.

pose Amobile robot’s position (location and heading).

preferred (lines, directions) The lines or directions you want the mobile robot to travel.
These are map items that can be drawn on amap using
MobilePlanner, to reduce the cost of grid cells under the line.
See "cost".

resisted (lines, areas) The lines and/or areas the mobile robots resists (attempts to
avoid) crossing or entering. These are map items can be drawn
on amapwithin MobilePlanner, to increase the cost of grid cells
under the line or area. See "cost".

route A “to do” list or series of tasks, goals, or macros for the mobile
robot to follow.

RS-232 Recommended Standard 232. Standard for serial com-
munication that provides full-duplex unbalanced-transfer com-
munications using amulti-conductor cable.

safety commissioning The testing and commissioning (verification of proper function)
of a robot's on-board safety systems. Uses a wizard to test E-
Stop (tests brake activation) and Safety Laser (tests max speed
limits and obstacle detection). Per EN-1525, commissioning
must be done by specially trained people.

sector User definedmap regions that direct specific AMR actions, like
ignoring sensor readings, driving on the right or left, limiting
the number of robots in the area at one time, etc.

SetNetGo The software OS that resides on mobile robots and the optional
Fleet Manager appliance. Used to configure mobile robots’ com-
munication parameters, gather debuginfo files, and upgrade
the Fleet Operations Workspace Core. Accessed via the
SetNetGo tab in MobilePlanner.

skilled persons Persons that have the technical knowledge or sufficient exper-
ience to enable them to avoid electrical or mechanical dangers.

SNG SetNetGo

SSID Service Set IDentification - identifies a wireless LAN.

Stay A touchscreen function that delays the departure of the AMR.
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Each touch of the Stay button adds to the time the AMRwill
wait before continuing to its next goal.

swing radius The radius of the circle that a mobile robot will use when turn-
ing in place (with no forwardmotion).

tasks Instructions for the robot to perform certain actions like reading
inputs, setting outputs, movement commands, talking, wait-
ing, etc.

touchscreen A full-color touch-sensitive screen on mobile robots. Used for dis-
playing information to the Operator, as well as receiving input
from the Operator.

transporter Another name for the LD Platform Cart Transporter. This should
not be confusedwith the Semi Transporter, which is a mobile
robot designed tomove wafer pods in semiconductor fabrication
plants.

turn radius The radius of the circle that the mobile robot will use when turn-
ing while moving forward.

virtual doors An area on amobile robot's map that, when a robot plans a
path through this area, causes the robot to stop at a designated
door goal prior to passing through. The user may designate
tasks to execute at those door goals, for example, toggling out-
puts to open a door, or enunciating to warn human operators
before entering a busy aisle.

wheel light See "light disc".

wheel pin A small pin that is inserted into the rear side of the drive
assembly after compressing the drive wheel springs, to keep
the wheel in the up position. Mobile robots are shippedwith
wheel pins installed, to protect the drive assembly from damage
during transport.

wizard A guide within the software user interface that assists the user
in setting up the software program.
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Appendix

A.1 Parts List
AMR parts and accessories are provided in the following table.

Table 11-1. AMR parts

Item Part
Number Details Included Optional

Docking Station
AC Power Fuse

02212-
000L

250 V, 10 A, and Time-
lag fuse

X

Laser Aperture
Label

13308-
000L

Laser Aperture Label X

Invisible Laser
Aperture Label

13307-
000L

Invisible Laser Aper-
ture Label

X

Medical Implant,
Magnetic Field
Warning Label

18621-
000

Medical Implant, Mag-
netic FieldWarning
Label

X

Yellow circle sur-
rounding the E-
Stop button

11229-
167

Yellow circle sur-
rounding the E-Stop
button

X

No Riding Label 18178-
000

No Riding Label X

Incline Limit Label 18622-
000

Incline Limit Label X

Automatic Vehicle
Label

18623-
000

Automatic Vehicle
Label

X

Docking Station
Roller

12416-
000

Rollers on the under-
side of the Docking Sta-
tion

X

Drive Wheel 11210-
000

Robot Drive Wheels X

CALB Assembly
Battery

20452-
000

Robot Battery X

ANTENNA,
WIRELESS,
RVRSE SMA

10616-
000

Wireless Antenna on
the payload structure

X

Assembly, Skin
Set, ESD, LD-60

21452-
995F

ESD Skin set X

Assembly, Skin
Set, ESD, LD-90

21452-
996F

Skin set X
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Item Part
Number Details Included Optional

EA 11

Assembly, Skin
Set, ESD, LD-90x,
60:1

21452-
997F

LD-90x Skin Set X

Skin, Front
Bumper, ESD, FRU

21452-
151F

ESD Front Bumper X

Skin, Front
Bumper Panel

12804-
100

Standard Front
Bumper

X

Skin, Front Top
Panel, ESD, FRU

21452-
201F

ESD Front Top Panel X

Skin, Front
Bumper Panel, LD,
Modified for Tim
Sensor

12804-
101

Tim Sensor compatible
Front Bumper Panel

X

Skin, Rear Panel,
ESD, LD-60, FRU

21452-
701F

LD-60 ESD Rear Panel X

Skin, Rear Panel,
ESD, LD-90, FRU

21452-
702F

LD-90 ESD Rear Panel X

Skin, Rear Panel,
ESD, LD-90x,
60:1, FRU

21452-
705F

LD-90x ESD Rear Panel X

Skin, Front Top
Panel

12804-
200

Standard Front Top
Panel

X

Skin, Rear Panel,
LD-90x

12804-
705

LD-90x Standard Rear
Panel

X

Skin, Rear Panel,
LD-130CT

12804-
704

LD-130CT Rear Panel X

Skin, Rear Panel,
LD-105CT

12804-
703

LD-105CT Rear Panel X

Skin, Rear Panel,
LD-60

12804-
701

LD-60 Standard Rear
Panel

X

Skin, Rear Panel,
LD-90

12804-
702

LD-90 Standard Rear
Panel

X

Skin, Battery
Door, ESD, FRU

21452-
801F

ESD Battery Door X

Skin, Battery Door 12804-
801

Standard Battery Door X

Assembly, Skin
Right, LD, ESD

21452-
350F

Right-side ESD Skin X
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A.1  Parts List

Item Part
Number Details Included Optional

Assembly, Skin,
Right

12804-
350

Standard Right-side
Skin

X

Assembly, Skin
Left, LD, ESD

21452-
450F

ESD Left-side Skin X

Assembly, Skin,
Left

12804-
450

Standard Left-side Skin X

Skin, Left Hatch,
LD, ESD

21452-
600F

ESD Left Hatch X

Skin, Left Hatch 12804-
600

Standard Left Hatch X

Docking Station
Internal Fuse

13091-
000

Fuse located internally
within the Docking sta-
tion

X
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